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Pratarmé

Si metodiné priemoné skirta padéti Vytauto DidZiojo universiteto Lietuviy filologijos
bakalauro programos studentams naudoti elektroniniy teksty ruoSimo priemones, taikyti
ivairius tyrimo metodus, suvokti moksliniy rasto darby pobiidi, paaiskinti tokiems darbams
keliamus reikalavimus ir palengvinti raSymo procesa. Patarimai gali buti naudingi ir
studijuojantiems kitose kalbotyros bakalauro programose, taip pat rengiantiems magistro
darbus.

Knygoje pateikti reikalavimai, kuriy reikia laikytis norint pateikti gerai parengta
mokslini darba. Pabréziama, kad svarbus ne tik darby turinys, bet ir forma (i kurig daznai
nekreipia tinkamo démesio ir aukStesniy kursy studentai): citavimas, lenteliy ir paveiksly
pateikimas, literatiiros saraso sudarymas, teksto iSdéstymas ir pan.

Studijuojantiems VDU Lietuviy filologija daugiausia reikia atsiskaityti raStu, t. y.
paragyti referata, namy darba, kursinj darba ir pan. Zodiniai atsiskaitymai paprastai vyksta per
seminarus — praktinius uZsiémimus. D¢l dazniau raSomuy raSto darbuy Sioje metodingje
priemongje daugiausia démesio skiriama rasto, o ne ZodZiu pristatomiems darbams. TacCiau
pateikiama patarimuy, kaip pasirengti mokslini darba pristatyti ZodZiu.

Rasto darbai svarbis tuo, kad padeda jsigilinti { atskiras mokomojo dalyko temas ir
ugdo studenty analitinio darbo igtidZius. RaSydami darbus studentai susipaZista su mokslinio
tiriamojo darbo metodologija, Saltiniy {vairove ir bibliografija, iSmoksta taikyti mokslinio
darbo techninius bei apipavidalinimo reikalavimus.

Siandien studenty rasto darbai jau neatsiejami nuo kompiuteriniy programy naudojimo.
Sios metodinés priemonés antrame skyriuje gausu praktiniy patarimy, kaip taikyti kai kurias
kompiuterines programas rengiant ivairius rasto darbus.

Tikimeés, kad $i metodiné priemoné padés studentams, pradéjusiems studijuoti Vytauto
Didziojo universitete. Knygoje pateikti patarimai turéty buti pravartis ir pirmakursiams, ir
Lietuviy filologijos programa bebaigiantiems bakalauro darbus raSantiems ketvirtakursiams.

Dé¢kojame VDU Lietuviy kalbos katedros Lietuviy kalbos katedros vedéjai prof. dr.
Astai Kazlauskienei, déstytojams ir doktorantams uZ vertingas pastabas bei pasitilymus, kaip
patobulinti § leidini.

Autoriai



I DALIS. METODINIAI NURODYMAI MOKSLINIAMS
DARBAMS (E. Rimkuté)

1. MOKSLINIU DARBU ZANRAI IR YPATYBES

1.1. Bendrosios moksliniy darby ypatybeés

Mokslo kalbai buidingas apibendrinimas, dalykinis tikslumas, déstymo logiSkumas,
objektyvumas, glaustumas, iSsamumas, aiSkumas. Mokslo kalbos dalykini tiksluma lemia
terminy ir vienareikSmiy, tiesioginés reikSmeés ZodZiy vartojimas. Mokslinio teksto ZodZio
reikSmei apibréZti nereikia platesnio konteksto — jis turi biti aiSkus ir vienareikSmis.

Mokslo kalbos sintaksei budingos konstrukcijos, pabréZiancios déstymo logiSkuma
(pvz.: pirma, antra, kita vertus), iterpiniai (pvz.: vadinasi, taigi, pavyzdZiui), sudétiniai
jungtukiniai sakiniai (pvz.: DaiktavardZiai, reiskiantys pojiuciais suvokiamus konkrecius
dalykus, yra konkretieji, o visi kiti priklauso abstrakciyjy daiktavardziy klasei.).

Objektyvuma pabréZia beasmenés ir pasyvinés konstrukcijos (pvz.: Sioje darbo dalyje
yra apibréZiamas daugiareiksmiskumas apskritai. Toliau analizuojami  smulkesni
daugiareiksmiskumo tipai, pateikiama jy klasifikacija. Paaiskinama, kodél darbo objektu
pasirinktas morfologinis daugiareiksmiskumas).

Budingi mokslinio stiliaus trokumai yra gremézdiSkos sakinio konstrukcijos,
daiktavardZziy gausa (pvz.: Sio darbo rasymui (= Siam darbui raSyti; rasant Si darbq)
pasirinkta tokia tema...), nekonkretiis, neaiSkis, netinkami ZodZiai (pvz.: didelé reiksmeé, be
galo svarbus, labai jdomus).

Mokslo kalbai biidingas nominatyvinis stilius: vartojama daug abstrak¢iy daiktavardziy.
Toks raSymas daro kalba abstrak¢ia ir sudétinga, o tai daugelio mokslininky ir studenty
siekiamybé. Jy manymu, tai yra svarbiausias mokslo kalbos skiriamasis poZymis. TaCiau
reikia stengtis vartoti kuo maZziau bent jau veiksmazodiniy ir bidvardiniy daiktavardZiy su
priesagomis -imas, -ymas, -umas.

Darbe patartina vartoti esamaji arba butaji kartini laika, o ne biisimaji. Net ir jvade
reikéty vartoti ne biisimaji laika, nes, kai skaitomas ivadas, visas darbas jau biina paraSytas,
todél logiskai atrodo esamasis ar butasis laikas.

Daugelio déstytoju nuomone, rasto darbuose studentai turéty vengti raSyti pirmuoju
asmeniu. Vis délto kai kuriais atvejais (motyvuojant temos, metody pasirinkima, apraSant
eksperimenta) gali biiti pavartotas ir pirmasis asmuo (pvz.: Pasirinkau $iq temgq, nes...; Todél
manau, kad Sie metodai tinkamiausi.). Pirmojo asmens vartojimas neturéty biiti suprantamas
kaip teksto individualumas. Teksto individualuma lemia kalbos Zodingumas, gebéjimas
parinkti kuo taiklesni sinonima, gramatiniy formy ivairové, sakinio struktiira. Per didelis
darbo asmeniSkumas — tipiSka studijy pradininky problema, o bebaigiantiems mokslus
studentams biidingas kitas kraStutinumas — pateikti gausybg pavyzdZiy ir nedristi jais kaip
nors pasinaudoti ar jvertinti.

Moksliniy darby autorius turi atskleisti ne savo asmeniSkuma, bet turi pasirodyti esas
tam tikros srities specialistas, kai renkasi tema, medZiaga, literatiira, teorijas, metodus ir kt.;
kai sprendZia, kaip tirti surinkta medZiaga, kokias numatyti tyrimo perspektyvas.
AsmeniSkumu bity laikoma, jei studentas reikStysi kaip privatus asmuo su mokslisSkai
nepagrista nuomone ar vertinimais, jei daryty asmeninius apibendrinimus (Rienecker et al.
2003: 40).

Pradedantys rasyti mokslinius darbus, ne visada isivaizduoja, ko i$ juy reikalaujama ir
tikimasi. Toliau pateikta keletas klaidingy minciy apie tai, koks turi biiti geras darbas:



santykis su darbu turi biiti asmeninis, ne vien dalykinis;
geriausiai vertinamos i§samios, placios Zinios;

privalu buti originaliam, mastyti naujai;

negalima nesutikti su déstytoju;

svarbiausia, kad turinys biity geras, o forma néra labai svarbi;
labai gerai, jei raSoma kuo abstrakc¢iau ir sudétingiau.

Kituose poskyriuose pateiktos mokslo darby ypatybés, reikalavimai, keliami mokslo
darby kalbai, aprasSyti pagrindiniai mokslo darby Zanrai turéty padéti suvokti, ka rasyti ir ko
vengti mokslo darbuose.

1.2. Moksliniy raSto darby ypatybeés

Siame poskyryje aiskinama, kokiomis ypatybémis turi pasizyméti savarankiskas rasto
darbas — kursinis ar bakalauro darbas. Siems darbams keliami tam tikri reikalavimai.
Svarbiausi yra tokie (Rienecker et al. 2003: 17):

e pagrindinis tikslas — iStirti;
e visada grindZiamas teorija ir (arba) tam tikru metodu;
e teksto siuntéjas ir gavejas yra specialistai;
e paskirtis — mokslui priimtina forma skleisti mokslinio tyrimo rezultatus
akademinéje visuomeneéje;
darbas raSomas atsizvelgiant i tam tikrus mokslinius reikalavimus;
e darba sudaro tam tikros nustatytos sudedamosios dalys, ju struktiira gana
griezta (ypac ivado ir iSvadu);
e darbui keliami apibrézti literatiiros saraso, citavimo, iSnasy tvarkos ir kt.
reikalavimai;
e darbe vartojami tiriamos srities terminai, metakalba.

Visiems rasto darbams bendra tai, kad juose, remiantis atitinkamomis mokslo
savokomis ir metodais, tiriama viena aktuali kokios nors disciplinos problema.' Problema
nereiSkia sunkumy, kurie kilo raSant darba, pvz., sunku rinkti medZiaga, néra reikiamos
literatiiros, triiksta laiko ir pan. Sio ZodZio nereikia suprasti kaip kazko labai problemiska, tai
gali buti vadinama ir darbo klausimu. Problema — tai kazkas, apie ka dar ne viskas pasakyta,
iSaiSkinta iki galo, ne taip ar nepakankamai, netinkamu aspektu, jvairiai interpretuojama.
Taigi problema néra bet koks klausimas, neturintis atsakymo, bet klausimas, i kuri reikia
atsakyti, t. y. kurio atsakymas galéty biiti kam nors panaudotas.

Tirti nebitinai reiSkia iSspresti pasirinktaja problema; 1S humanitariniy moksly paprastai
tikimasi problemos analizés, interpretacijos, polemikos ar vertinimy. Taigi pagrindinis
mokslinio darbo reikalavimas — iStirti, tod¢l nereikia atpasakoti visko, kas raSoma tema yra
Zinoma.

Kaip didelis moksliniy darby trukumas pabréZiamas Ziniy atpasakojimas, o ne Ziniy
taikymas. 1 lenteléje apibendrintai pateikti Ziniy atpasakojamyjy ir Ziniy taikomuyjy darby
skirtumai, i kuriuos vertéty atkreipti démesi rasant mokslinius darbus.

! Aktuali problema — tokia problema, kuria spresti disciplinai yra vienoks ar kitoks poreikis.
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1 lentelé. Ziniy atpasakojamyjy ir Ziniy taikomyjy darby skirtumai (pagal Rienecker et al. 2003: 41-42)

Ziniy atpasakojamuosiuose darbuose Ziniy taikomuosiuose darbuose
sutelkiamas démesys i tema sutelkiamas démesys i tiksla

remiamasi pasakojimu tiriama problema, analizuojama
pateikiama viskas, kas Zinoma atsirenkama ir apdorojama informacija
orientuojamasi i darbo pavadinima (tema), o ne problema orientuojamasi i problema

nesiejamos atskiros dalys; laikomasi teksto sasaju tik skyriy ar | iSlaikoma sasaja tarp atskiry darbo daliy
poskyriy viduje

Ziniy atpasakojamieji darbai taikomi paciam rasanciajam turimas mintyje skaitytojas

Dazniausiai geriausi savarankiSki darbai daugiausia démesio skiria Ziniy taikymo ir
analizés lygmeniui, o prastesni darbai beveik visada biina pernelyg referatiSki: nors juose
atsirenkama ir vertinama literatlira, tas vertinimas paprastai yra subjektyvus, nesiremiantis
iSankstiniais, disciplinai priimtinais kriterijais.

Blogai ivertinti darbai paprastai buina per platiis, juose pernelyg daug betikslio
atpasakojimo, nesusijusiy daliy. Paprastai Zinias atpasakojantys studentai skaito per daug,
raSo per mazai ir raSydami per retai kelia klausimus.

Be Ziniy taikymo ar atpasakojimo kriterijaus, mokslo darbai vertinami ir pagal kitus
reikalavimus. 2 lenteléje pateikti bendrieji moksliniy rasto darby reikalavimai, i§ kuriy galima
spresti apie darbo verte. Cia skiriami turinio kriterijai, t. y. tos ypatybés, kuriomis turi
pasizyméti mokslinio darbo tekstas (pateikta kair¢je lentelés puséje), ir moksliné retorika, t. y.
darbo forma (pateikta deSinéje lentelés puseje).

Oponentas paprastai iSmano bendruosius disciplinos dalykus, specialusis darbo turinys
ne visada biina Zinomas. Biitent todél oponentui — kaip ir kitiems specialiai neisigilinusiems i
tyriné¢jama klausima skaitytojams — daug labiau nei darbo vadovui reikalinga tvarkinga darbo
forma ir kalba.

2 lentelé. Bendrieji moksliniy rasto darby reikalavimai (pagal Rienecker et al. 2003: 36-37)

Turinio kriterijai Formos Kkriterijai (moksliné retorika)
Gerame rasto darbe: Gerame rasto darbe:
e rodomas profesinis susidoméjimas, e taikomasi prie adresato,
e taikomos, o ne atpasakojamos Zinios, e atsakoma | problemos formuluotés
e pagrindZiamas vienoks ar kitoks klausima,

pasirinkimas ir elgesys, e yra aiSki ir logiSka struktira,
e rodomas mokslinis pastabumas, e taisyklinga kalba,
e pateikiama teisinga ir patvirtinta e vartojama metakalba,
informacija, e tinkamai vartojama tos mokslo
e iSkeliama tinkama problema, srities terminija,
e naudojama tinkama metodika ir e nuosekliai laikomasi  pasirinkto
teorija, citavimo budo,
e naudojama tik reikalinga literatiira, e  geras rasto darbas atitinka techninius
e laikomasi fakty pateikimo etikos, reikalavimus, yra vientisas teksto ir
e geras rasto darbas yra savarankiskas, sakinio poZidriu.

sutelktas i viena pagrindinj dalyka.

Toliau pateikta dar keletas formaliy kriterijy, kurie tiek studentui, tiek jo vadovui, tiek
oponentui padés nustatyti mokslinio darbo vertg (pagal Rienecker et al. 2003: 37-38):
e Kokia darbo apimtis palyginti su katedros nustatyta tokio darbo puslapiy
skaiCiaus norma?
e Kaip atrodo bibliografija? Ar ji pateikiama nuosekliai? Ar naudojamasi
naujausia literatira?
e Ar turinyje atsispindi nuoseklus ¢jimas nuo problemos i§vados link?




Ar darbas lengvai skaitomas?

Ar i$naSos vartojamos pagristai, ar néra per ilgos, nesuprantamos?

Ar sudarytas specifiniy terminy Zodynélis?

Ar skyriy antrastés atitinka juy turini?

Ar darbo kalba gera: suprantama, tiksli, vientisa, vienareikSme?

Ar aptariama ir vertinama darbe naudojama literatiira?

Ar tinkamai cituojama, ar citatos pateikiamos vienodai?

Ar pateikiamos prieSingos nuomonés? Ar nenutylimi nepatogtis pavyzdZiai?

Taigi geras mokslinis rasto darbas yra sutelktas i viena pagrindini dalyka, nepaisant to,
kad apimtis gali biiti Simtas lapy. Tekstas turi turéti viena tema, viena problema, turi buti
vientisas.

Norédami patobulinti mokslo darba, iSpléskite ta teksto dali, kurioje priimate
sprendimus ir pagrindZiate pasirinkima; savo tikslams pasitelkiate kity sukurtas savokas,
metodus, teorijas; analizuojate ir interpretuojate; siejate, lyginate, darote iSvadas; vertinate
kity ar savo paties teksta. O ta teksto dalj, kurioje aprasSinéjate, parafrazuojate, apzvelgiate
medziaga, reikéty trumpinti (Rienecker et al. 2003: 46).

1.3. Rasto darby kalba

Visuose mokslinivose darbuose dalykinis turinys turi biiti pateiktas objektyviai,
iSsamiai, tiksliai, teisingai ir ri§liai. Moksliniai darbai raSomi profesine kalba, kurioje
vartojamos konkrecios reikSmes savokos, tiksliis terminai. Kad darbas buty dar tikslesnis, kai
kuriuos terminus reikia apibréZti. Paprastai apibréZiami ne visi terminai, o tik:

e pagrindiniai, kurie nejeina { pagrindini konkrecios profesijos Zodyna, ju gali nesuprasti
net ir tos profesijos Zmone¢s, nesusij¢ su darbe analizuojama problematika;

e paimti iS kity mokslo kryp¢iy ar kasdienés kalbos;

e tie terminai, kuriuos reikia patikslinti, nes darbe vartojami kitokia reikSme;

e terminai, vartojami keliose disciplinose.

Vienas i§ mokslinés kalbos poZymiy yra metakalba. Tai kalb¢jimas apie patj teksta. Ji
gali buti vartojama pristatant tema, paaiSkinant metodus, susiejant pastraipas, skyrius ir
poskyrius, atskiriant sava teksta nuo cituojamo, primenant, kas jau buvo raSyta. Visa tai lemia
metakalbos vienety pasirinkima (Rienecker et al. 2003: 244-245):

e metapastraipos raSomos skyriy pradZioje bei pabaigoje ir paaiSkina, kas bus
raSoma ar buvo paraSyta, pvz.: Ankstesniame skyriuje buvo aptarta... Dabar belieka
iSanalizuoti...;

e metasakiniai nurodo skyriaus tema, pvz.: Siame skyriuje bus nagrinéjamas...;

e metazodzZiai rodo:

o logini ir semantini pastraipy bei sakiniy rysi (be to, todél, nes, kaip buvo

minéta ir kt.),

o kalbos akta (toliau bus analizuojama, nagrinéjama, remiamasi ir kt.);
teksto (kaip minéta 3 puslapyje; kaip matyti is 3 paveikslo; Zr. 1 priedq ir kt.)
ir literatiiros nuorodas (kaip teigia X; Y nurodo ir kt.);
ivertinima (turbiit, is dalies, gal ir kt.),
sustiprina teksta, daro ji patikima (akivaizdu, be abejonés, Zinoma ir kt.),
autoriaus reakcija (galima papriestarauti, stebina ir kt.),
kreipimasi i skaitytoja (atkreipkite démesj);

@)
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e metazenklai (dvitaskiai, vardijimas papunkCiui) ir metaapipavidalinimas
(iSskyrimas kursyvu, parySkinimas, iSretinimas) padeda atkreipti skaitytojo démesi,
1Sdéstyti teiginius tam tikra tvarka, nurodyti svarbiausius dalykus.

Gerame raSto darbe matyti metakomunikacija su skaitytoju, t. y. darbo autorius
pasako, kas bus daroma, kodé¢l, kaip, ir taip susieja atskiras teksto dalis. Metakalba geriausia
vartoti, kai pristatoma tema; paaiSkinama, kaip naudojamasi literatiira, teorijomis ir metodais;
atskiriant, kur paties autoriaus ZodZiai, o kur kity autoriy tekstas; siejant pastraipas;
primenant, kas rasSyta ir kas dar bus raSoma; siejant buvusio skyriaus pabaiga su kito skyriaus
pradZia; parodant, kur keiciasi tema, kaip susij¢ aptariami dalykai; paaiSkinant, kam darbe
reikalinga tam tikra informacija. Metakalba atskleidZia, kas daroma su darbo turiniu, parodo
skaitytojui, { ka atkreipti démesj. Per metakalba studentas pademonstruoja iZvelgias savo
darbo visumga (Rienecker et al. 244-247).

Kaip raSyta anksciau, metakalba laikoma svarbiu mokslinio darbo privalumu. Taciau
atkreiptinas démesys ir { mokslinio darbo triikumus, susijusius su darbe vartojama kalba.
Viena i§ didziausiy klaidy, pasitaikanciy pradedanciy rasyti mokslinius darbus tekstuose, —
raSymas mokslo populiarinamaja kalba. Mokslo populiarinamieji darbai skirti pristatyti
savo specialybés dalykus nespecialistams, todél reikia raSyti papras€iau, vartoti maZziau
tarptautiniy ZodZiy, specialybés terminy nei moksliniame darbe.

Mokslinio darbo kalba, palyginti su mokslo populiarinamojo, turi buti sausa, be
vaizdingy, emociniy ZodZiy, be sakytinés kalbos elementy; reikéty vengti moralizavimo,
neturéty biiti daZnai reiSkiama niekuo nepagrista asmeniné nuomoné. Reikia paisyti kalbos
tikslumo, o ne estetiSkumo. Kalba neturi biiti imantri. Reikia vengti metafory (pvz., sakytinés
ir rasytinés kalbos dvikova), nes jos vaizdingos ir dviprasmés; vertinamyjuy Zodziy (pvz.:
mano manymu, tai ganétinai keistas teorijos interpretavimo biidas; tai neprotingas teiginys);
pernelyg daug pabréZiamuyju kieki nusakanciy ZodZiy (pvz.: labai, be galo, nepaprastai);
sutrumpinty formuy (pvz., svetimybém laikomi skoliniai is slavy ar germany kalby);
kategorisky teiginiu® (pvz.: visi vartoja, visur vartoja, niekas neZino, kalba nyksta). Norint
teigti, kad visi visur vartoja tam tikra Zodj, reikia ta jrodyti patikimais duomenimis. Kita
vertus, vargu ar galima rasti tokiy atvejy, kurie patvirtinty absoliu¢ia tam tikro kalbinio
reiskinio vartosena. Rasant mokslinius darbus reikéty vartoti Zodzius dauguma, dalis, daugiau
nei pusé, nedaugelis ir pan. Taciau tokius apibendrinimus galima daryti tik tada, kai turima
pakankamai medZiagos, irodancios Siuos teiginius.

Mokslo populiarinamosios kalbos skverbimusi | mokslo darbus galima laikyti pagyras,
daznai skirtas autoriui, o ne jo kurybai (nors analizuojami kiiriniai). Mokslo darbuose reikia
tirti kiirybos, o ne Zmogaus patraukluma atspindincias ypatybes.

Moksliniame darbe skyriy pavadinimai negali buti klausiamieji sakiniai, pvz.: Kodél
vartojame skolinius? Tai tinka tik mokslo populiarinamiesiems darbams. Plg. Sias iStraukas i$
pirmakursiy raSyty kursiniy darby:

o Mano nuomone, skoliniy, kurie is tikryy skamba nelietuviskai, gausus vartojimas, tai vis
populiaréjanciy uZsienio kalby jtaka. Lietuviai ir taip ne itin didZiuojasi dabartine Lietuva. Gal ir kalba
pasirodé ne tokia jau tobula, kuriq stengiamasi , papuosti svetimybémis“. O gal tai tiesiog noras biti
panaSesniems | didingajq Amerikq arba § Zaviajq Anglijq. Juk tikrojo lietuvio kraujyje yra jaugusi frazeé: ,,visur
gerai, kur miisy néra“. Gal todél ir stengiamasi siekti to, ko mes neturime.

o Kalbininky surinkti naujyjy svetimZodZiy sqrasai kelia ne vien lingvistiniy, bet ir socialiniy
problemy. Svarbiausia is jy: kodél turédami savo kalboje nuo seno vartojamy ZodZiy skolinamés svetimus?
Liiidnas atsakymas: negerbiame nei savo tautos, nei savo kalbos — visa, kas sava, negraZu, pasene,

* Kategoriskumas ypa¢ bidingas pirmakursiams.
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nebemadinga, o kas atéje is svetur, gerbtina, vartotina, nes tai yra atéje is Vakary, kuriy kultira ryja Ryty
kultiirq.

e Daznas pilietis tardamas skolinj net nesusimaqsto, kokia yra sudarkyta jo kalba, kaip pamaZu nyksta
senoliy sukrautas turtas. Tad iskylancios problemos — kodél lietuviy tauta neatsigina svetimybiy, plistanciy is
Vakary, kodél mes, kalbos teséjai, patriotai, pamaZu skurdiname savo unikaliq kalbq.

Sios itraukos tikty mokslo populiarinamiesiems straipsniams, neformalioms
diskusijoms apie skoliniy Zala lietuviy kalbai, mitingams, bet ne moksliniams darbams. Cia
pernelyg daug asmeninés nuomones, tam tikry Sukiy, bendry fraziy, raSanciojo subjektyvia
(daznai neigiama) nuomong atspindin¢iy ZodZiy.

Moksliniuose darbuose iSvados daromos remiantis savo surinktais duomenimis, o ne
paplitusiais stereotipais, tod¢l savo darbo iSvadose nereikia pateikti ir taip akivaizdZiy,
visiems zZinomuy dalyku, pvz.: lietuviy kalba yra viena seniausiy kalby, priklausanti balty
kalby grupei; daiktavardis — kalbos dalis, reiskianti daikto pavadinimq. 1Svados turi biiti
konkrecios, pagristos atliktu tyrimu (placiau Zr. 2 skyriy).

Moksliniuose darbuose neturi biiti neaiskiy, neirodyty teiginiu, pvz.: AS manau, kad Sis
skolinys yra atéjes is angly kalbos. Si fakta galima patikrinti, todél minéto sakinio arba i§ viso
nereikia raSyti, arba reikia paraSyti (prieS tai pasitikslinus), kad tiriamasis skolinys tikrai
pasiskolintas i§ angly kalbos.

Apibendrintai moksliniy ir mokslo populiarinamyjy darby kalbos skirtumus iliustruoja 3
lentelé, kurioje pateikti raSto darby kalbos aktai: kairéje lentelés puse¢je pateiktos tos ypatybes,
kurios budingos moksliniams darbams, o deSinéje puséje — mokslo populiarinamiesiems
darbams.

3 lentelé. RaSto darby kalbos aktai (pagal Rienecker et al. 2003: 238)

Moksliniame darbe reikia Mokslo darbe nereikia
argumentuoti agituoti
pagristi recenzuoti
irodyti, parodyti prisipaZinti
diskutuoti mokyti
interpretuoti pasiepti
niuansuoti populiarinti
probleminti liaupsinti
itikinti propaguoti
tirti peikti
vertinti postuluoti

Moksliniai darbai turi buti raSomi taisyklinga lietuviy kalba. Reikéty vengti neaisSkiy,
nesuprantamy ZodZiy. Rekomenduojama daugiau vartoti lietuvisky, o ne tarptautiniy ZodZiy;
viename darbe nevartoti to paties termino sinonimy. Kaip minéta, moksliniam stiliui budingi
sudétiniai sakiniai, bet tokie sakiniai neturéty buti pernelyg ilgi, nes ilgame sakinyje kartais
sunku suvokti pagrinding mintj.

Ypac reikia atkreipti démesj { raSyba, skyryba, kalbos kultiira. Galutinis darbo variantas
turi biiti be minéty klaidy. Susidiirus su sudétingesniais rasybos, skyrybos ar kalbos kulttiros
atvejais, reikia pasitikrinti atitinkamose knygose ar Zinynuose. Kalbotyros darbuose pasitaiko
kalbos kultiiros normy pazeidimu, pvz., viskas, kas susij¢ su kalba (ZodZiai, terminai, frazés ir
pan.) yra vartojama, o ne naudojama; pavyzdziai, klaidos yra ne sutinkami, o randami
(placiau zr. Kazlauskiené et al. 2011).

Labai atidZiai reikia perzitréti paskutini darbo varianta (rekomenduojama perskaityti
atspausdinta, o ne kompiuteryje) ir iStaisyti korekttros klaidas, t. y. suzitréti tarpus, skyrybos
Zenkly, ypac kabuciy, rasyba, Sriftus, raidZiy dydi ir pan. (placiau Zr. 2.2).
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Mokslo darbuose reikia vengti to paties termino sinonimijos, pvz.: prieSdélis —
prefiksas, dialektas — tarmé, deminutyvas — maZybinis Zodis. Visame darbe reikia vartoti vienga
kuri pasirinkta termino varianta.

Apibendrinant rasto darby kalbos ypatybes, galima pateikti tokius patarimus (pagal
Rienecker et al. 2003: 235):

e kalba dailinkite tik paskutiniame darbo variante;
nesistenkite rasyti kuo sudétingiau ir abstrakc¢iau;
adresuokite darba kolegai, o ne tos pacios temos specialistui;
darbo tekstas turi iSplaukti i§ atlickamo tyrimo;
raSykite dalykiSkai, tiksliai, taisyklingai, profesine kalba;
vartokite metakalba;
venkite mokslo populiarinamosios kalbos.

1.4. Moksliniy darby zanrai

Prie§ pradedant rasyti tam tikro Zanro mokslini darba, reikéty atkreipti démesi i keleta
dalyky:

e susipazinkite su tam tikram Zanrui keliamais reikalavimais bei kokybés
kriterijais ir sugebékite juos taikyti;

e savarankiSkas raSto darbas — tai tam tikrai sri¢iai aktualios problemos mokslinis
tyrimas, kuriam pasitelkiamos atitinkamos mokslinés teorijos ir metodai;

e skirtingos mokymo istaigos kelia nevienodus reikalavimus to paties Zanro
moksliniams darbams;

e aukStojoje mokykloje raSomiems darbams keliami kiti reikalavimai nei
vidurinéje mokykloje ar gimnazijoje;

e aukStyjy mokykly raSto darbai — tai ne laisvo stiliaus raSinéliai, vadoveliy tekstai,
mokslo populiarinamieji straipsniai ir pan.

e raSydami darba ypac atsizvelkite i jam keliamus stiliaus reikalavimus (Rienecker
et al. 2003: 15).

Toliau aptarti dazniausiai studenty filology raSomi moksliniy darby Zanrai: referatas,
kursinis darbas, bakalauro darbas, mokslinis praneSimas, tezés, straipsniai, recenzija.

1) Referatas — svarbiausiy vieno ar keliy autoriy citaty raSoma tema santrauka. Todél
referatas néra savarankiSkas mokslinis darbas, nors jame turéty atsispindéti ir referato
autoriaus pozicija. Referate nereikéty raSyti visko, kas Zinoma apraSomuoju klausimu. Bitina
iSmokti isigilinti i tema, atsirinkti autorius (ju gali biiti nedaug) ir atmesti tai, kas néra biitina
ar savaime suprantama. Referato struktiira néra sudétinga: ji gali sudaryti tik jvadas, vienas
arba du déstymo skyriai ir iSvados.

Referaty temos yra pateikiamos atitinkamo kurso pradZioje. Referatus skaitysiantis ir
vertinsiantis déstytojas paaiSkina temas, iSdésto pagrindinius reikalavimus. Referatams
keliami ne tokie auksti turinio reikalavimai kaip kursiniams ar bakalauro darbams. Referatai
gali buti prilyginami namy darbui arba gali biti traktuojami kaip dalis studenty savarankisko
darbo. Paprastai referato pazymys iskai¢iuojamas i atitinkamo dalyko bendra pazymi.

2) Kursiniams darbams keliami aukstesni reikalavimai negu referatams. Nuo referato
jie pirmiausia skiriasi tuo, kad paremti studento surinktais duomenimis, kurie turi buti
apdoroti, iSanalizuoti ir tinkamai aptarti bei interpretuoti. Kursini darba raSantis studentas
turéty daugiau konsultuotis su vadovu. Skirtingai nei referate, €ia jau reikéty remtis keliais ar
net keliolika autoriy. Kursinio darbo struktiira sudétingesné: pagrinding dalj reikéty iSdéstyti
3—4 skyriuose, galimi priedai, jvairi iliustraciné medZiaga (placiau Zr. 2 skyriy).
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Kursiniy darby temos gali biti susijusios su konkre€iu studijuojamu dalyku, pvz.,
leksikologija, kai visi studentai raSo panaSaus pobudZio kursinius darbus. TreCiame kurse
studentai apsisprendZia, { kuria studijy krypti — kalba ar literattira — nori labiau gilintis ir raso
atitinkamy temy kursinius darbus.

Lietuviy filologijos bakalauro programoje kursiniai darbai raSomi pirmame, antrame ir
treCilame kurse. Kursiniam darbui parengti skiriami 3 ECTS kreditai. Kursiniai darbai
vertinami kaip atskiras studijy dalykas.

3) Bakalauro ir magistro darbas struktiiros pozitriu i§ principo beveik nesiskiria nuo
kursinio darbo, taiau akivaizdZiai skiriasi darbo problemiskumu, iSsamesniu temos
nagrinéjimu ir paties darbo apimtimi.

Bakalauro darbas raSomas ketvirtaisiais studijy metais. Lietuviy filologijos bakalauro
studijy baigiamasis darbas — tai studento savarankiSkai atliktas ir iformintas tyrimas, rodantis
gebéjima taikyti studijy metu jgytas Zinias. Bakalauro darbe studentai turi parodyti gebéjima
formuluoti studijy krypties problemas; savarankiskai atlikti teorini ir praktini tyrima; taikyti
tinkamus tyrimo metodus; tinkamai pasirinkti moksling literatiira ir ja naudotis (pristatyti,
analizuoti, interpretuoti); tinkamai interpretuoti tiriamaja medZiaga ir tyrimo metu gautus
duomenis; aiskiai ir pagristai formuluoti tyrimy iSvadas, rekomendacijas; glaustai, aiSkiai,
nuosekliai, taisyklinga kalba raStu ir ZodZiu pristatyti tyrima.

Bakalauro darbe turéty biiti ne maZiau kaip 10 literatuiros pozicijy, t. y. knygu, straipsniy
ar kitokiy darby, kuriais remtasi rasant darba.

Kursiniy ir bakalauro darby tyrimy laukus ir tematika apibréZzia Lietuviy kalbos ir
Lietuviy literatiiros katedros. Darby temos skelbiamos vieSai rudens semestra ir nurodomi
temoms vadovaujantys déstytojai. Pasirinkta darbo tema studentas turi suderinti su darbo
vadovu. Pasirinktas bei suderintas temas ir vadovus tvirtina katedros vedéjas ne véliau kaip
iki rudens semestro pabaigos.

Daznai trecio kurso kursiniai darbai yra tgsiami kaip bakalauro darbai. Tac¢iau galima
raSyti kitos temos bakalauro darba, negu buvo kursinis. Be to, galima keisti ir studijy krypti:
jei kursinis darbas raSytas kalbos tema, bakalauro darba galima raSyti i§ literatiiros arba
atvirk$¢iai. Tiek kursiniy, tiek bakalauro darby temas gali sugalvoti patys studentai.
Pasirinktas darbo vadovas gali vadovauti jisy norimam atlikti tyrimui arba gali Siek tiek
pakoreguoti tema.

Baigiamyjuy, t. y. bakalauro, darby temas tvirtina Rektorius katedros vedéjo teikimu ne
veliau kaip prie§ meénesi iki vieSojo gynimo datos. Rektoriaus patvirtintos baigiamyju darby
temos nekeiCiamos. LeidZiama tik patikslinti baigiamojo darbo pavadinima.

Studentai pagal katedros metodinius nurodymus rengia darba savarankiSkai,
konsultuodamiesi su darbo vadovu, laikydamiesi Lietuviy kalbos ir Lietuviy literatiiros
katedry nustatyty baigiamyjy darby rengimo metodiniy nurodymy. Darbo vadovas
konsultuoja nustatytomis konsultacijy valandomis.

RaSydami kursinius ir bakalauro darbus studentai privalo laikytis moksliniy tyrimy
etikos reikalavimy. Jei rengiant darba nustatomi duomeny falsifikavimo ar neobjektyvaus
interpretavimo atvejai, samoningai iSkraipoma teoriné medziaga, pazeidZiamos autoriy teises,
darbo autorius privalo iStaisyti etikos normy pazeidimus. Jei jis to nepadaro iki darbo vadovo
nustatyto termino, specialiu katedros posédZio nutarimu uZdraudZiama ginti toki darba.
NeleidZiama ginti arba, jei etikos normuy paZeidimas nustatomas tik per vieSa gynima,
neigiamai vertinamas nesavarankiskai atliktas darbas.

NesavarankiSku laikomas darbas: 1) jei visas darbas arba jo dalis paraSyta kito
autoriaus; 2) jei visas darbas ar jo dalis yra be nuorody perraSytas kito autoriaus darbas
(plagiatas); 3) jei darbas sudarytas tik i$ kity autoriy kiiriniy ar juy daliy, nurodant Siy kiiriniy
ar ju daliy autorius, bet virSijant citavimo tikslui reikalinga masta, t. y. kai perraSomi arba
perpasakojami beveik iStisi kity tyrinétojy darbai ir nepateikiama savo apibendrinimy.
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Bakalauro darbui parengti ir apginti skiriama 15 ECTS kredity.

Kiti moksliniy darby Zanrai:

4) Mokslinis praneSimas paprastai yra skaitomas per mokslines konferencijas. Jame
reikia ne tik kalbéti apie kokia nors mokslo problema, idéjos naujuma, bet ir pateikti
argumenty, jrodymy, komentary. Rengiant praneSima, reikia nepamirsti, kad jis bus
skaitomas. Tad Cia geriau vengti ilgy sakiniy, skaitmeninius duomenis deréty apvalinti ir
pasiruosti vaizding medZiaga.

5) Tezés paprastai yra trumpa mokslinio praneSimo santrauka, kurioje glaustai
apibudinamas tyrimas, pateikiami apibendrinti rezultatai ir iSvados. DaZniausiai tezés
iSspausdinamos prie§ konferencija, kad konferencijos dalyviai biity geriau susipaZing su
pristatysimais pranesimais.

6) Straipsniai gali buti dvejopi: gryni moksliniai ir populiarinamieji. Pirmieji raSomi
tos srities mokslininkams ir nuo mokslinio praneSimo skiriasi apimtimi, iSsamesne problemos
analize, platesniu bei gausesniu duomeny, irodymy, iliustracijy pateikimu ir, Zinoma,
sudétingesne kalba. Populiarinamieji straipsniai raSomi neprofesionalams. Paprastai juose
raSoma ne apie kokia nors problema, o apie jau iStirtus dalykus. Toks tekstas turi biti labai
patrauklus.

7) Recenzija — kritinis mokslo darbo ar meno kiirinio vertinimas. Kritika turi buti
korektiska ir argumentuota. Tad recenzijos autorius privalo gerai apgalvoti ir turinj, ir
kalbines raSkos priemones.
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2. REIKALAVIMAI MOKSLINIAMS DARBAMS

Mokslinis tekstas i§ kity iSsiskiria grieZta struktiira, i§ dalies palengvinancia raSanciojo
darba: paprastai nereikia galvoti, kokios turi biiti sudedamosios dalys, kokia tvarka jas
iSdeéstyti. Taciau struktiira mokslo srityse nevienoda. Humanitariniy, socialiniy moksly darby
struktiira laisvesné, gali buti ir ne visos sudedamosios dalys. Grieztos struktiiros paprastai
laikomasi fiziniy, technologijos, biomedicinos moksly darbuose. Apibendrinta mokslinio
darbo struktira biity tokia:

e temos pristatymas, problemos formuluote;
darbo tiksly, uzdaviniy nurodymas, metody paaiskinimas;
ankstesniy darby tiriamaja tema apZvalga;
paties tyrimo analize¢;
pateikiamos iSvados ir apibendrinimai;
nurodomos tokiy tyrimy perspektyvos, o kai kada aptariami pasirinkto metodo
trakumai.

Svarbiausias teksto struktiiros vienetas — pastraipa. Tai riSliy sakiniy grandiné,
vienijama bendros minties. Mokslinio teksto skirstyma pastraipomis reikia labai apgalvoti:
kiekvienoje pastraipoje turi buti pagrindinis sakinys — teiginys. DaZnai rekomenduojama
pastraipa pradéti teiginiu ir baigti apibendrinimu, o tarp ju turi biti aiSkinimas. Mintys
pastraipoje turi buti iSdéstomos nuosekliai laiko, erdvés tvarkos, svarbos pozitiriu. RiSliame
tekste pastraipos turéty biiti panaSaus dydzio. Neturéty biiti vieno sakinio pastraipy.

PanaSios struktiiros kaip pastraipa turéty buti ir didesnis mokslinio teksto vienetas —
skyrius. Kiekvienas skyrius pradedamas iZangine ir baigiamas apibendrinamaja pastraipa, tarp
ju raSomos déstymo pastraipos, kurios taip pat turi pagrindini teiginj ir pateikia, detalizuoja
konkrecia informacija, susijusia su pagrindine skyriaus mintimi. Visos déstymo pastraipos turi
biiti susijusios, tarp ju negali buti minties Suoliy, plg. Sia teksto iStrauka i§ kursinio darbo:

Lietuviy kalboje yra ne viena sprestina problema. Viena i§ ju, ypa¢ aktuali $iomis dienomis, yra skoliniai.’

Skolinys — paimtas i§ kitos kalbos Zodis: barbarizmais paprastai laikomi skoliniai, kurie vartojami be
reikalo, turint taisyklingus atitikmenis savojoje kalboje — taip skolinio reikSmé aiSkinama Lietuviy kalbos
Zodyne. Skoliniai yra nelietuviSskos kilmés ZodZiai, vartojami vietoj lietuvisky atitikmeny. Skolinius vartoja
{vairiy profesiju ir amZiaus grupiy Zmonés: politikai, pardavéjai, finansininkai, teisininkai, taip pat {vairiy meno
sri¢iy atstovai, mokslininkai. Skolinius platina vertéjai, Zurnalistai, uZsienie¢iai." Tiesiog tapo mada savo kalboje
angliskai pavadinti muzikos grupe ar firma.” DaZnai skoliniai i§ miisy buitinés $nekamosios kalbos plinta j rasty
kalba, ypac i perioding spauda, todél yra labai sunku visiskai iSstumti® skolinius i§ lietuviy kalbos. Néra
pasaulyje né vienos kalbos, kuri neturéty svetimy kalby kilmés ZodZiy, skoliniy.” Lietuviy kalboje yra daug
tikryju skoliniy, kurie i misy kalba i§ kity kalby atéjo labai seniai kaip kultiros reiskiniai. Pasaulyje, galima
sakyti, néra tokios kalbos, kuri nebiity kada nors skolinusis ar net dabar tebesiskolina kity kalby Zodziy, ir
verstusi vien savo Zodynu.® Tai yra natiiralus reidkinys, kuris néra vien teigiamas ar vien neigiamas. Visi jo

? Atkreipkite démesj i nevienoda pastraipy ilgj. Pastraipos visame tekste turéty biti panasaus ilgio. Reikia vengti
pastraipy, sudaryty i§ vieno triju trumpy sakiniy. Antrojoje pastraipoje tekstas turéty biiti suskaidytas bent | tris
pastraipas.

* Jeigu rafoma, kad skolinius vartoja ivairiy profesijy ir amZiaus grupiu Zmonés, néra prasmés i§vardyti kai
kurias profesijas.

> Sis sakinys ir toliau esantis tekstas turéty biiti raSomas kitoje pastraipoje, nes &a jau kalbama apie kitus
dalykus. Tarp ankstesnés ir Siame sakinyje esancios informacijos yra minties Suolis: i§ pradziy kalbama apie tai,
kas vartoja skolinius, o kitame sakinyje (toje pacioje pastraipoje) pateiktas kursini rasancio studento
pastebéjimas (galima sakyti, netgi vertinimas) apie skolinius i§ angly kalbos.

® Moksliniuose darbuose reikia vengti tokiy ZodZiu, kaip isstumti, nes jie parodo neigiama raganciojo vertinima.
Mokslo darbuose turi biiti neutralus stilius.

7 Vél minties $uolis tarp ankstesniame ir §iame sakinyje pateiktos informacijos.

¥ Visiems Zinoma ir savaime suprantama informacija. Tokiy dalyky nereikia ra$yti moksliniame darbe.
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vertinimai priklauso nuo skolinio ir jo atitikmens santykio. Kaip pastebi Aldonas Pupkis knygoje ,,Kalbos

kultiiros studijos*: ,,Daugiausia buvo skolintasi i§ slavy kalby (senosios slavy kalbos, baltarusiy (gudy), lenky,

rusy), germany (vokieciy), Siek tiek i$ ugrofiny, latviy ir kity kalb «?

2.1. Mokslinio darbo dalys

Mokslinis darbas skirstomas 1 pagrindines (ivadas, déstymas ir iSvados) ir
papildomasias (antraStinis lapas, turinys, santrauka, priedai, Saltiniy ir literatiiros saraSai)
dalis. Déstymas turéty sudaryti apie 85 proc., ivadas — apie 10 proc., i§vados — apie 5 proc.
pagrindinés darbo dalies. Priedy apimtis daugelyje darby neribojama.

2.1.1. vadas

Ivadas — viena i§ svarbiausiy mokslinio darbo daliy, jis reprezentuoja visa darba ir jo
autoriy, parodo darbo vieta mokslo pasaulyje; tai mokslinio darbo vizitiné kortele. Manoma,
kad ivada geriausia raSyti, kai visas darbas jau baigtas. Taciau darbo pradzioje galima turéti
juodrastini {vado varianta, kuris buty viso darbo orientyras. [vade turi biiti pateikti patys
bendriausi dalykai:

e Darbo objektas daZniausiai sutampa su darbo tema. ApibréZiant objekta turéty biiti
pateikiamas ne tik temos pavadinimas, bet ir nurodomi jos pasirinkimo motyvai,
aptariamos mokslinés perspektyvos, darbo aktualumas.

e Darbo objektas gali sutapti ir su tiriamaja medZiaga. PavyzdZiui, jei darbe
analizuoti naujieji i§ angly kalbos atéj¢ skoliniai, vadinasi, objektas yra skoliniai, o
apraSant tiriamaja medZiaga sukonkretinama, kokie skoliniai tirti, t. y. nurodoma,
kokia empiriné medziaga surinkta.'® [vade reikia nurodyti tiriamosios medZiagos
pobidi (pvz.: publicistikos tekstai, pokalbiy irasai, apklausy duomenys); medziagos
apimti (pvz.: surinkta 100, 5300 pavyzdziy); atrankos kriterijus (pvz.: duomenys
surinkti atlikus kiekybing apklausa; duomenys rinkti i§ pirmo kurso studenty rasto
darby).

e Jei raSomas darbas, kuriame naudojami empiriniai duomenys, biitina nurodyti, i$
kur tie duomenys surinkti, t. y. reikia nurodyti Saltinj. Kaip minéta, duomenys gali
biiti labai {vairiis, taigi ir Saltiniai gali biiti skirtingi. PavyzdZiui, duomenis galima
rinkti i§ groZinés literatiiros, tekstyny, televizijos ir radijo laidy, pokalbiy irasy,
studenty darby ir pan.

e Tikslas — paaiSkinimas, ko siekiama raSomu darbu, kam Sis darbas reikalingas.
Tikslas turéty buti pateikiamas vienas.

e Uzdaviniai — nurodoma, kas turi buti padaryta, kad biity pasiektas tikslas.
Dazniausiai uZtenka nurodyti 2-5 uZdavinius. Formuluojant uZdavinius, vartotinos
veiksmaZzodziy bendratys, o ne veiksmazodiniai daiktavardziai, t. y. palyginti,
istirti, nustatyti, o ne palyginimas, tyrimas, nustatymas.

e Metodai — tai medZiagos nagrinéjimo biidas. [vade metodas ar metodai tik
nurodomi, jie ¢ia neturéty buti placiai aptariami ar analizuojami.

Atliekami tyrimai gali buiti susij¢ su musy patirtimi, jie vadinami empiriniais. Empiriniai

tyrimai remiasi dvejopais principais: indukcijos arba dedukcijos. Atliekant indukcinius
tyrimus pirmiausia surenkami duomenys, jie analizuojami, klasifikuojami, o tada daromi

? Paskutiniame sakinyje pateikta informacija galéty bati pateikta po skoliniy apibrézimo. Sis sakinys nesisieja su
ankstesniu, kuriame ra§oma apie kity kalby ZodZiy skolinimasi kaip reiskinj.

' Empirija — medZiaga, kuri yra tyrimo objektas ir kuria galima apradyti (stebéjimai, duomenys, tekstai,
Saltiniai).
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apibendrinimai, iSvados. Tiriant dedukciniu metodu pirmiausia suformuluojama problema,
tada nurodoma, kaip ja reikéty spresti. Daznai tokiais atvejais yra gaunamos naujos teorijos, o
tos teorijos iliustruojamos pavyzdziais ar eksperimentais. Remiantis dedukciniais metodais
iSvados daromos i$ pirminiy teiginiy. Taigi dedukcija yra atvirkStinis procesas indukcijai: ¢ia
nuo teorijos einama prie pavyzdziy.

Remiantis dedukcija ne visada galima padaryti pagristas iSvadas, nes kartais teorijai
pagristi parenkami tik ta teorija jrodantys pavyzdZiai, o tie pavyzdZiai, kurie prieStarauja,
ignoruojami. Indukcinis metodas pranasSesnis uZ dedukcini dar ir psichologiniu poZiiiriu, nes
indukcija skaitytoja tarsi padaro atradimo, t. y. iSvados, dalyviu.

Lingvistikos darbuose galima remtis ne tik patirtimi, t. y. konkre€iais duomenims,
stebéjimu, bet ir kalbos jausmu, intuicija. Tokie metodai vadinami intuityviaisiais. Vis delto
dauguma lingvisty darby yra empiriniai, todel toliau apraSyti empiriniuose darbuose taikomi
metodai.

Tiek dedukciniai, tiek indukciniai tyrimai yra pagristi tam tikrais metodais. Metodai yra
jvairiai klasifikuojami. Pagal tai, ar analizuojami dabartinio ar ankstesnio laikotarpio
reiSkiniai, skiriami sinchroniniai ir diachroniniai metodai. Pastarieji skirstomi i filologinj,
lyginamaji istorini ir vidinés rekonstrukcijos.

., Filologinis metodas remiasi ta pacia kalba raSyty skirtingy epochy teksty lyginimu.
Lyginant vienodas funkcijas atliekanCius kalbos reiSkinius ankstesniuose ir vélesniuose
tekstuose, nustatoma ty reiSkiniy raida (pvz., palyging M. DaukSos rastuose randamas
daiktavardZiy linksniy formas su vélesniuose raSto paminkluose uzfiksuotomis, nesunkiai
galésime atskleisti lietuviy kalbos daiktavardziy linksniavimo evoliucija, vykusia per ilgesni
ar trumpesni laiko tarpa).” (Palionis 1985: 270).

Lyginamasis istorinis metodas naudojamas, kai lyginami giminiSky kalby faktai ir taip
stengiamasi atkurti ty kalby praeiti. Artimas lyginamajam istoriniam yra vidinés
rekonstrukcijos metodas, kai atkuriami senesniy epochy kalbos reiskiniai remiantis tos pacios
kalbos duomenimis (Palionis 1985: 271).

Sinchroniniai metodai apima vieno laikotarpio medZiaga, jie neatsizZvelgia i kalbos
reiSkiniy kitimg. IS sinchroniniy metody grupés filology baigiamuosiuose darbuose
daZniausiai remiamasi apraSomuoju ir lyginamuoju metodais. Aprdasomasis (deskriptyvinis
analitinis) metodas — toks metodas, kai surenkami tam tikri duomenys ir analizuojami. Tai
reiSkia, kad apibréZiamas reiskinys ar objektas, skaidomas i sudedamasias dalis, tos dalys
lyginamos ir klasifikuojamos. Galiausiai pateikiamos iSvados, kuo pasiZymi analizuoto
vieneto vartosena.

Lyginamasis metodas naudojamas tada, kai lyginami ivairtis duomenys, pvz., lyginama
daiktavardZio vartosena raSytinéje ir sakytinéje kalboje. Norint palyginti, reikia iSanalizuoti
duomenis, taigi aprasomasis ir lyginamasis metodai yra glaudZiai susijg.

Kiekybinés analizés metodas — toks metodas, kai darbe pateikiama statistiniy duomeny.

RaSant darbus sociolingvistikos ar psicholingvistikos temomis, daZnai naudojami
kokybiniai ir kiekybiniai metodai. Kokybiniai tyrimai pasiZymi lankstumu ir duomeny
indukcine analize. Kokybiniai tyrimai daZnai yra nestruktiirizuoti, neturi standartinés tyrimo
strukttros, tinkancios bet kuriai tiriamai aplinkai. Be to, skirtingai negu Kkiti, kokybiniais
tyrimo metodais labiau isiskverbiama i daikty ir reiSkiniy kilme, o ne i skaiciy, kieki (Kardelis
2002).

Kita svarbi kokybiniy tyrimy ypatybé yra ta, jog Siems tyrimams netaikomi grieZzti
imties turio reikalavimai. Ju reprezentatyvuma lemia ne atsitiktiniai tiriamyjy parinkimo
biidai, o lankstis vienokie ar kitokie teoriniai kriterijai. Svarbiausias kokybiniy tyrimy
elementas — tyrimo duomeny apibendrinimas (Kardelis 2002; Rienecker et al. 2003).

Kokybiniams tyrimams paprastai priklauso stebéjimo, pokalbio (interviu), dokumenty
rinkimo, anketinés apklausos ir analizés metodai.
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Kiekybiné apklausa taip pat daznai naudojama sociolingvistikos ar psicholingvistikos
darbuose. Cia svarbu apklausti kuo didesni Zmoniy kiekj ir nustatyti tam tikras tendencijas.

Dirbant su empirine medziaga galima eiti dviem keliais. Pirmasis — surinkti daug
pavyzdziy ar duomeny, pvz., paprasyti kryziukais uZpildyti anketas nemaza Zmoniy skaiCiy.
Tada reikes suskaiCiuoti, kiek ir kokios riiSies atsakymuy gauta, galbiit reikés atlikti statistinius
skaiiavimus, pvz., ar viena Zmoniy grupé pateikia daugiau teisingy atsakymy uz kit (apie
statistinius metodus placiau Zr. 6.2 skyriy).

Norint apklausti kuo daugiau informanty, reikia pateikti lengvai skaiciais paver¢iamus
duomenis, pvz., padéti varneles prie teigiamy atsakymy, kuriuos suskaiiavus galima gauti
kiekvienos kategorijos skaiCiy. Toks metodas ypac¢ tinka i§ anksto iSkeltoms hipotezéms
patvirtinti arba paneigti.

RaSant darbus galima dirbti tokia eiga: pradéti nuo kokybinio tyrimo ir paziuréti, ko
galima tiketis. Toliau, remiantis gautais duomenimis, gali biti iSkeliama hipoteze, o tada, jei
reikia, galima eiti toliau prie kiekybiniy duomeny rinkimo ir pabandyti ta hipotez¢ patvirtinti.

Toliau trumpai aptarti kiti filology darbuose taikomi metodai:

- statistinis (placiau Zr. 6.2 skyriy),

- tekstyny lingvistikos (plaiau Zr. 6.1 skyriy),

- interpretacinis (dazniausiai taikomi literatiiros darbuose),

- instrumentinis (kalbos reiSkiniy tyrin¢jimas {vairiais prietaisais, pvz.,
spektrografu; daZniausiai taikomas fonetikoje),

- distribucinis (nustatomas ZodZiy junglumas, pasiskirstymas ir vartojimas
tekstuose; daZniausiai taikomas fonologijos, morfologijos, sintakseés,
leksikologijos tyrin¢jimuose),

- gretinamasis (labiau nutolusiy dalyky lyginimas; galima taikyti morfologijos,
sintaksés, leksikos, fonologijos tyrinéjimuose),

- opozicijy (kai gretinami skirtingi tyrimo objektai, kad dél kontrasto geriau
iSryskéty ju skirtybés''; taikomas fonologijoje, morfologijoje, sintakséje,
leksikologijoje),

- transformacijy (kai kei¢iama kalbos elementy, pvz., sakinio daliy, iSoriné
tvarka, kalbiné raiSka, siekiant nustatyti, ar del to pakinta teksto turinys,
sakinio prasmé ir pan.; daZniausiai taikomas sintakséje),

- negalimo pavyzdZio (kai samoningai sukuriami realiai nevartojami ZodZiy
junginiai ar sakiniai, iSrySkinantys tiriamyjy vienety reikSmeés arba vartosenos
ypatumus),

- eksperimento (eksperimento metu sukuriamos salygos vartoti kalbos vienetus
ir taip parodyti ju vartojimo ypatumus, pvz., psicholingvistinis eksperimentas,
kai praSoma pateikti pirmus i galva atéjusius zZodZius, kurie asocijuojasi su
pateiktais ZodZiais stimulais),

- kartografinis (kalbos reiSkiniy paplitimo vaizdavimas tam tikrais salygiSkais
Zenklais Zemeélapiuose; paprastai taikomas dialektologijos tyrinéjimuose).

Kuri metoda pasirinkti rasant mokslini darba, paprastai pataria darbo vadovas.

Ivade dar galima nurodyti:
e Problema - tai klausimas, i kuri ketinama darbe atsakyti. Aptariant problema
nereikia raSyti, su kokiomis problemomis susidurta renkant medZiaga, raSant

" Leksinéje semantikoje opozicija suvokiama kaip santykis tarp dviejy ZodZiy, kuriems biidingas bendras ir bent
vienas skiriamasis pozymis. Skiriamos 5 opozicijy rasys: privatyviné, gradualiné, ekvipolentiné, dizjunkcing,
nuling, placiau Zr. Jakaitien¢ 1988.
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darba. Reikia pabréZti tiriamo reiSkinio problemiSkuma: kokias problemas bus
galima i8spresti i$analizavus jisy darbo objekta.'

e Hipotezé — spéjimas, koks galéty biiti atsakymas { iSkelta klausima. Hipotezé
gali pasitvirtinti, gali ir nepasitvirtinti. Nereikia bijoti kelti tokiy hipoteziy,
kurios atlikus tyrima nepasitvirtina.

e Teorijos pasirinkimas — nurodoma, kokiomis teorijomis naudotasi ir kodél jos
pasirinktos. Kursiniuose darbuose daZniausiai uZtenka nurodyti metodus,
bakalauro darbuose kartais nurodomos ir teorijos, pvz., priklausomybiy
gramatikos, funkcinés gramatikos, struktiiralizmo ir pan.

¢ Ankstesniy darby apZvalga — jeigu nagrin¢jama tema jau kas nors rasé, ivade
galima aptarti ty autoriy darbus, trumpai nusakyti jy tyrimy rezultatus. Jei
tiriama tema paraSyta nemaZai darby, jiems apZvelgti galima skirti dalj
tiriamosios darbo dalies.

e Terminai aptariami tuo atveju, kai jie gali buti jvairiai interpretuojami arba yra
labai specifiniai; galima po jvado ar kitur pateikti pagrindiniy darbe vartoty
terminy Zodynélj, ypac jei tokiy terminy gana daug.

e Apsiribojimas — paaiSkinimas, kas i darba neitraukta, i ka neatsizvelgta ir
kodél.

e Darbo struktiirg prasminga pristatyti tada, kai del skyriy, ju iSdéstymo gali
kilti abejoniy. Tai neturéty biti tik daliy iSvardijimas, reikéty keliais ZodZiais
apibudinti, kas bus raSoma kiekvienoje dalyje.

e Dar vertéty nurodyti darbo aktualuma, naujumg, t. y. kuo tiriama tema
aktuali tam tikrai mokslo Sakai, praktikai; ar maZzai tyrinéta. Kiekvienas
mokslinis darbas turi duoti ka nors naujo kurios nors mokslo krypties teorijai ir
praktikai — antraip jo apskritai neverta raSyti. Bet naujumas — nebiitinai naujy
dalyky atradimas; tai gali biiti to paties dalyko analizé kitais metodais, kitais
aspektais; to paties dalyko kity problemy pabrézimas.

e [vade galima apraSyti teoring ir prakting verte. Jeigu yra apibréZtas mokslinis
naujumas, tai teorinés darbo vertés galima neskirti arba keliais sakiniais
nurodyti, kokie pagrindiniai darbo teiginiai yra svarbiis analizuojant tam tikro
dalyko teorija. Jeigu darbo aspektai turi prakting vertg, juos biitina nurodyti.
Reikéty parasyti, kaip konkreciai gali biiti idiegti tyrimo metu gauti rezultatai
ir metodiniai teiginiai.

Anks¢iau minéti dalykai, t. y. objektas, tikslas, hipotez¢ ir pan., ivade turéty buti
pajuodinti, kad skaitytojas i$ karto atkreipty démesi i svarbiausius dalykus.

Ivadas turéty biiti raSomas ne viska iSmananciam skaitytojui (nors daZnai ji skaito tik
vienas darbo vadovas, geras tos srities Zinovas). Ji turéty suprasti kiekvienas, net ir nieko
neiSmanantis apie analizuojama sriti. [vade nepageidauti jvairis pasiteisinimai,
apgailestavimai d¢l laiko, vietos, medZiagos stokos.

Kai kuriuose darbuose (vadoveliuose, monografijose) raSomos pratarmés, kuriose gali
biti trumpai aptariamos darbo atsiradimo, raSymo salygos, dékojama pagalbininkams,
recenzentams, techniniams darbuotojams. Kursiniuose, bakalauro, magistro darbuose

"2 Toliau pateikta viena problemos formuluoté i§ J. RaiZzytés 2009 m. apginto bakalauro darbo Skoliniy ir
svetimvardZiy kaitymo problemos: ,.Senieji nusistovéjusios sulietuvintos raSybos skoliniai abejoniy niekam
nekelia. Siame darbe analizuoti tie kity kalby kilmés ZodZiai, kuriy kaitomumas ar nekaitomumas yra aktuali
problema ne tik kalbos specialistams, bet ir visuomenei. Kalbininkai rekomenduoja daugelj nekaitomy skoliniy,
turin¢iy gale nekirCiuota skiemeni, kaityti, o turin¢iy kiriuota — nekaityti, taciau néra aiskaus saraSo, kurie
skoliniai turéty buti kaitomi, o kurie ne. Todé¢l tiriamojo darbo tikslas — parodyti skoliniy ir svetimvardziy
kaitymo problemas lietuviy kalbos vartosenoje: kiek ir kuriy vartojamos taisyklingos formos, o kuriy ne.
Siekiant uZsibrézto tikslo, keliami tokie uzdaviniai: <...>“.
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pratarmiy raSyti nereikia. Kartais raSomos dedikacijos, t. y. kam skirtas darbas — ju
kursiniuose ir bakalauro darbuose taip pat nereikia.

Toliau pateikta bakalauro darbo jvado istrauka.'’ Atkreipkite démesi, kaip iddéstyti
pagrindiniai ivado dalykai.

Komerciné reklama jau seniai tapo kasdienybés dalimi, o socialiné reklama dar neseniai, bet intensyviai,
patraukia adresato démesj. Nekomerciné reklama i§ esmés skiriasi nuo komercinés. Pagrindiniai jos uzdaviniai
yra: pakeisti elgesio modelius, populiarinti socialines problemas, sukurti teigiama visuomenés nuomong tam
tikru klausimu (Jokubauskas 2003: 143). Socialiné reklama po truputi verZiasi i visy gyvenimus, skatindama
keisti ir keistis, nelikti abejingiems, tolerantiskiau Zvelgti | aplinka. Socialiniy reklamy, naujos reklamy rasies
Lietuvoje, tekstai yra §io tiriamojo darbo objektas.'*

Rasomo darbo tema — kalbiné socialiniy reklamy analizé — pasirinkta ne atsitiktinai, o motyvuotai:
socialinés reklamos pastaraisiais metais tapo aktualios, todél svarbu istirti anksciau lingvistiSkai neanalizuotos
Sios reklamos kalbos désningumus.

Pastebéta, kad beveik visada nekomercinémis reklamomis raginama keisti ir keistis. Todél galima daryti
prielaida, kad toks reklamos poveikis sukuriamas lingvistinémis priemonémis. Tai liudyty apie samoninga tam
tikry kalbiniy formy vartojima siekiant efekto. D¢l to keliama tyrimo hipotezé, jog socialinei reklamai
paveikumo suteikia tam tikros gramatinés kategorijos, ZodZiy reikSmés, tam tikras funkcijas atliekantys sakiniai.

Norint paneigti ar patvirtinti hipotezg, keliamas tiriamojo darbo tikslas: iSanalizuoti socialiniy reklamy
kalbos ypatybes. Minétam tikslui pasiekti keliama keletas uZdaviniy: "

Apzvelgti anksciau atliktus komerciniy reklamy tyrimus.

Istirti daiktavardzio, biidvardZio, veiksmaZodZio kategorijas socialiniy reklamy tekstuose.

Apzvelgti socialinése reklamose vartojamy ZodZiy reikSmes.

Aptarti sakiniy funkcinius tipus.

Kai kuriy gramatiniy kategorijy ir funkciniy sakiniy tipy analizés rezultatus palyginti su anksciau
tirty komerciniy reklamy duomenimis.

Mokslinei analizei naudojami per 2 ménesius i$ pakelés stendy (plakaty), interneto, televizijos surinkti 74
socialiniy reklamy tekstai (109 sakiniai / 454 ZodZiai). Toks laikotarpis ir informacijos kanalai pasirinkti
neatsitiktinai: jie parodo, kiek ir kokiy socialiniy reklamy per 2 ménesius pasiekia kiekviena vartotoja.'®

<..> Straipsniy ar knyguy, kuriose biity analizuojama lietuvisky socialiniy reklamy kalba, néra. Siuo
aspektu tyrimas yra naujas, dél to ir aktualus.'” <...>

Tiriant kalbos dalis ir sakinius pasitelkiami Sie metodai: analizés (analizuojamos gramatinés kalbos daliy
kategorijos, zodziy reikSmes, sakiniy funkcijy tipai), apraSomasis (aprasomi anksciau atlikti komerciniy reklamy
tyrimai, socialiniy reklamy klasifikacija), lyginamasis (lyginamos kai kurios socialiniy ir komerciniy reklamy
gramatinés kategorijos, sakiniy funkciniai tipai).

Darbas susideda i$ keturiy pagrindiniy daliy: ivado, teorinés dalies, analizés dalies ir i§vady. Teorinéje
dalyje pateikiama reklamy klasifikacija, apraSomi anksciau atlikti komerciniy reklamy tyrimai. Analizés dalyje
tiriamos gramatinés kategorijos, ZodZiy reikSmés, sakiniy funkciniai tipai.

Nk

Taigi i§ $io ijvado matyti, kad autoré iSsamiai pristaté savo tyrima: jau i§ ivado aiSku,
kas, kaip ir kodél bus tiriama. Kursiniy darby ivadai gali biiti trumpesni, ne tokie iSsamils,

" Tai Neringos Pakalnytés 2008 m. VDU apginto bakalauro darbo Kalbiné socialiniy reklamy analizé
sutrumpintas ivadas.

' Iprasta, kad {vadas pradedamas bendrais teiginiais apie tiriama objekta; situacija, kuri paskatino imtis vienokio
ar kitokio tyrimo. Kursiniame darbe galima i$ karto pradéti nuo esminiy dalykuy: objekto, tikslo, problemos ir
pan.

"> Atkreipkite démesij, kad pateikiamas vienas tikslas ir i§ karto paaiskinama, kokiais etapais bus siekiama to
tikslo, taigi pateikiami keli uZdaviniai. Darbo uzdavinius galima pateikti ne i$ karto po tikslo.

'® Ragant kalbotyros darbus, jvade arba tiriamojoje darbo dalyje reikia nurodyti analizuotos medziagos pobidi ir
kiekj, nes i$ to galima spresti apie atlikto darbo sudétinguma, patikimuma, vertg.

"7 Kursiniuose darbuose nebiitina nurodyti naujumo ir aktualumo. Paprastai raSant kursini darba dar tik
gilinamasi { mokslo problemas, retai toks darbas btina kazkuo naujas, o rasant bakalauro darbus svarbu suvokti
ju naujuma, teoring ar prakting vertg ir tai galima nurodyti jvade. Reikéty vengti nepagristy teiginiy, plg. Sia
iStrauka i§ kursinio darbo: ,,.Darbe pateiksiu savo surinkto skolinio vartojimo pavyzdzius, kurie nulems mano
kursinio darbo originaluma, iSskirtinuma i§ kity tokio pobudzio darbuy.” I§ tikryju darbe pateikti skolinio
vartojimo pavyzdziai anaiptol néra nei mokslo darbo originalumas, nei iSskirtinumas; kalbotyros darbuose ta
biitina padaryti.
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taciau skaitytojui turi buiti aiSkiis svarbiausi dalykai: darbo objektas, tikslas, uZdaviniai,
analizuotos medZiagos pobidis.

2.1.2. Tiriamoji darbo dalis

Tiriamojoje darbo dalyje (déstyme) turi biiti nuosekliai analizuojami ir apraSomi jvade
numatyti uzdaviniai, jrodinéjami teiginiai, aikinamos hipotezés. Sita dalis turi biti
suskirstyta | skyrius ir poskyrius. Kiekvienas poskyris turéty buti pradedamas jvadine
pastraipa, kurioje raSoma, kas bus analizuojama tame poskyryje, ir baigiamas apibendrinimu,
t. y. trumpomis to poskyrio iSvadomis.

Pirmojoje tiriamojoje darbo dalyje galima pateikti teorini darbo pagrindima, literattiros
apzvalga. Baigus literatiiros apZvalga, reikéty padaryti apibendrinancias iSvadas ir informuoti
skaitytoja apie tai, kas Zinoma apie problemas, kurias planuojama tirti.

Kitoje déstymo dalyje reikia pateikti savo surinktos medZiagos analiz¢, konkretaus
tyrimo duomenis. Gautus rezultatus reikia palyginti su kity autoriy duomenimis (jei tokiy
yra). Lygindamas ir nustatydamas tyrimo rezultaty panaSumus, ypaC skirtumus, autorius
privalo biti labai atsargus ir taktiSkas, nedaryti skuboty iSvady. Reikia atsizvelgti 1
lyginamyjy tyrimy atlikimo salygas, tyrimo metodus ir kitas aplinkybes (Kardelis 2002: 351).

Aptariant rezultatus, iSrySkéja autoriaus erudicija, gebéjimas analizuoti ir sintezuoti
tyrimo rezultatus, lyginti juos su kity autoriy duomenimis, formuoti tolesnio mokslinio tyrimo
kryptis, hipotezes ir t. t. Skyriaus pabaigoje galima aptarti galimas tyrimo klaidas ir abejones
del duomeny patikimumo. Tai jokiu biidu nemenkina darbo vertés, nes pats autorius geriau
negu kas kitas gali kritiSkai jvertinti tyrimo rezultatus, o tai palengvina kity tyréjy darba
(Kardelis 2002: 351).

2.1.3. Isvados

ISvados, kaip ir ivadas, turi savo struktiira. ISvados turéty biiti raSomos taip, kad atsakyty

1 ivade iskelta tiksla ir uZdavinius. ISvadose biitina parasyti:
e ka tyréte ir kokius gavote rezultatus;
e kas galéty pasinaudoti darbo rezultatais;
e kg dar reikéty tirti.

ISvadose neturéty bati lenteliy ar grafiky, visa tai pateikiama déstymo dalyje; neturéty
biti cituojama. Visos darbo iSvados turi iSplaukti i§ jusy darbo, ¢ia negali buti teiginiy,
nesusijusiy su jusy tyrimu. ISvados turi biiti konkrecCios, atitikti darbo pavadinima, tiksla,
uzdavinius, gautus rezultatus. Turi patvirtinti arba paneigti darbo pradzioje iSkelta hipotezg.

Patartina iSvadas numeruoti. Galima skaidyti i smulkesnes dalis, pvz., 2.1.2.

Toliau pateiktos sutrumpintos bakalauro darbo apie socialiniy reklamy kalbines
ypatybes iSvados:

1. Atlikus kalbing socialiniy reklamy analiz¢ paaiskéjo, kad kalbos daliy gramatiniy kategorijy, Zodziy
reikSmiy ir sakiniy funkcijy pasirinkimas socialiniy reklamy kalboje néra atsitiktinis. Jais raginama, kvie¢iama
populiarinti socialines problemas, pakeisti elgesio modelius, sukurti teigiama visuomenés nuomong tam tikru
klausimu.

2. Morfologiné reklamos kalbos analizé parodé, kad daZniausiai socialiniy reklamy kalboje vartojamos
kalbos dalys yra daiktavardis ir veiksmazodis (atitinkamai 31 proc. ir 30 proc.). Biidvardis, kuris yra daZniausia
kalbos dalis vyriSkosiose ir moteriSkosiose komercinése reklamose (Sinkevicitité 2007), socialinése reklamose
yra retas. Veiksmazodis socialinése reklamose yra daznas taip pat kaip ir vaikiSkosiose komercinése reklamose
(Sinkeviciaite 2007).

2.1. DaiktavardZiy vartosenos ypatybiy analizé¢ parod¢, kad socialinése reklamose labiausiai paplitgs
nezymeétasis giminés kategorijos narys — vyriskoji giminé. DaiktavardZiai daznai vartojami vienaskaita.
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2.2. Veiksmazodziy analizé parodé, kad socialiniy reklamy kalboje paplitgs vienaskaitos antrasis asmuo,
kuris daZnai biina liepiamosios nuosakos formos. Tokia vartosena suteikia reklamai paveikumo, nes
sumazinamas atstumas tarp adresanto ir adresato, liepiama veikti. <...>

2.3. Buidvardziy morfologiné analiz¢ parodeé, kad socialinése reklamose labiau paplit¢ daresni kokybiniai
budvardziai.

2.3.1. Budvardziai socialiniy reklamy kalboje daZnai vartojami vienaskaita, paplitgs neZymétasis giminés
kategorijos narys — vyriskoji giminé.

2.3.2. Informatyvus buidvardziy laipsniy tyrimas, kuris parodé, kad socialinése reklamose reciau nei
komercinése reklamose vartojami auksciausiojo laipsnio biidvardziai. Tai patvirtina, jog socialinése reklamose
biidvardis néra toks ,,reklamiskas* kaip komercinése.

2.4. Reklamy kalbos daiktavardziy ir budvardziy linksniy daZznumo analizé patvirtino anksciau istirtus
duomenis, kad gramatiniai linksniai yra labiau paplit¢ nei konkretieji. Tai susij¢ ir su tranzityviniy
veiksmazodziy dominavimu prie§ intranzityvinius.

2.5. Kity, ne tokiy informatyviy, kalbos daliy analizé parodé¢, kad neretai socialiniy reklamy kalboje
vartojami asmeniniai, klausiamieji ir neapibréZiamieji jvardziai. SkaitvardZiai, prieveiksmiai ir tarnybinés kalbos
dalys — retesnés.

<.>

5. Tyrimo hipotezé pasitvirtino: paaiskéjo, kad socialinéms reklamoms paveikumo suteikia
veiksmazodZiy antrasis asmuo pavartotas liepiamaja nuosaka, esamasis laikas (ijvykio veikslas), daiktavardZiy
asmeny pavadinimy vartosena (skatinama spresti su asmenimis susijusias problemas), biidvardZziy, reiskianciy
psichini vidinj pozZymj vartosena (apeliuojama { adresato savijauta ir psichologing biisena), aktyvy veiksma
reiSkianCiy veiksmazodZiy ir skatinamyjy sakiniy vartosena. Tyrimo rezultatai parodé, kad budvardziy
auksciausiasis laipsnis socialinése reklamose néra toks daznas kaip komercinése. Abstraktesnés reikSmés
daiktavardZiai retai randami. Saukiamieji sakiniai emoci$kai stiprina skatinima.

<.>

8. Darbo rezultatais galéty naudotis socialiniy reklamu kiiréjai, reklamos kalba analizuojantys tyréjai,
sociolingvistika tiriantys ar ivairius kalbos reiskinius analizuojantys asmenys.

<.>

10. Be kalbiniy socialiniy reklamy ypatybiy analizés galima buty tirti $iy reklamy vaizda, garsa ir ju itaka
toms reklamoms suvokti, padaryti jas itaigias.

Paprastai iSvados pateikiamos tokia eilés tvarka, kokia buvo pateikti uZzdaviniai (iSvady
ir uzdaviniy numeracija nebttinai turi sutapti). Kaip matyti i§ anks¢iau pateikto pavyzdzio,
tam tikra uZdavini atitinkanti iSvada turi bati i§samesné, ilgesné nei ivade pateikta uzdavinio
formuluote.

2.1.4. Papildomosios dalys

Pirmoji papildomoji darbo dalis — antraStinis lapas. Jame turi biiti nurodyta:

e tikslus institucijos pavadinimas (ne santrumpa);

e autorius (vardas ir pavarde);

e pavadinimas;

e raSto darbo pobudis (kursinis, bakalauro, magistro darbas (ne bakalaurinis ar
magistrinis darbas!), referatas, namy darbas ir kt.);

e vadovas ar darba tikrinantis déstytojas (greta vardo ir pavardeés reikia nurodyti
déstytojo mokslini laipsni ir pedagogini varda; biitina suderinti gimines, t. y.
vadovas arba vadové);

e paraSymo metai ir vieta (Zr. 1 ir 2 priedus).

Turinys turi gerai atspindéti darbo struktiira, reikia iSvardyti visas sudétines dalis
(skyrius, poskyrius, skyrelius) ir nurodyti ju puslapius. Teksto nereikia suskaidyti i pernelyg
smulkius skyrelius, pvz., 5.1.3.2.4.2.

Strukturinés darbo dalys turi biiti labai aiSkiai suformuluotos. Skaitytojas turi Zinoti, ko
gali tikétis iS kiekvieno skyriaus: jeigu dalies pavadinime yra Zodis analizé, vadinasi, bus
analizuojama, jeigu — aptarimas, bus tik aptariama. Patartina déstymo dalis sunumeruoti
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(paprastai numeruojama arabiskais skaitmenimis), kitos dalys (ivadas, i§vados ir kt.) gali biiti
nenumeruojamos. Toliau pateikti du turiniy pavyzdziai: pirmame pavyzdyje sunumeruota tik
tiriamoji dalis, o antrame pavyzdyje — visos pagrindinés dalys.

Turinys
Lietuviy kalbos fonemy automatiné garsy kaita (santrauka)'®.........ocooeeeeeeeeeeeeeee, 3
The automatic changes of phonemes in Lithuanian (SUMmMary) ...........ccccoceeeveeerriiireenieeeeenneen. 4
TVAAAS ...ttt e e et e e e e e e e et e e e e e e atbbb—aaaaeeeaattaaaraaeeeeanararaaaaens 5
1. Automatiné garsy kaita lietuviy kalbos SaKNYSE .........cevvveeriieiriiiiniieniienieceieeeeeeseec e 6
1.1. PriebalSit PAKItIMAL....c..veerrueeriieieniiieniee ettt ettt s sebee s e e 8
111, DISIMIHACIJA et eiiee ettt ettt sttt sane e 8
11,2, KONEAKCIA . eeeueiieiiieieiee ettt sttt 15
1.1, BalSiy PAKItIMAL «.eeeeeueeireeeiiieeeeiiieeeeiiee e ettt e ettt e e et e e e ettt e e senteeeeenneeeseneeeeeeaneeeeans 17
1.2.1. Tlguju balSiy trumpPinimas. ......cceeueeerieerieerieerieeenieeeneeenreesreesbeeeieeesieeenanee e 18
1.2.2. 0j, €], TV VIENDAISINIIMAS . ...ccoveieiiieniiieniie ettt ettt et 20
ISVAAOS ..ottt sttt ettt ettt et e 22
SAltNial i HEETALTAIA ..........veveceeeeeeeseeeeeeeeee et se s s s se e ee e es e senenen 25
SULTUMPINIINAT ..ttt ettt ettt st e st e e bt e sateesabeesabeesabe e e bt e e saneesaneesane 26
PLICAAL.c..eeeeeieeeee ettt ettt st et 27
Turinys
Lietuviy kalbos fonemy automatiné garsy kaita (Santrauka) ...........ccceeceeeeeriieeeeriiieeeeiieeeeniieeenns 3
The automatic changes of phonemes in Lithuanian (SUMMAry) ..........ccccceeeeveeerniieeeecieeeeniieenns 4
) B 2T b TP UPRR S PRR 5
2. Automatiné garsy kaita lietuviy Kalbos SAKNYSE .........ccovveiriiiiniiiniiiniieciieeeeceniee e 6
2.1. PriebalSiy PAKItIMAL....c..veerueeiriiieniieentee ettt ettt sttt ettt e s e s e it eesanee e 8
2.1 1. DISIMIHACIJA +eenvveeereeriiieeiieeitt ettt ettt s 8
2.1.2. KONIAKCIA e ettt ettt e e 15
2.1, BalSiyl PAKITIMAL «.eeeeeueeieeeeiiiieeeiieeeeiicee et e e ettt e e et e e e et ee e s e e e eneeeessnneeeesnneeeeennes 17
2.2.1. Tlguju balSiy trumMpPINImas. ......eeereeeerueerieeriieenieeentee e ntee et e eieeesareesaneesareeeane 18
2.2.2. 0J, €], TGV VIENDAISINIIMAS ....ccevuereirierieeiieeiiee ettt e steesree st e it st e saneesanee e 20
B IBVAAOS .ttt ettt ettt sttt e b e st e s e e e 22
4. SAltiNGal i THETAIIA .......cv.vecveeceeeceecee e 25
5. SULTUMPINIMAT ¢ .uteeeiiiieiiieniiee ettt sttt ettt sttt e st e e bt e e saaeesabeesabeeesbeeenaneesaneenane 26
6. PIIEAAL ..ottt st ettt e e e 27

Analizuojama medZiaga, didelés lentelés gali biti pateikiamos prieduose. Priedus reikia
numeruoti ir pavadinti, jeigu butina, paaiSkinti, kas prieduose pateikiama. Puslapiai Cia
numeruojami kaip ir visame darbe. Tiriamojoje dalyje turi biiti nuoroda i prieda.

Jeigu vartojama daug pasikartojan¢iy sutartiniy Zenkly, simboliy, vienety, terminy
santrumpy ir jeigu jie pavartoti daugiau nei pora karty, reikéty pateikti sutrumpinimy ir
santrumpy sarasa. [ $i sarasa nereikia jtraukti visiems Zinomy sutrumpinimy (pvz.: pvz., t. y.,
kt.). Sutrumpinimy ir santrumpy sarasa reikia pateikti darbo pabaigoje.

Santrauka turi biiti raSoma taip, kad ja galéty suprasti ir ne tos srities specialistas. Cia

turi biti labai apibendrintai pateikta:

e objektas,
tikslas,
uzdaviniai,
metodai,
turinys,
rezultatai,
iSvados ir rekomendacijos.

'8 Santraukos reikalingos tik bakalauro ir magistro darbams.
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Santrauka turi biti glausta ir informatyvi, ji turéty padéti apsispresti, ar verta skaityti
darba. Santrauka reikalinga tik bakalauro ir magistro darbams. Santraukos pateikiamos iS$
karto po turinio. Bakalauro ir magistro darbuose turi biti dvi santraukos: santrauka lietuviy
kalba ir santrauka viena i§ pagrindiniy Europos Bendrijos kalby. Santraukos neturéty biiti
ilgesnés nei vienas puslapis, t. y. vieno puslapio apimties santrauka lietuviy kalba ir vieno
puslapio apimties santrauka uZsienio kalba. Pateikiant santraukas paciame darbe ir turinyje
turi bati paraSomas darbo pavadinimas ir nurodoma, kad tai santrauka. Sis reikalavimas
galioja santraukoms ir lietuviy, ir uzsienio kalba. Santraukos nenumeruojamos kaip atskiri
poskyriai (Zr. turinio pavyzdZius).

Santrauka reikia raSyti riSliu tekstu, o ne punktais. Nereikia numeruoti iSvady ir
uzdaviniy, Zr. toliau pateikta pavyzdi:

Siame darbe analizuotos horoskopy leksikos ypatybés. Tokia tema pasirinkti paskatino knygoje Zanro
ribos ir paribiai iSsakyta pozicija, kad horoskopy kalba labai aptaki ir daznai daugiaprasmeé, kad kiekvienas
skaitytojas suprasty kaip nori (Marcinkevi¢iené¢ 2008: 171). Todél Sio tiriamojo darbo tikslas — iSanalizuoti
horoskopu leksikos ypatybes, norint patvirtinti arba paneigti hipotezg, kad skirtingiems zodiako Zenklams
parasyti tekstai neturéty skirtis leksikos ypatybémis.

Tikslui pasiekti kelti tokie uzdaviniai: sudaryti bendra horoskopy tekstyna ir dvylika atskiry horoskopo
Zenkly tekstyny; apZvelgti teoring literatiira, kurioje apraSomos lietuviy kalbos leksikos ypatybés; iSanalizuoti
tekstyny leksikos ypatybes: iSrinkti prasminius ZodZius ir ZodZiy junginius, sudaryti daZninius Zodziy sarasus,
nustatyti daZniausias ZodZiy ir ZodZiy junginiy lemas bei jas suskirstyti i temines grupes.

IStyrus tekstynus ir ju duomenis paaiskéjo, kad pati didZiausia teminé grupé yra aktyvaus veiksmo,
maziausiai horoskopuose minimi daiktai — astrologinése prognozése dazniausiai aptariamos abstrak¢ios realijos.
Ateit] pranasaujanciuose tekstuose neretai kalbama apie darba, santykius, skaitytojas skatinamas veikti.
Pagrindinis dominuojantis jausmas — meilé. Ypa¢ akcentuojamas asmeniskumas. Sie pagrindiniai horoskopy
bruozai atsiskleidZia visuose analizuotuose tekstynuose. Nepaisant horoskopo Zenklo, visi tekstai pasiZymi tomis
paciomis leksikos savybémis. Daugumoje teminiy grupiy pacios dazniausios lemos rastos visuose tekstyny
dazniniuose sarasSuose. Tik pastoviyjy junginiy analizé parodé, kad visuose horoskopo Zenkly tekstuose
aptariamos tos pacios realijos, bet skirtingiau ir jvairiau, i§laikant ta pacia esme."

§altiniq ir literatiiros saraSe (jie gali biiti ir atskiri) pagal bibliografijos apraso
taisykles (Zr. 3 prieda) pateikiami tik naudoty Saltiniy ir cituotos literatiros duomenys.
Vadinasi, 1 Si sarasa jtraukiami tik tie Saltiniai ir literatiira, kurie turi nuorodas tekste. Sarasas
sudaromas abécelés tvarka. Publikacijas nelotyniSkais raSmenimis rekomenduojama
transliteruoti (t. y. perraSyti lotyniSkais raSmenimis) ir pateikti bendrame saraSe. Literattiros
saraSe pateikty knygu ir kity darby nereikia numeruoti.

Moksliniuose darbuose ne visada tinkamai atskiriami 3altiniai ir literat@ra. Saltiniai —
tai tekstai, pokalbiy irasai, knygos, duomeny bazés, i§ kuriy rinkta medZiaga moksliniam
darbui. PavyzdZiui, raSant darba tema Zod%io , klausimas* vartosena dabartinéje lietuviy
kalboje Saltiniu galima pasirinkti Dabartinés lietuviy kalbos tekstynq — didele elektroniniy
teksty duomeny bazg. Norint iSsiaiSkinti vardininko funkcijas dabartinéje lietuviy kalboje,
vienu i§ Saltiniy galima pasirinkti sakyting kalba, pvz., spontaniSkos kalbos jrasus. Jei
moksliniame darbe tiriamos metaforos, pavartos Siuolaikiniy rasytoju es¢, tokiu atveju darbo
Saltiniu galéty buti, pvz., R. gerelytés, S. Parulskio, G. Beresneviciaus ir kt. autoriy kiiriniai.

Jeigu medZiaga rinkta i§ vieno dvieju Saltiniy, juos uZtenka aptarti ivade; nereikia skirti
atskiro skyriaus. Jei Saltiniy daugiau, rekomenduotina visus Saltinius surasyti atskiroje dalyje
darbo gale.

Literatlira — tai ta teoriné medZiaga, kuria remiamasi rasant mokslinius darbus; tai
mokslininky, studenty darbai, kurie yra svarbis tiriant tam tikra tema, kuriuose galima rasti
naudingos informacijos, padedancios irodyti tam tikrus teiginius, pagristi tam tikros teorijos
ar metodo pasirinkima. PavyzdZiui, jei raSomas darbas apie metafory vartosena, apie

" Tai 2011 m. Zivilés Varnagirytés apginto bakalauro darbo ,,Horoskopy leksikos ypatybés* santrauka.
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metaforos samprata, ju klasifikacija galima paskaityti ir savo darbe pasiremti K. Zuperkos
»wotilistika®, R. KoZeniauskienés ,,Retorika. ISkalbos stilistika* ir pan. darbais. Jeigu tiriami
linksniai ir ju funkcijos, butina paskaityti ir pacituoti A. Paulauskienés ,Lietuviy kalbos
morfologija®, V. Labucio ,Lietuviy kalbos sintaks¢* ir pan. darbus. Analizuojantiems
reikSmiy pasiskirstyma, bitina remtis E. Jakaitienés ,,Lietuviy kalbos leksikologija®, ,,.Leksine
semantika® ir pan. Kita vertus, jei buvo perskaitytas vadovélis, straipsnis, bet i§ jo
moksliniame darbe nepanaudota né viena mintis, tokiu atveju tie darbai neitraukiami i
literatiiros sarasa.

2.2. Formalieji mokslinio darbo reikalavimai

Pastabos (iSnaSos, komentarai, nuorodos) — tekstas, kuriuo komentuojama, papildoma,
paaiskinama tam tikra informacija. Jos nepriklauso darbo tekstui, todé¢l pateikiamos:
a) skliausteliuose (tai literatiiros, priedy, kity skyriy nuorodos);
b) iSnaSose (tai butini trumpi paaiSkinimai, kuriy negalima tiesiogiai susieti su
visu tekstu);
c) teksto pabaigoje (Cia pateikiami visi komentarai eilés tvarka, kaip jie ir buvo
suzymeti tekste).

Pavyzdziai turi buti pateikiami kursyvu (skai¢iy kursyvu raSyti nereikia). Reik§mé
aiSkinama paprastosiose kabutése, pvz.: kaduogys ,kadagys“, kadagys ,sausy viety
dekoratyvinis spygliuotis kriimas ar medis juodomis uogomis, kadagys (lot. Juniperus)*.
Zodis ar junginys, kurj norima idry$kinti pavyzdyje, gali biti iretinamas. I§retinami,
pabraukiami arba parySkinami gali biiti labai svarbus teiginiai ar mintys.

Kiriniy pavadinimai gali biiti raomi kabutése arba kursyvu, pvz.: Zemaités apsakymas
,Marti* arba Zemaités apsakymas Marti.

Moksliniame darbe daZnai reikia pasiremti kity teiginiais, juy autoriai turi biiti nurodomi.
Svetimos mintys gali biiti paZodZiui perteikiamos (t. y. cituojamos) arba perpasakojamos
(perfrazuojamos, referuojamos). Citatos rasomos kabutése, i teksta iterptas perfrazuotas
teiginys raSomas be kabuciy (placiau Zr. 5 skyriy).

Pazodinéje citatoje gali buti praleidZziamas tekstas, ta vieta reikia Zyméti <...>. Citatoje
iterptas darbo autoriaus komentaras rasomas lauztiniuose skliausteliuose [komentaras]. Labai
ilga citata gali buti atitraukiama nuo parastés ir surinkta maZesnémis raidémis arba raSoma
kursyvu. Kai kada citatos tekstas neatitinka dabartinés bendrinés kalbos (raSybos, kalbos
kulttros) normy, tada rekomenduojama po tokio ZodZio raSyti nuoroda /sic!].

Kabuciy, skyrybos, iSnaSy Zenklus patartina iSdéstyti tokia tvarka: ,BrandZiose
bendrinése kalbose nebiina istisinés kodifikacijos.“* Taigi pirmiausia raSomas taskas ar kitas
skyrybos Zenklas, po to uzdaromos kabutés ir uz jy raSomas iSnasos Zenklas.

Kartais cituojant kai kuriuos ZodZius ar teiginius norima iSryskinti. Tokiu atveju raSoma
taip: ,,BrandZiose bendrinése kalbose nebiina iStisinés kodifikacijos.* (pabraukta mano — V.
P.). Tai reiSkia, kad darbo autorius, kurio inicialai nurodomi skliaustuose (pvz., Vardenis
Pavardenis), nori pabrézti Zodi istisinés ir ji pabraukia citatoje.

Jei citata norima jterpti ir pradéti raSyti maZzaja raide ir jei citatos pirmasis Zodis buvo
paraSytas didZiaja raide, pirma citatos raid¢ rekomenduojama raSyti lauZtiniuose skliaustuose:

Ribos tarp sinchronijos ir diachronijos ne visada aiskios. Kaip teigia Vincas Urbutis (2009:165), ,,[r]iba
tarp skaidomo i morfemas ir neskaidomo kamieno yra negrieZta ir istoriSkai pereinama: buve¢ skaidomi kamienai
ilgainiui tampa neskaidomi, o neskaidomi kamienai, kad ir Zymiai reciau, gali pasidaryti skaidomi. Kiekvienu
momentu kalboje yra pereinamuyjy reiskiniy, kur skaidymas ar neskaidymas i§ esmés yra susitarimo dalykas. Ir
ten, kur morfema tikrai iSsiskiria, jos i$siskyrimo laipsnis, arba rySkumas, néra visur vienodas.*
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Citaty, perfrazuoty teiginiy autoriy nuorodos pateikiamos paciame tekste:
skliausteliuose nurodoma autoriaus pavarde, publikacijos leidimo metai ir puslapis, pvz.:

Kai kurie mokslininkai (Zinkevicius 2000: 25; Girdenis 2001: 223) §j reiskinj aiskina...
Kai kurie mokslininkai (Zinkevicius 2000; Girdenis 2001) §j reiskinj aiSkina...

Prie§ autoriy ar veikala tuose paciuose skliaustuose gali biiti vartojamos santrumpos
plg., zr., pvz.: (plg. Urbutis 1978: 50), ju sutrumpinimy saraSe paaiSkinti nereikia. Kai
minimos to paties autoriaus tais paciais metais iSleistos publikacijos, pridedamos mazosios
raides. Jos iSdéstomos abécéles tvarka, pvz.:

Esama ir kitokiy vertinimy (Zinkevicius 2000a, 2000b).

Literaturos sarase jie suraSomi taip pat tokia tvarka. Jeigu pateikiama paZzodiné citata,
puslapj biitina nurodyti. Jeigu perfrazuojama, tada puslapio galima ir nenurodyti.*® Jeigu
autoriaus pavardé pateikiama tekste, tada skliaustelivose nurodomi tik metai (jeigu butina, ir
puslapis), pvz.:

Zinkevicius (2000) teigia, kad ...

Jeigu yra keli tos publikacijos autoriai, tai nuorodoje raSoma viena pavarde ir et al. (iS
lot. et alii — ir kiti), bet riSliame tekste reikia nurodyti visas pavardes, pvz.:

E. Jakaitiené, A. Laigonaité ir A. Paulauskiené (1976) teigia, kad...

Kai kuriy gerai Zinomy veikaly gali biiti nurodomos raidinés santrumpos, pvz.: Lietuviy
kalbos Zodynas — LKZ (zodyno puslapiai nenurodomi); LKZe — internetinis (elektroninis)
Lietuviy kalbos Zodyno variantas; Lietuviy kalbos gramatika — LKG 1965: 255; DLKT —
Dabartinés lietuviy kalbos tekstynas. RaSant literatiros darbus, rekomenduojama vartoti
Saltiniy santrumpas (ypac jei naudojami keli Saltiniai, jei Saltiniy pavadinimai yra ilgi), pvz.,
BD — , Balta drobulé®.

Santrumpomis galima Zymeéti ir institucijas: VDU — Vytauto DidZiojo universitetas,
VLKK - Valstybiné lietuviy kalbos komisija, LKI — Lietuviy kalbos institutas.

Jeigu cituojamas darbas paraSytas nelotyniSko alfabeto raidémis, tai autorius ar
pavadinimas riSliame tekste transliteruojami, pvz.: Lukov (galima pridéti ir galiing, t. y. rasyti
Lukovas), o kaip literatiiros nuoroda skliaustuose raSoma originalo kalba, pvz.: (JIykos 1976:
25).

Norint pacituoti vieno autoriaus tekste cituojama kita autoriy, rekomenduojama raSyti
taip:

<...> juo labiau, kad ,,skiautinys* (daiktavardZio vedinys) néra vieniSas darinys, plg. panasius vedinius
drobinys, Zabinys, zirginys (Keinys 1975: 45, cituojama i§ Girc¢ien¢ 2003: 48).

Literatiiros sarase nurodomas tik tas Saltinis, i§ kurio cituojama.
Néra vienos nuomones dél autoriy vardy raSymo:

1) vardo raide¢ galima raSyti tik pirma karta minint autoriy, toliau raSyti tik
pavardg;

%% Reikeéty pernelyg nepiktnaudziauti §iuo patarimu. Mokslo darbuose rekomenduojama nurodyti perpasakojamos
vietos puslapi.
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2) galima ir visada greta pavardés tekste (ne nuorodose) rasSyti ir vardo raid¢ arba
visa varda.

Svarbiausia, kad visame darbe bty vienodai cituojama ir tuo paciu principu nurodomi
autoriy vardai bei pavardés.

Tas pats pasakytina ir apie uZsienieCiy pavardes: jas galima lietuvinti, galima palikti
originalo kalba. Rekomenduotina prie uZsienietiSky vardy ir pavardziy, kur galima, pridéti
lietuviSkas galtines. Kokias galtines galima pridéti, reikéty pasitikslinti Valstybinés lietuviy
kalbos komisijos nutarimuose (Zr. http://www.vlkk.Ilt/nutarimai/svetimvardziai.html).

Lentelés, paveikslai numeruojami i$ eilés per visa darba arabiSkais skaitmenimis, Salia
paryskintomis raidémis paraomi ju pavadinimai. ZodZiai lentelé, paveikslas ir ju numeriai
turi buti iSretinti. Lentelés pavadinimas raSomas vir§ jos, paveikslo — apacioje. Po pavadinimy
nereikia taSky. Toliau pateikti paveikslo ir lentelés pavyzdziai.

50%
45%
40%
35%
30% -
25% -

.
20% CEERD ——

15%
10%
5% 1 9,8% 9,5%
0%

1 kir€iuoté 2 kir¢iuoté 3 kir¢iuoté 4 kir€iuoté

1 paveikslas. Daiktavardzio kir¢iuociy santykiai

1 lentelé¢. Linksniy semantinés ir sintaksinés funkcijos

Linksnis Funkcija

Vardininkas Subjektas

Kilmininkas Objektas, aplinkybés
Naudininkas Objektas, subjektas, aplinkybés

I kiekviena lentele ar paveiksla darbe turi biti nuoroda, pvz.: Linksniy semantinés ir
sintaksinés funkcijos apibendrintai pateiktos 1 lenteléje. Kaip rodo tyrimo rezultatai, 3 ir 4
kirciuociy ZodZiy néra daug (¥r. 1 pav.*"). Paveikslais darbe turi buti vadinami jvairis
grafikai, diagramos. Todél negalima raSyti: kaip matyti is' 1 grafiko, turi buti kaip matyti is 1
paveiksle pateikto grafiko.

Jei tekste yra tik viena lentelé arba vienas paveikslas, ju numeruoti nereikia. Lenteliy ir
paveiksly numeracija yra atskira.

Kai kada lentelése ar paveiksluose teikiami duomenys néra nustatyti darbo autoriaus,
tada reikia nurodyti Saltini (Salia pavadinimo arba po lentele mazesnémis raidémis).

Duomenis lentelése, pacius lenteliy ir paveiksly pavadinimus galima raSyti iprastu
dydziu, t. y. 12 pt. raidémis, bet galima raSyti ir maZesnémis raidémis: 10 ar 11 pt. Svarbu,
kad paveiksluose bei lentelése pateikti duomenys biity iskaitomi ir suprantami.

[liustraciné medZiaga (paveikslai, lentelés) ir tekstas turi vienas kita papildyti, o ne
dubliuoti. Todél netikslinga tekste iSvardyti visus lenteléje ar paveiksle esancius skaiCius.
Svarbu neperkrauti teksto lentelémis ir paveikslais, nes tada sunku skaityti.

*! Jei rafote visa Zodi paveikslas, lentelé, biitina suderinti linksnius, t. y. Zr. I lentele; plg. I paveikslg.
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Jeigu norima aptarti dviejy démeny vartosena, pvz., vienaskaitos ir daugiskaitos;
moteriSkosios ir vyriSkosios gimings ir pan., tada nereikia duomeny pateikti paveiksluose, nes
paveikslai skirti tam, kad biity galima lengviau vizualiai isivaizduoti darbe pateikiama
informacija. Jeigu norima pateikti daug lenteliy, jas reikéty kelti i priedus. Prieduose patartina
pateikti dideles (viename puslapyje netelpancias) lenteles.

Lituanisty raSomy darby apimtis (be priedy) turéty biiti tokia:

e kursinis darbas — apie 1 autorini lanka (apie 40 000 spaudos Zenkly, 15-25
psl),

e Dbakalauro darbas — apie 1,5 autorinio lanko (apie 60 000 Zenkly, 3545 psl.),

e magistro darbas — apie 2,5 lankus (apie 100 000 Zenkly, 5565 psl.).

RaSoma tik vienoje lapo pus¢je A4 formato (210 x 297 mm) popieriuje paliekant tokias
parastes: virSuting ir apatiné — po 20 mm, kairioji — 30 mm, deSinioji — 10 mm.

Puslapiai, iSskyrus antrastinj, numeruojami, bet antrastinis lapas iskai¢iuojamas i bendra
puslapiy skai€iy, tik ant jo neturi biiti puslapio numerio. Puslapio numeris raSomas lapo
apatinés paraStés centre, arabiSkais skaitmenimis, be tasky ir kableliy.

Kiekvienos pastraipos pirmoji eiluté atitraukiama nuo kairiosios paraStés 15 mm.
Pastraipoms nustatoma abipusé¢ lygiuoté — tekstas sulygiuojamas ir pagal deSiniaja, ir pagal
kairiaja parastes.

Tarp eiluiy paliekamas 1,5 eilutés intervalas. Skyriy pavadinimai atitraukiami nuo
teksto per 2 eiluciy intervala, poskyriy — per 1,5 eilutés intervala.

Darbo ir skyriy pavadinimai raSomi paryskintomis didZiosiomis raidémis, poskyriy —
parySkintomis mazosiomis. Skyriy pavadinimy raidZiy aukstis turi buti 16 pt., poskyriy — 14
pt., skirsniy — 12 pt. Puslapio apacioje ar viso teksto gale iSnaSos raSomos 10 dydZio raidémis.
MaZesnémis raidémis rekomenduojama rasSyti pavyzdZius, ypac€ jei ju pateikiama keletas iS$
karto; ne tokius svarbius teiginius.

Tekstas turi buti raSomas 7Times New Roman arba Palemono Sriftu. Kitokie Sriftai
nerekomenduoti moksliniuose darbuose. Moksliniuose darbuose reikia stengtis nenaudoti
ivairiy, daZnai skaitytoju démesi blaskanciy simboliy, pvz., numeruojant ne skaiCiais, o
simboliais, reikéty naudoti vieno (to paties lygmens teksto numeracijai) tipo simbolius:
kvadratélius, rutuliukus, varneles; nereikéty varijuoti Siais simboliais.

Moksliniai darbai turi buti paraSyti taisyklinga lietuviy kalba, be klaidy, mintys
iSdéstytos aiSkiai, nuosekliai, suprantamai, sistemingai. Darbas turi buti spausdintas
kompiuteriu.

2.3. Formalieji kompiuteriu renkamo teksto reikalavimai

Po beveik visy skyrybos Zenkly (, . ; : ? !) turi bati tarpas, po ZodZio prie§ skyrybos
Zenkla tarpas nededamas, pvz.: Kad vaiko organizme tritksta skysciy, rodo Sie poZymiai:
sausos lilpos, lieZuvis ir burnos gleiviné, ikritusios akys, verksmas be aSary; tamsus slapimas,
retas Slapinimasis. Visame pasaulyje uZdrausta reklamuoti pieno pakaitalus. Kodel? Norima
skatinti natiiraly kidikiy maitinimq!

Tarpy nereikia, jei kableliu skiriamos sudétinio skaiCiaus dalys, pvz.: per ménesj
benzino kaina padidéjo 3,5 procento, arba kai keli skai¢iai sudaro skyriaus pavadinimo dali,
pvz.: 2.5.1. Terminijos apZvalga. Be tarpy raSomos kai kurios Zenkly kombinacijos, pvz.: ?/
L. 2.0 111 ..., bet po kablelio prie§ bruksni dedamas tarpas, t. y. , — Kartais su tarpais raSomi
ilgesni skaiciai, kad juos biity lengviau suvokti ir perskaityti, pvz.: 3 876 234 gyventojy.
[sidémétina, kad tokiais atvejais skaiiai negali buti skiriami kableliais ar taskais.
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Reikalingi tarpai po santrumpos ir kito ZodZio, pvz.: I Simonaityté; doc. dr.
V. Pavardenis™; nr. 15; 30 %; t. y.; t. t.; § m. Jei sakinys baigiasi sutrumpinimais, pvz., . f.,
kt., pan., po ju raSomas vienas, o ne du taskai. Negalima ZodZiy junginiy sutrumpinimy skirti
pasviruoju briikSniu. Turi biti a. k., 0 ne a/k (asmens kodas); p. d., o ne p/d (paSto dézute).
Pasviru bruks$niu Zymimas dviejy Zodziy santykis, pvz.: m/sek. (metry per sekundeg), arba du
lygiaver€iai dalykai, pvz., 130/80 (arterinio kraujospudzio dydziai).

Reikia isidéméti, kad po tarptautiniy maty santrumpy nerasomi taskai, pvz.: cm, km, h,
ha, kg ir kt. Taskai neraSomi po akronimy, pvz.: ES, JAV, VDU.

Skliaustai raSomi tokiu badu: Zemé yra fatalizmo motina, dél to daugelis azijieciy
daznai pasiduoda likimui, kuri jiiros (bei dvasios) jégy sukurstytas vakarietis pats kalasi, t.y.
po skliausto ir pries§ ji neturi biti tarpy.

Toliau pateiktame sakinyje matyti, kaip turéty buti raSomos lietuviskos kabutés: Jos
tarptautiniu atZvilgiu esancios maZai naudingos, nes savo ,,mikroskopiskumu“ tik kliudancios
didZiosioms valstybéms racionaliai tvarkyti pasaulj. Tarp kabuCiy ir ZodZio neturi buti tarpy.
Koks nors pavadinimas gali biiti raSomas tarp kabuciy arba kursyvu, pvz.: ,Dabartinés
lietuviy kalbos Zodyne* pateikta apie 50 000 ZodZiy lizdy arba Dabartinés lietuviy kalbos
Zodyne pateikta apie 50 000 Zodziy lizdy.

Jei tekste susiduria dveji skliausteliai ar dvejos kabutés, reikia raSyti tik vienus
skliaustus ir vienas kabutes.

DaZnai neZinoma, kur raSytinas briks$nelis, o kur vidutinio ilgio briik§nys. BriikSnelis
raSomas tarp dviejy lygiareikSmiy ZodZiy, kurie reiSkia sudétini vieno dalyko pavadinima,
pvz.: lopSelis-darZelis, paroda-pardavimas. NeraSomas tarp ZodZiy, kuriy vienas paaiskina ar
patikslina kita, pvz.: gydytojas chirurgas, bité motinélé. BriikkSnelis taip pat raSomas tarp
dvigubos pavardés daliy ar tarp pavardés ir slapyvardzio, pvz.: Stuoka-Gucevicius,
Mykolaitis-Putinas; nurodant pasto koda, pvz.: LT-49296; po skaiCiaus, pvz.: 1-0ji, 50-yjy
mirties metiniy proga. Pries bruksneli ir po jo neturi biti tarpy.

Tekste vietoj praleisto tarinio, siekiant intonaciSkai i$skirti ir kai kuriais kitais atvejais,
raSomas briuksnys, prie§ ir po jo turi biiti tarpai, pvz.: MaZosios valstybés siela — laisve.
BrukSnys dar raSomas tarp ZodZiy ar skaitmeny, Zyminciy daikty bei reiSkiniy vietos, laiko,
kiekio, eilés ribas, pvz.: jmonéje dirbo 2000-2005 m.; traukinys vyksta marsrutu Vilnius—
Kaunas; knygynuose pasirodé naujas italy—lietuviy kalby Zodynas; dienq bus 16-20 laipsniy
Silumos; apie tai rasoma 15-28 psl. Siuo atveju tarpy prie§ briik$nj ir po jo neturi bati. Bet:
birZelio 18 d. —liepos 1 d.; X a. pab. — XI a. pr.

Jei numeruojama punktais ir punkto pabaigoje raSomas taskas, kitas sakinys turéty buti
raSomas didZiaja raide; jei punkto pabaigoje raSomas kablelis ar kabliataskis, kita sakini
reikéty pradeéti raSyti mazaja raide. Iprasta, kad jei po numeracijos skaitmens dedamas taskas
(pvz.: 1., 5.2.) iSvardijjami dalykai pradedami raSyti didZigja raide, o po tokio teiginio
dedamas taSkas. Jei po numeracijos skaitmens ar raidés raSomas skliaustelis (pvz.: 1); a)),
teiginj {prasta pradéti raSyti maZaja raide ir pabaigoje déti kablelj arba kabliataski (daugiau
apie kompiuteriu renkamo teksto reikalavimus Zr. Kazlauskiené et al. 2011).

** Vardo pirmoji raidé ir pavardé turéty biiti toje pacioje eilutéje. Norint, kad santrumpa ir pavardé likty toje
pacioje eilutéje, galima naudoti klavisy kombinacija ctrl + shift + space.
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3. BAIGIAMUJU DARBU GYNIMAS
Referatai ir kursiniai darbai gali buiti ginami, jei taip nusprendZia tam tikra dalyka
destantis déstytojas arba jei sprendimas priimtas Lietuviy kalbos katedroje. Bakalauro ir
magistro darbai (toliau jie vadinami baigiamaisiais darbais) privalo buti ginami. Toliau
pateikta bendra informacija, apimanti pasirengima baigiamujy darby gynimui, pati gynima ir
vertinima.

3.1. Pasirengimas baigiamyjy darby gynimui

Pasirengimas baigiamyjy darby gynimui ir gynimas vykdomi laikantis Vytauto DidZiojo
universitete galiojancios Baigiamyjy darby rengimo ir gynimo tvarkos (2008 02 06 [SAK Nr.
74a) ir katedros nustatyty tarpiniy darbo rengimo bei atsiskaitymo terminy.

Baigiamuosius darbus gali ginti studentai, jvykde visa studiju programa. Ar studijuy
programa yra jvykdyta, sprendZia Lietuviy kalbos ir Lietuviy literattiros katedros.

Tinkamai parengto ir iriSto bakalauro baigiamojo darbo du egzempliorius kartu su
kopija elektronin¢je laikmenoje studentas jteikia katedrai ne véliau kaip prie§ 10 darbo dieny
iki baigiamyjy darby vieSojo gynimo pradzios.

Darbo vadovas turi pateikti atsiliepima ne véliau kaip prie§ 5 dienas iki numatyto
vieSojo gynimo pradZios. Vadovo dalyvavimas baigiamyjy darby vieSajame gynime yra
pageidautinas.

Katedros ved¢jas ne veliau kaip prie§ 10 darbo dieny iki baigiamyjy darby vieSo gynimo
pradzios skiria recenzenta. Bakalauro baigiamaji darba recenzentui studentas iteikia ne véliau
kaip prie$ 5 dienas iki darbo vieSo gynimo.

Baigiamyjuy darby vieSam gynimui fakulteto dekano teikimu Rektoriaus {sakymu
sudaroma kvalifikaciné komisija (toliau — komisija). Komisijos pirmininkas ir bent vienas
komisijos narys turi biiti i§ Kkitos institucijos (socialiniy partneriy atstovai arba kity
universitety, mokslo institucijy mokslininkai).

Recenzentas atsiliepima apie darba iteikia baigiamyjuy darby gynimo komisijai ne véliau
kaip iki darbo vieSo gynimo dienos ir studentui — ne véliau kaip viena dieng iki vieSojo
gynimo. Recenzento dalyvavimas baigiamyjy darby vieSajame gynime yra pageidautinas.

3.2. Baigiamyjuy darby gynimas

Baigiamojo darbo gynimas yra vieSas ir vyksta Rektoriaus jsakymu paskirtos
kvalifikacinés komisijos posédyje. Darbai vieSai ginami egzaminy sesijos metu.

VieSo gynimo metu baigiamojo darbo autorius trumpai pristato darbg, nurodydamas
tyrimo problema, tiksla, uzdavinius, apibuidina objekta, gautus rezultatus, taikyty metody
patikimuma, supaZindina su iSvadomis ir jas pagrindZia, pateikia rekomendacijy. Bakalauro
baigiamajam darbui pristatyti skiriama iki 10 min.

Po darbo pristatymo studentui klausimus gali pateikti gynimo komisijos nariai ir Kkiti
vieSajame gynime dalyvaujantys asmenys. Po Sios diskusijos studentas atsako i recenzento
pateiktus klausimus.

Studentas, negyngs arba neapgyngs baigiamojo darbo, Salinamas i§ universiteto. Antra
karta ginti neapginta baigiamaji darba, sudarius sutarti su universitetu, leidZiama egzaminy
sesijos metu ne anksCiau kaip po pusés mety, jei susidaro ginaniyjy grupé pagal studiju
reguliamino nustatyta tvarka (ne maZiau kaip 5 studentai). Antra karta neapgynus baigiamojo
darbo, sudarius atitinkama sutarti, turi biiti rengiamas naujas baigiamasis darbas.
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Baigiamasis darbas ne véliau kaip po dveju mety vieng karta gali buiti ginamas eksternu,
pasiraSant eksterno studijy sutarti, jei darbas ankstesniais studiju metais buvo parengtas,
iteiktas ir rekomenduotas ginti.

Rekomenduojama bakalauro darbus pristatyti naudojant pateiktis (.ppt failus). Pirmoje
pateiktyje reikia nurodyti bakalauro darbo pavadinima, ji parengusio studento varda ir
pavarde, taip pat galima nurodyti darbo vadovo varda, pavarde.” Toliau reikéty pateikti
pagrindinius dalykus i$ ivado: darbo objekta, tiksla, uzdavinius, Saltini, problema, hipotezg ir
pan. Pateiktyse reikia suraSyti pagrindinius atlikto tyrimo rezultatus. Kaip minéta, iSvadose
galima nurodyti, kg dar reikéty tirti toliau, ar darbas gali buti tgsiamas. Ta galima pasakyti ir
per pristatyma.

Pateiktyse informacija gali buti tekstiné, bet daznai informatyvesni buna lentelése ir
paveiksluose pateikti duomenys. Svarbu, kad biity jmanoma jZitréti lentelése ir paveiksluose
pateiktus duomenis, taigi reikia pasirinkti tinkama raidZiy dydi (rekomenduojama ne
mazesnés nei 20 pt. dydZio raidés). Taip pat svarbu pasirinkti tokj pateik¢iy Sablona, kuriame
gerai matytysi informacija, t. y. vengti pateikCiy, kuriy tamsiame fone pateikiamos tamsios
raidés ir pan. Be to, reikia vengti pateik¢iy Sablony su paveiksliukais, rySkiais ornamentais,
nes jie netinka moksliniams darbams pristatyti, taip pat daZnai sunku biina jZilréti
informacija. PateikCiy pabaigoje nereikia raSyti aciii uZ déemesi, negalima iterpti Sypsenéliy ar
kity simboliy.

RuoSiantis 7-10 minuciy bakalauro darbo pristatymui ZodZiu, rekomenduojama turéti
15-20 pateik¢iy. Tai tik rekomendacija, nes pateik¢iy skaiius priklauso nuo jose pateikiamos
informacijos kiekio, kalbéjimo tempo ir pan. Geriau turéti daugiau pateik¢iy, bet jose pateikti
po nedaug informacijos, kad biity lengviau klausytis pristatymo ir ji suvokti.

Pristatant baigiamuosius darbus reikéty ne skaityti tai, kas parasSyta pateiktyse, o stengtis
papasakoti, kitais ZodZiais perteikti pateiktyse esancia informacija. Pristatant ZodZiu
baigiamaji darba (taip pat kalbant konferencijose, seminaruose) parasyta teksta reikéty
pritaikyti kalbéjimui: sutrumpinti sakinius, kad juos biity galima lengviau suvokti; skaicius
sakyti apytiksliai, pvz., skai€iy 2 879 pristatant darba ZodZiu sakyti beveik trys tikstanciai, o
ne du titkstanciai astuoni Simtai septyniasdesimt devyni.

Svarbiausius dalykus pateiktyse galima parySkinti. Teksta rekomenduojama skaidyti i
pastraipas, naudoti numeracijos Zenklus. Prie§ pristatyma biutina pasitikslinti pagrindiniy
terminy, tarptautiniy ZodzZiy kir¢iavima®*, kad nebiity daroma kalbos klaidy.

3.3. Baigiamyjy darby vertinimas

Baigiamieji darbai vertinami pasibaigus gynimui uzdarame gynimo komisijos posédyje,
kuris yra protokoluojamas. Kiekvienas gynimo komisijos narys baigiamaji darba vertina
atskirai. Galutinis baigiamojo darbo ivertinimas yra lygus visy komisijos nariy vertinimy
aritmetiniam vidurkiui, suapvalintam iki sveiko skaiiaus. ISkilus gin€ams d¢l vertinimo,
galutini sprendima priima kvalifikacinés komisijos pirmininkas. Komisija taip pat atsiZvelgia
1 recenzento pareik§ta nuomong apie baigiamaji darba ir i vadovo atsiliepima. Darbo
recenzentas ir vadovas pateikia savo nuomong apie darba, bet nevertina jo pazymiu. Tuo
atveju, kai darbo vadovas yra ijtrauktas { kvalifikacinés komisijos sudéti, jo vertinimas
skaiCiuojant vertinimy aritmetini vidurki neitraukiamas.

> Jei pateiktyse nurodomas darbo vadovo vardas ir pavardé, reikia nepamiriti paraSyti ir jo mokslinius bei
pedagoginius vardus, pvz., doc. dr.; prof. habil. dr.

** Daznai netaisyklingai sukiréiuojami Sie ZodZiai ar jy formos: objektas, hipotézé, réiksmes, aprasomasis
metodas, médZiaga, kldusimai, tyrimas, tyrimius.
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Baigiamieji darbai vertinami atsizvelgiant i Siuos kriterijus:

1. Darbas, kuris jvertinamas puikiai (10), atitinka tokius reikalavimus:

darbas paraSytas aktualia arba nauja tema, tinkamai suformuluotas tyrimo tikslas, uZdaviniai,
hipotezés;

autorius yra susipazings su kity mokslininky darbais, naudojasi naujausiais tos srities darbais;

darbe taikomos, o ne atpasakojamos Zinios; naudojama tik reikalinga ir patikima informacija; visa
medZiaga panaudota tikslingai;

pasirinkta tinkama teorija ir metodika;

duomenys yra patikimi, reik§mingi kitiems tyrimams, tinkamai pateikti;

gauti rezultatai ne tik pateikti, bet ir paaiskinti;

iSvados atitinka darbo tikslg ir uzdavinius;

néra dalykiniy klaidy;

darbas paraSytas taisyklinga, aiSkia kalba, be kalbos ir korektiiros klaidy, mintys iSdéstytos logiskai ir
nuosekliai; vartojama metakalba; lengvai skaitomas darbas;

tinkamai vartojami terminai;

darbas yra vientisas, skyriy antrastés atitinka turinj; darbas yra strukttriskai subalansuotas;

cituojama tiksliai ir nuosekliai, bibliografinis aprasas sudarytas laikantis reikalavimuy;

darbo apimtis atitinka nustatytus reikalavimus;>

taikomasi prie adresato;

idomus, sklandus, aiSkiai bakalauro darbo esmg atskleidZiantis pristatymas su tinkamai pateikta
vaizdine medZiaga;

pristatymo turinys ir ekstralingvistiniai elementai atitinka reikalavimus;

darbo autorius tinkamai sureaguoja ir aiskiai atsako i gynimo metu pateiktus klausimus; geba dalyvauti
mokslinéje diskusijoje.

2. Darbas, kuris jvertinamas labai gerai (9), atitinka tokius reikalavimus:

darbas paraSytas aktualia arba nauja tema, tinkamai suformuluotas tyrimo tikslas, uzdaviniai, hipotezés;
autorius yra susipazings su kity mokslininky darbais, naudojasi naujausiais tos srities darbais;

darbe taikomos, o ne atpasakojamos Zinios;

pasirinkta tinkama teorija ir metodika;

duomenys yra patikimi, tinkamai pateikti;

gauti rezultatai ne tik pateikti, bet ir paaiskinti;

iSvados atitinka darbo tikslg ir uzZdavinius;

néra dalykiniy klaidy;

darbas paraSytas taisyklinga, aiSkia kalba, be kalbos klaidy (galimos kelios korekturos klaidos), mintys
iSdéstytos logiskai ir nuosekliai;

tinkamai vartojami terminai;

darbas yra vientisas, skyriy antrastés atitinka turinj; darbas yra strukttriskai subalansuotas;

cituojama tiksliai ir nuosekliai, bibliografinis aprasas sudarytas laikantis reikalavimuy;

darbo apimtis atitinka nustatytus reikalavimus;

idomus, sklandus, aiSkiai bakalauro darbo esme¢ atskleidZiantis pristatymas su tinkamai pateikta
vaizdine medZiaga;

pristatymo turinys ir ekstralingvistiniai elementai atitinka reikalavimus.

3. Darbas, kuris jvertinamas gerai (8), atitinka tokius reikalavimus:

darbas paraSytas aktualia arba nauja tema, tinkamai suformuluotas tyrimo tikslas, uzdaviniai, hipotezés;
autorius yra susipazings su kity mokslininky darbais, naudojasi naujausiais tos srities darbais;

darbe taikomos, o ne atpasakojamos Zinios;

duomenys yra patikimi, tinkamai pateikti;

gauti rezultatai ne tik pateikti, bet ir paaiskinti;

iSvados atitinka darbo tikslg ir uzdavinius;

néra dalykiniy klaidy;

1 § kriteriju reikia atsizvelgti labai individualiai: jeigu para$yta daugiau negu numatyta reikalavimuose dél to,
kad pasirinkta plati darbo tema, ji iSsamiai iStirta, tokiu atveju paZymys néra maZinamas, bet jei darbo apimtis
virSyta tik dél to, kad jame daug netinkamos medZiagos, tai tokiu atveju reikéty mazinti pazymj.
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darbas paraSytas taisyklinga, aiSkia kalba, be kalbos klaidy (galimos kelios korektuiros klaidos), mintys
iSdéstytos logiskai ir nuosekliai;

tinkamai vartojami terminai;

darbas yra vientisas, skyriy antrastés atitinka turinj; darbas yra strukttriskai subalansuotas;

ne visur cituojama tiksliai ir nuosekliai, bibliografinis aprasas sudarytas nesilaikant visy reikalavimuy;
darbo apimtis atitinka nustatytus reikalavimus;

bakalauro darbo pristatymas atskleidZia tyrimo esmg, pateikiama tinkama vaizdiné medZiaga;
pristatymo turinys ir ekstralingvistiniai elementai atitinka reikalavimus.

4. Darbas, kuris jvertinamas pakankamai (7), atitinka tokius reikalavimus:
darbe tinkamai suformuluotas tyrimo tikslas, uzdaviniai, hipotezés;
autorius yra susipazings su kity mokslininky darbais;
duomenys yra patikimi;
gauti rezultatai ne tik pateikti, bet ir paaiskinti;
iSvados atitinka darbo tikslg ir uzdavinius;
gali bti pasirinktas netinkamas metodas ar tyrimo aspektas;
néra daug dalykiniy klaidy;
darbe rasta keletas kalbos ir korektiiros klaidy, galimi tam tikri nelogiski teiginiai;
darbas néra struktiiriSkai subalansuotas;
cituojama nenuosekliai, bibliografinis aprasas sudarytas nesilaikant visy reikalavimuy;
darbo apimtis neatitinka nustatyty reikalavimuy;
bakalauro darbo pristatymas nei$samus, nerislus;
tinkamai neatsakoma i gynimo metu pateiktus klausimus; nesugebama moksliskai diskutuoti.

5. Darbas, kuris jvertinamas patenkinamai (6), atitinka tokius reikalavimus:
darbe netinkamai suformuluotas tyrimo tikslas, uzdaviniai, hipotezés;
pasigendama kity mokslininky darby apzvalgos;
darbe atpasakojamos, o ne taikomos Zinios;
ne visi duomenys yra patikimi;
gauti rezultatai tik pateikti, bet i§samiau nepaaiskinti;
iSvados nevisiskai atitinka darbo tiksla ir uzdavinius;
yra dalykiniy klaidy;
darbe rasta daug (daugiau negu 10) kalbos ir korektiiros klaidy, galimi tam tikri nelogiski teiginiai;
darbas néra struktiiriSkai subalansuotas;
cituojama nenuosekliai, bibliografinis aprasas sudarytas nesilaikant visy reikalavimuy;
darbo apimtis neatitinka nustatyty reikalavimuy;
bakalauro darbo pristatymas nei$samus, nerislus; nesugebama paaiskinti pagrindiniy atlikto tyrimo
dalykuy;
darbo autorius nesugeba atsakyti i gynimo metu pateiktus klausimus.

6. Darbas, kuris jvertinamas silpnai (5), atitinka tokius reikalavimus:
darbe netinkamai suformuluotas tyrimo tikslas, uzdaviniai, hipotezés;
pasigendama kity mokslininky darby apzvalgos;
darbe atpasakojamos, o ne taikomos Zinios;
pateikti duomenys yra nepatikimi;
gauti rezultatai tik pateikti, bet i§samiau nepaaiskinti;
iSvados neatitinka darbo tikslo ir uzdaviniy;
yra dalykiniy klaidy;
darbe rasta daug (daugiau negu 20) kalbos ir korektiiros klaidy, galimi tam tikri nelogiski teiginiai;
darbas néra struktiiriSkai subalansuotas;
cituojama nenuosekliai, bibliografinis aprasas sudarytas nesilaikant visy reikalavimuy;
darbo apimtis neatitinka nustatyty reikalavimuy;
bakalauro darbo pristatymas nei$samus, nerislus; nesugebama paaiskinti pagrindiniy atlikto tyrimo
dalykuy;
darbo autorius nesugeba atsakyti i gynimo metu pateiktus klausimus;
pristatymo turinys ir ekstralingvistiniai elementai neatitinka reikalavimy.
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4. RASYMO PROCESAS
Iki Siol raSyta, kokie reikalavimai keliami moksliniams darbams. Taciau daZnai
studentams, net ir isigilinusiems i pateiktus reikalavimus, iSkyla tokiy klausimy: ka apskritai
raSyti? kiek laiko raSyti? kada raSyti? ir pan. Toliau remiantis Rienecker et al. 2003 knyga
,Kaip raSyti mokslini darba®, pateikta keletas patarimy, kurie galbiit padés tinkamai
organizuoti raSymo procesa, suvokti sunkumus, su kuriais susiduriama rasant.

Norédami parasyti geresni darba, tarkités su savo vadovu. Labai dazna darbus rasanciy
studenty klaida — veltui, netikslingai eikvojama energija. Jei abejojate, kokie darbo kokybeés
kriterijai laikomi svarbiausi, butinai klauskite. Jei jau esate turéj¢ problemy dél mokslo darbo,
patartina:

e paprasyti i§ vadovo kuo iSsamesnio buvusio darbo vertinimo;

e pastudijuoti mokymo planus ar katedros metodinius nurodymus;

e perskaityti keleta gerai jvertinty koleguy darby, taip pat perskaityti darbe
esancius destytoju komentarus;

e pastudijuoti medziaga apie mokslinius darbus.

Kad raSyti buty malonu ir lengva, reikéty pasinaudoti Siomis rekomendacijomis:

e raSyti tema, leidZiancia atsiskleisti savarankiSkumui;

e raSyti lanksCiai — naudotis jvairiomis raSymo strategijomis, lygiagreciai raSyti
ivairias darbo dalis;

e pradéti raSyti kuo ankscCiau;

e raSyti kaskart, kai tik randama laiko, nuolat parasyti bent po truputj;

e nusiteikti nuolat perrasinéti darba;

e pirmiausia pradéti nuo turinio, véliau pereiti prie struktiros, formos ir tik
galiausiai dailinti kalba;

e taisyti darba einant nuo antraStiniy, svarbiyjy, prie paantraStiniy dalyky
(vadinamasis ,,i§ virSaus Zemyn* principas);

e taisyti darba, galvojant apie jo esmg (problemos formuluotg), tiksla ir adresata.

Moksliniai darbai raSomi tam tikra tema, o pasirinkti (ir pasitlyti) gera tema —
nelengvas darbas. ISsirinkti tema, kuri galéty patraukti, galima taip: per trumpa laika
perzvelgti daug ivairiy temy. Galima perZitréti katedroje ar bibliotekoje esancius anksciau
paraSytus darbus. Jei randama tema, kuri labai patinka, reikia uZsiraSyti. Galima raSyti darba
panasia tema, galbiit testi kazkieno anksciau pradétus darbus. Reikia stengtis rasti toki temos
aspekta, kuris atrodyty ypa¢ idomus, blity prieStaringas, netyrinétas ir pan. Sunku, bet ir
idomu raSyti darbus mazai ar visai netyrinétomis temomis.

Tema turéty biti aktuali, t. y. svarbi mokslo krypties teorijai ir praktikai. Ji turéty buti
susijusi ir su teorija, ir su praktika. Pravartu pagalvoti, ar bus galima rasti literatiiros temai
iSplétoti ir moksliniam darbui ta tema parengti. Svarbu, kad tema nebiity nei per siaura, nei
per plati. Dazniausias moksliniy darby trikumas — per plati tema, kuria tinkamai i$nagrinéti
neretai pritriiksta laiko ir patirties. Tokiu atveju studentas pateikia daug pavirSutiniSkos,
tinkamai neapraSytos medziagos, daZnai pats nesusigaudo, ka tiria. Tinkamai suformuluoti
temaq ir atlikti reikiama tyrima padeda kursinio ar bakalauro darbo vadovas.

Gera tema laikoma ta, kai matyti rySki problema, randama pakankamai teorin€s ir
empirinés medZiagos, tema bus galima tgsti, o darbo vadovas sugebes padéti.

Pasirinkus tema, reikia pradéti rasyti. Net pirma diena po temos pasirinkimo jau galima

pradéti raSyti. RaSyti galima apie tai:
e kuo sudomino pasirinkta tema;
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kas jdomiausia darbe;

pagrindinius argumentus;

savo pavyzdZius;

Zinomus faktus;

savo iSanksting nuomong apie kalbamaja sriti;

savo pasiilymus dél metodo, apsiribojimo, perspektyvy;

nedetalizuotas iSvadas.
RaSyti galima dar nepradéjus skaityti ir beskaitant. Tai, kas bus paraSyta tik pradéjus
dirbti, turbit neisliks galutiniame darbo variante, taciau padés ieSkant atsakymo literatiiroje ir
kaupiant empiring medziaga.

Neretai pats natiiraliausias biidas pradeéti raSyti — vadinamasis ,,idéjuy srautas arba minciy
lietus* (angl. brainstorm). Tai reiskia, kad ant popieriaus ar kompiuteryje uzZraSomos visos i
galva Saunancios mintys, negalvojant apie forma ir strukturg (apie kitus raSymo budus Zr.
toliau).

Nereikeéty skubéti raSyti teoriniy daliy. Tai sunkiausias ir daugiausia pasirengimo
reikalaujantis tekstas ir paprastai jis tampa didZiausia klititimi raSyti. Be to, neretai pradéjus
nuo teorinés dalies, priraSoma per daug — daugiau negu reikia darbo analizei.

Nuo raSymo turéty priklausyti literatiiros paieSka. Skaityti reikia Ziiirint, ar skaitoma
medZiaga padés atsakyti { problemos formuluotg. Bet koks raSymas (kad ir mazai su darbu
susijusiy dalyky) ir skaitymas skatina mastyti, padeda atsirasti reikiamoms mintims. Mastant
nebitinai imamasi raSyti. Idéjy, naujy sumanymuy kyla, kai leidZiama sau mastyti laisvai,
atsisakoma suvarZymuy.

RaSyti reikéty lanksciai, todél rekomenduojame pasiremti deSinéje 4 lentelés puséje
pateiktais patarimais.

4 lentelé. RaSymo strategijos (pagal Rienecker et al. 2003: 67)

Rasyti nepatartina Rasyti patartina

IStisai, be pertrauky Kas kiek laiko, bet nuolat

Remiantis grieZtu planu (struktiira) Be plano, strukttrinti véliau

Nuo pradziy Nuo galo arba vieng, arba kita dali

IS karto sklandZia, taisyklinga kalba Nekreipiant démesio i forma, tik i turini
Tik ,,viska* perskaicius Pries skaitant, beskaitant

Pirmiausia aprasant darbo prielaidas Pradedant nuo iSvady

Referuojant Taikant Zinias

Ataskaitos stiliumi Argumentuojant

Kiekvienas turime savita raSymo biida. Rienecker et al. (2003: 70-72) knygoje pateikti
keturi pagrindiniai moksliniy darby raSymo biidai (arba raSymo technikos):

1) Idéjy srautas (angl. brainstorm) — toks raSymo budas, kai nedarant atrankos
uzrasomos visos pasirinkta tema tuo metu i galva ateinan¢ios mintys, sumanymai, asociacijos.

2) Grafinis tinklas (temos Zemeélapis) (angl. mindmapping) — tai tam tikra tema suraSytos
mintys, idéjos, sumanymai, asociacijos. Temos pavadinimas paraSomas popieriaus lapo
viduryje, o aplink ji spinduliais ar apskritimuose uZraSoma viskas, kas susij¢ su ta tema.
Palyginti su minCiy srautu, grafiniame pieSinyje sistemingiau matyti uzZraSomy dalyky
santykiai.

3) RaSymas non stop — tai greitasis (laisvasis) raSymas, kai raSoma neplanuotai,
neredaguojama, kas paraSyta, nesustojama pagalvoti ir pasiplanuoti, negriZtama prie to, kas
paraSyta, netaisoma. Tokio raSymo tikslas — atsisakyti vidinés kontrolés, kritinio jausmo, noro
planuoti.

4) RaSymas padrikai — tai nedideliy, skirtingy darbo viety teksto daliy raSymas be
struktiros, t. y. raSoma tai, kam tuo metu turima medZiagos, nesiekiant biitinai pabaigti.
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Geriausia buty atskirti teksto kurima ir taisymg. Pvz., keleta savaiciy tik raSyti, o paskui
(kiek trumpiau) vien tik taisyti. Arba kasdien iki piety (kai turima daugiau jégu) rasyti ka nors
nauja, o po piety taisyti tai, kas paraSyta.

Nelengva jvertinti savo darba, tod¢l patartina padaryti pertrauka ir savo teksta skaityti
svetimomis akimis po keliy dieny ar keliy savaiciy. Tada bus lengviau radikaliai taisyti savo
teksta, ne tik viena Zodi pakeiciant kitu. Nereikéty apsiriboti tik Zodyno ar stiliaus taisymu.
Kartais darba reikia radikaliai pertvarkyti: priraSyti teksto, iSbraukti nereikalingas dalis,
sukeisti skyrius vietomis.

Teksta paprasCiausia tvarkyti iSspausdinus ji popieriuje, o ne kompiuterio ekrane, nes
skaitant teksta kompiuterio ekrane nematyti bendro didelés apimties teksto vaizdo.
Rekomenduojama duoti savo teksta paskaityti kam nors kitam. Tokiu atveju bus iStaisoma
daug kalbos ir korektiiros klaiduy, taip pat skaitantysis gali pastebéti ir dalykiniy klaidy.

Taisant darba reikéty pradéti nuo to, kas svarbiausia, o taisyma baigti smulkiais, bet taip
pat svarbiais darbo formos dalykais. Taigi teksta reikéty taisyti trimis pakopomis (Rienecker
et al. 2003: 77):

1. Pirmiausia didieji taisymai: turinys
e problemos formuluoté,
tikslas (adresatas),
argumentacija,
dokumentacija,
pavyzdZiy panaudojimas,
medZiagos paskirstymas pagal svarbuma.

2. Mazesni taisymai: struktiira (forma)
e pateikiamos informacijos eiliSkumas,
e peréjimas nuo vieno skyriaus prie kito,
e pradZios ir pabaigos,
e pasikartojimai.

3. Smulkieji taisymai: formuluotés, techniniai dalykai
e kalba, stilius, tonas,

raSyba, skyryba,

citatos,

iSnasos,

literattiros nuorodos,

antraStés ir paantraStés,

maketas, Sriftai.

Moksliniy darby raSymas — nelengvas procesas, bet kartais atrodo, kad visiSkai neiSeina
nieko paraSyti. Atrodo, tarsi biity iStikusi negalia. RaSymo negalia — realus dalykas,
iStinkantis turbiit kiekviena raSanti mokslinius darbus. Tik vieni lengviau ja iveikia, kiti
sunkiau. Rasymo negalia galima bandyti iveikti keliais biidais:
imkités atsikratyti raS§ymo problemy ir negalios kuo anksciau;
ieSkokite sustojusio darbo priezasciy;
raSykite apie tai, kas jums atrodo svarbu;
jei tema jums nejdomi, o rasyti galite tik i§ susidoméjimo, pasikeiskite tema;
pasvarstykite, ar nevertéty sumazinti raSymo apimties — apsiribojus ar sukonkretinus
medZiaga;
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pradékite raSyti, neatidéliokite raSymo, kol viskas bus perskaityta — raSyti butina, kad
veliau raSytuméte gerai;

susitaikykite su tuo, kad darba reikés perraSinéti keleta karty — tada sumazés jtampa
rasant juodrascius;

kuriam laikui atidekite sunkiai raSoma skyriy ir imkités lengvesnés vietos;

nuolat grizkite prie problemos formuluotés, naudokités ja kaip viso darbo raSymo
gaire;

pasizymekite, ko nesiseka paraSyti ir pasikonsultuokite su vadovu;

ilgai nelaukg susiraskite ka nors, su kuo galétumeéte pasikalbéti apie darba — geriausia
visy pirma eiti pas vadova;

iSsiaiSkinkite, koks i tikryju turi biti darbo lygis ir kokie jam keliami reikalavimai;
paskaitykite kity darby, duokite vadovui ivertinti darbo iStraukuy;

geriau rasykite po truputi kasdien: geriau dirbti trumpai, bet nuolat, nei ilgai, bet tik
retkarciais;

pripazinkite, kad iStiko raSymo negalia;

prieS pradédami raSyti pasiripinkite, kad darbo neapsunkinty galimos problemos
(daugiau 7zr. Rienecker et al. 2003: 83-92).

RaSymo negalia neatsiranda staiga. Ja signalizuoja tam tikri ,avariniai Zenklai*

(Rienecker et al. 2003: 84):

noras perskaityti ,,viska* prie§ pradedant raSyti;

noras aprépti per daug vienu metu: per plati problemos formuluoté, pernelyg didelis
abstraktumas, per daug teoretizavimo;

noras remtis tekstais, kuriy nesupranti;

noras per anksti raSyti galutinj varianta;

noras vienu metu raSyti skirtingoms adresaty grupéms;

noras i kiekvieng sakini prikimsti per daug informacijos;

noras biiti jvertinant 9 arba 10, neZinant vadovo kokybes kriterijy;

noras iSsiversti be niekieno pagalbos;

noras dirbti daug, sunkiai ir ilgai;

noras beraSant suspéti atlikti ir daugybe pasaliniy darby;

ankstesné raSymo patirtis — pernelyg sékminga arba pernelyg nesékminga.

Taigi labai svarbu atpaZinti raSymo negalia, suvokti jos atsiradimo prieZastis, rasti

sprendima, kaip iveikti Sia negalia ir, svarbiausia, tai padaryti laiku. Net jei jusy patiriami
mokslinio darbo sunkumai neprimena raSymo negalios, jei sulaukiate naudingy darbo vadovo
patarimy, vis tiek apie mokslini darba pravartu pasikalbéti su kolegomis, kurie neretai gali
pasitlyti naudingy patarimy.

Ar mokslini darba seksis rasyti lengvai ar sunkiau, ar raSymo procesas bus nuobodus ir

pernelyg varginantis, — tam Siokios tokios jtakos turi ir darbo vadovas. Kad bendravimas su
mokslinio darbo vadovu biity produktyvus, pasinaudokite Siais patarimais (pagal Rienecker

et al.
[ ]

2003: 93-100):
pasirinkite gera vadova, nebiitinai temos Zinova — tiriamoji sritis ir vadovavimas
darbui ne visada turi sietis;
visaip iSnaudokite galimybe konsultuotis, bet kartu stenkités dirbti savarankiskai;
susitikite su vadovu kuo ankscCiau, geriausia tada, kai pasirinkote tema ir turite rastu
pasiZymej¢ pirmasias mintis apie ja;
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kiek imanoma, ruoskités konsultacijoms rastu, rasykite vadovui: siyskite teksta ir
komentarus el. pastu, uzsiraSinekite, apie ka kalb¢jote per konsultacija;

aiSkiai apsibrézkite, kuriais i§ vadovo pasitilymy naudosités; bty gerai, kad apie
vienoki ar kitoki apsisprendima informuotuméte vadova;

klauskite vadovo, jei iSkilo kokia abejong;

iSsakykite vadovui, ko norétuméte i§ konsultacijy, nesvarbu, kad visko nebtity galima
1Spildyti;

atlikite savo darba — uZ tai, kad vadovavimas biity geras, atsako ne tik vadovas.

Geras vadovas — tai pirmiausia Zmogus, kuris nors kiek savo laiko gali skirti

konsultacijoms. Antra, jis turi Zinoti, koks turi buti geras darbas. Taigi vadovavimas geras,

kai:

darbas domina ir studenta, ir vadova;

1 studento darbg Zitirima rimtai;

abi pusés Zino, koks bus ju vaidmuo Siame bendradarbiavime;

vadovas ir studentas lanks¢iai Zitiri i akademinio darbo procesa;

vadovavimas — tai pokalbiai ivairiomis temomis: apie darbo turini, metodus, teorijas,
galimas struktiiras, darbo procesa;

vadovas laikosi tam tikry darbo kokybés reikalavimy ir iSsako juos studentui; jis
vertina studento darbo iStraukas, pasako, kas gerai, o ka galima pagerinti;

vadovaujant siekiama patobulinti, o ne tik jvertinti pateikta darbo iStrauka;

studentui neleidZiama gaisti laiko aiSkiai nevaisingoms mokslinéms paiesSkoms;
konsultacijos duoda studentui tiek profesinés (turinio prasme) naudos, tieck moko ji
raSyti mokslini darba (Rienecker et al. 2003: 94).

Svarbu isidéméti, kad vadovas neturi taisyti techniniy dalyky: korektiiros, kalbos klaidy,

aiSkinti, kaip sudaryti literatiiros saraSa ir pan. — tam skirti §ie metodiniai nurodymai. Jei
pateiksite darba su klaidomis, gali buti, kad tos klaidos blaskys vadovo démesi ir sulauksite ne
vertingy komentary darbo tema, o tik darba su pataisyta kalba.

5. LITERATUROS PAIESKA, ATRANKA IR PATEIKIMAS

Prie§ pradedant skaityti ir ieSkoti literatiros, rekomenduojama pasinaudoti S$iais

Rienecker et al. (2003: 121) pateiktais patarimais:

geriau nuodugniai pasinaudokite nedideliu literatiiros kiekiu nei pavirSutiniSkai
daugeliu knygy ar straipsniy;

nusistatykite galuting literatiiros paieSkos data ir jos laikykités;

eikite nuo placios temos paieskos prie siauresnés, remdamiesi problemos formuluote;
nepamirSkite, kad naujausia moksliné informacija daZniausiai publikuojama
straipsniuose ar konferencijy praneSimy medZiagoje; nemaza dalis medZiagos apskritai
randama tik straipsniuose;

iSmokite kompiuterinés literattiros paieskos;

skaitykite literatiira, turédami mintyje, kam darbe ja panaudosite — nereikia skaityti
visy knygy ar straipsniy iStisai ir vienodai nuodugniai;

skaitydami konspektuokite, ka ketinate panaudoti.

Ieskant literatiros nereikia susikoncentruoti | kiekj (Zinoma, moksliniuose darbuose

reikia remtis tam tikru knygu ar straipsniy skai¢iumi, pvz., raSant bakalauro darba reikéty
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remtis bent 10 literatiiros Saltiniy), nes vertinama ne tai, kiek perskaityta, o tai, kas paraSyta.
Taigi geriau remtis maziau, bet atidZiai perskaityty teksty, negu perZvelgti pavirSutiniSkai;
geriau raSyti kokybiSkiau, remiantis tik keliais tekstais, negu raSyti prastai, paskubomis, bet
remiantis daugybe teksty. Tod¢l prieS pradedant skaityti, naudinga susidaryti 3 saraSus: 1)
literaturos, kuriqg reikia perskaityti pirmiausia; 2) literatiiros, su kuria pageidaujama
susipazinti; 3) literattiros, kurig bus galima paanalizuoti, jei liks laiko.

Knygoje ,,Kaip raSyti mokslini darba*“ (Rienecker et al. 2003: 127) teigiama, kad
raSantys mokslinius darbus studentai daZnai per anksti pradeda skaityti moksling literatiira, be
to, skaito per daug ir per nuodugniai. Skaityti dar nepradéjus raSyti darbo galima tada, kai
norima susipaZzinti su tema. Imtis nuodugnaus skaitymo darbo tema reikéty tik tada, kai darbo
strategija jau nors kiek apgalvota, o dar geriau — kai jau pasizyméta, ko tikimasi i§
skaitysimos literatiros.

Studentai, gave ar susirade literatliros sarasSa, neturéty skaityti visy knygy istisai, nuo
pirmo iki paskutinio puslapio. Kai kurias knygas reikés perskaityti visas, kity — tik atskirus
skyrius, dar kai kurias knygas ar kitus mokslo darbus uZteks permesti akimis, pasklaidyti ir
susidaryti visumos vaizda.

IS pradziy rekomenduojama skaityti apibendrinancio pobudZzio literattiros Saltinius:
monografijas®, disertacijas, knygas ir pan. Tai padés tiriama problema suprasti, i ja isigilinti.
Po to galima pereiti prie literatiiros, aptariancios atitinkamus siaurus klausimus — tai
straipsniai, tezés, anotacijos ir kt. Kita vertus, straipsniai svarbiis tuo, kad yra naujesni, nes
mokslininkai pirma raSo straipsnius, o tik po to knygas; daugelis temy néra tokios placios, kad
apie jas buty galima paraSyti visa knyga; tikétina, kad tam tikra tema galima rasti kelis Simtus
straipsniy ir né vienos knygos. Chronologiniu poZiliriu geriausia pradéti nuo naujausios
literaturos.

Ypac¢ daug medZiagos galima rasti internete, bet ja reikia vertinti kritiSkai, nes daznai
internete pateikta medZiaga yra nekokybiSka, nepatikima, neZinia kieno pateikta. Taigi
internetas negali atstoti bibliotekos.

Reikia skirti literatiira, kuria buvo remiamasi vidurin¢je mokykloje ar gimnazijoje, ir
kuria reikéty remtis studijuojant universitete. Pavyzdziui, mokiniams skirtas ,,Lietuviy kalbos
Zinynas“ neturéty biiti cituojamas raant kursinius ar bakalauro darbus. Zinyne pateikta
glausta informacija apie lietuviy kalba, jos ypatybes, o raSant mokslini darba, reikia remtis
atitinkamos srities specialisty darbais. Pavyzdziui, gilinantis | fonetika, reikéty skaityti A.
Pakerio ,,Bendrinés lietuviy kalbos fonetika*; rasantiems darba i§ akcentologijos praversty
paskaityti D. Mikulénienés, A. Pakerio, B. StundZios ,.Bendrinés lietuviy kalbos kir¢iavimo
Zinyna‘‘; morfologijos tema daug darby yra paraSiusi A. Paulauskiene, sintaksés — V. Labutis,
leksikologijos — E. Jakaitiené, taigi pirmiausia reikéty skaityti minéty mokslininky paraSytus
vadovélius ir straipsnius.”’

Literatura reikia naudotis tikslingai. Kaip daznas moksliniy darby trikumas paminima
tai, kad autorius nesugeba paaiSkinti, argumentuoti, kod¢l remtasi vienu ar kitu literatiiros
Saltiniu. Darbe reikia paaiSkinti, kodél naudojatés biitent tais autoriais. Kaskart ka nors
pacitavus reikia pakomentuoti. Pavyzdziui:
pasitelksiu x pozitrj { y, nes x poZitris mano darbo tikslui bus pravartus Sia prasme...

x darbai daro itaka jau keleto karty mokslininkams, tiriantiems...

X yra vienintelis ras¢s apie y;

X teiginys gana idomiai prieStarauja z teiginiams, nes pasak z, x yra svarbus teoretikas, nes... Ta
pati apie x yra pasakgs ir y (Rienecker et al. 2003: 143).

2 Monografija — mokslo veikalas, i$samiai nagrinéjantis viena klausima, tema, vieno autoriaus kiiryba ir pan.

" Pirmakursiy, kartais ir ketvirtakursiy darbuose galima pamatyti nuoroda i Karoliniskiy gimnazijos mokytojo
Algimanto Urbanavidiaus interneting svetaing (http://ualgiman.dtiltas.lt/). Cia pateikta daug naudingos
informacijos, bet rasantiems mokslo darbus reikia remtis pirminiais Saltiniais, kuriuose tas pats dalykas, pvz.,
frazeologizmai, aptarti daug i§samiau.
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Reikia stengtis pacituoti pirmini Saltinj, nepaisant to, kad daZnai kurios nors srities
specialisty darbai yra perpasakojami, aptariami studenty darbuose; be to, neretai antrinius
Saltinius biina lengviau rasti nei pirminius. Jei remiamasi antriniu Saltiniu, t. y. perpasakojimu,
percitavimu, tada galima ne taip suprasti kai kuriuos teiginius, galima iSkreipti mintis.
Percituoti 1§ kito Saltinio galima tik tuo atveju, kai negalima rasti knygos (ji iSleista seniai,
néra Lietuvos bibliotekose ir pan.).

Skaitant literattirg, biitina pasizyméti kai kuriuos duomenis:

e autorius, redaktorius;
pavadinima;
leidima;
vieta;
leidykla;
leidimo metus;
straipsniams: toma, numerj, straipsnio puslapius;
cituojamos vietos puslapi (kaip tekste pateikti bibliografija, Zr. 2.1 skyriy).

Literatiiros dazniausiai ieSkoma pagal du paieskos tipus:

e Grandininé paieSka, kai darbui tinkama literatiira ieSkoma einant nuo vieno teksto
prie kito, tada dar prie kito ir t. t. Kartais galima rasti sudarytas bibliografijos
rodykles, kuriose chronologiSkai arba pagal temas pateikti tam tikros mokslo Sakos
darbai. Grandining paieska geriausia biity pradéti nuo tokio leidinio.*®

e Sisteminé¢ (elektroninés literatiros) paieska, kai ieSkoma pagal teminius ZodZius
arba pavardes. IeSkoti galima internetinése paieSkos sistemose, biblioteky
kataloguose, duomeny bazése, elektroniniuose Zurnaluose, universitety svetainése ir
pan.

Suradus reikiama literatiira, reikia mokéti ja tinkamai perteikti. Skiriami keli literatiiros
perteikimo buidai. DaZniausi i$ jy yra citavimas, parafrazavimas ir referavimas.

e Cituoti reikia tada, kai svarbu perteikti teksta Zodis Zodin, kai svarbu ne tik tai, kas
pasakyta, bet ir kaip pasakyta; biitinai reikia pasiremti teksto autoritetu.

Cituoti galima ir tada, kai norima priestarauti cituojamo autoriaus pozitriui. Citatos turi
biiti negausios ir gerai parinktos. Citata tekste reikia aiSkiai iSskirti. Trumpesnés citatos
raSomos kabutése, o ilgesnés iSskiriamos atitraukiant nuo parastés, kartais raSant maZesnémis
raidémis. Cituoti privaloma visiSkai tiksliai, net jei tekste akivaizdi klaida.

Kita kalba paraSyta citata reikia iSversti { lietuviy kalba. Jei ta citata labai svarbi, jei gali
kilti dél vertimo atsirandanciy netikslumy, citata originalo kalba rekomenduojama pateikti
iSnasoje.

e Parafrazuojama, kai reikia perteikti turing; tiksli formuluoté nesvarbi; teksto stilius
neatitinka jusy darbo stiliaus; tekste akcentuojami kiti dalykai nei reikia jisy darbui;
reikia trumpinti.

e Referuoti reikia, kai norima perteikti teksto esmg; reikia praleisti nereikalingas
detales; reikia apibendrintai pristatyti teksta (placiau Zr. Rienecker et al. 2003: 146-
150).

* Keletas bibliografijos rodykliy pavyzdziu: Kazimieras Gaivenis: bibliografijos rodyklé (parengta Lietuviy
kalbos institute, 2003); Lietuviy kalbos terminy Zodyny bibliografijos rodyklé (parengta Lietuviy kalbos institute,
2007); Gaivenyte-Butler J., Keinys S., Noreikaité A. Lietuviy kalbos terminy Zodynai: anotuota 1900-2005 m.
bibliografijos rodyklé (parengta Lietuviy kalbos institute, 2008).
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Moksliniuose darbuose reikéty daugiau parafrazuoti ir referuoti, o ne cituoti.
Referavimas — laisviausias teorinés medZiagos perteikimo biidas. Tiek parafrazuojant, tiek
referuojant nieko negalima pridéti nuo saves; reikia raSyti savais ZodZiais, savu stiliumi, bet
neiskreipiant teksto turinio ir atskiriant ne sava minti nuo savy komentary.

Daznai studentai moksliniuose darbuose nenurodo, i§ kur cituoja ar perpasakoja, nors
akivaizdZiai matyti, kad mintys néra paciy studenty. Taigi kity mintis savo darbuose reikia
pateikti atidZiai, visada nurodant, i§ kur jos paimtos. PrieSingu atveju moksliniai darbai virsta
plagiatais.

Pradedantys raSyti pirmuosius mokslinius darbus studentai paprastai stengiasi labai
saziningai nurodyti 1§ kity autoriy paimta medZiaga: stropiai kabutémis ir iSnaSomis suZymi
citatas. Tokiems studentams budingi du pagrindiniai trukumai: jie pernelyg daug tiesiogiai
cituoja ir ju darby teorin¢ dalis — beveik iStisas kity autoriy darby nuraSymas. DaZnai
citavimas biina nemotyvuotas.”” Antras trikumas — neisradingas citaty siejimas su autoriaus
tekstu. Cituojami sakiniai nesusiejami, todél jaucCiamas teksto nenuoseklumas. Daznai
laikomasi schemos: citata ir ja iliustruojantys pavyzdziai (Pirockinas 1990: 122-123).

¥ Nemotyvuoto citavimo pavyzdZiai: nurodomi iprasti, visiems Zinomi, banalis dalykai, pvz., kad lietuviy
kalbos garsai skirstomi i balsius ir priebalsius; skiriama vienuolika lietuviy kalbos daliy; nurodant rasytojo
gimimo ir mirties datas ir pan. Bet jei yra diskutuotina dél kai kuriy dalyky, tada reikia pacituoti, pvz.,
nesutariama dél A. Strazdo gimimo vietos ir mety; diskutuojama, kiek lietuviy kalboje yra fonemuy; kaip skirstyti
sujungiamuosius sakinius ir pan. (Pirockinas 1990: 122-123).
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II DALIS. ELEKTRONINIU TEKSTU RUOSIMO PRIEMONES
IR JU NAUDOJIMAS (A. Utka)

Siandien studenty rasto darbai jau neatsiejami nuo kompiuteriniy programy naudojimo:
visi baigiamieji rasto darbai turi biiti parengti kompiuteriu, daznai reikia pateikti net tik
spausdinta, bet ir elektronini varianta. Sioje metodinés priemonés dalyje gausu praktiniy
patarimy, kaip taikyti svarbiausias teksto ruo$imo kompiuterines programas rengiant jvairius
raSto darbus.

Tiesa, Cia nesistengiama aprépti visy kompiuteriniy priemoniy, visu ju galimybiy,
funkcijy ir komandy, nes tam yra skirta speciali literatiira (pvz., Leonavi¢iené 2005, 2007,
2011 ir kt.). Taip pat tikimasi, kad studentai jau Zino pagrindines teksty rinkimo ir
formatavimo komandas, tod¢l Sioje metodingje priemongje tik stengiamasi pateikti specifinius
ilgo teksto perziiiros, rengimo ir formavimo buidus, tyrimo duomeny tvarkymo ir analizavimo
galimybes.

1. KOMPIUTERINIU PRIEMONIU (PROGRAMU) NAUDOJIMO
SVARBA FILOLOGAMS

2007-2012 m. lietuviy kalba ir literatiira studijuojanciy 4 kurso studenty apklausa
parod¢, kad filologijos studentai vis daZniau naudoja ivairius kompiuterinius irenginius ir
svarbiausias kompiuterines programas, be to, pastebima tendencija, kad studentai link¢ geriau
vertinti savo kompiuterini rasStinguma (Zr. 1 ir 2 paveikslus).

Kompiuteriniy jrenginiy naudojimas

5,2
| 4,5 4,8 4:9
3,9

2007 2008 2009 2010 2011 2012

O P N W R O

Kompiuteriniu ir. skaicius

1 paveikslas. Vidutinis aktyviai naudojamy kompiuteriniy jrenginiy skaicius, tenkantis 1 studentui
(irenginiai: stacionarinis kompiuteris, neSiojamasis kompiuteris, skeneris, skaitmeninis fotoaparatas,
skaitmeniné kamera, atmintukas, belaidis internetas, mp3 grotuvas, iSmanusis telefonas)
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Kaip vertinate savo kompiuterinj rastinguma?

39
38 3,77
3,7 3,63
36 3,59 3,58 355
3,5
34 3,32
3,3 -
3,2
3,1
3,0 - . . . . .

2007 2008 2009 2010 2011 2012

2 paveikslas. Studenty savo kompiuterinio rastingumo vertinimo rezultatai penkiabaléje skaléje (1 —
labai blogai, 2 — blogai, 3 — patenkinamai, 4 — gerai, 5 — labai gerai)

Tokie apklausos rezultatai rodo, kad filologijos studentams kompiuterinés priemonés
tampa vis svarbesnés, o geb¢jimas naudoti tas priemones — vis aktualesnis.

Nors svarbiausias Sios metodinés priemonés tikslas — padéti tinkamai paraSyti ir
pristatyti baigiamuosius darbus, kitas tikslas — pagerinti bendra studenty kompiuterini
raStinguma. Dabartinés teksto redagavimo, skai¢iavimo ir analizés programos yra labai
sudétingos priemonés, kuriose idiegta daug Zmogaus rankini darba palengvinanciy funkcijy.
Tiesa, daznam vartotojui nepavyksta visy ju isisavinti, todél prarandamas brangus laikas,
daroma klaidy. Todél svarbu ne tik aktyviai naudotis kompiuterinémis priemonémis, bet ir
iSnaudoti kuo daugiau jy galimybiy. Specialistas, gebantis efektyviai panaudoti kompiuterines
priemones, bus konkurencingesnis darbo rinkoje ir labiau vertinamas darbdaviy.
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2. SVARBIAUSIOS ELEKTRONINIU TEKSTU RUOSIMO
PRIEMONLS

Galima skirti SeSias svarbiausias kompiuteriniy programy rasis, kuriomis ruoSiami
elektroniniai tekstai. Tai teksto redaktoriai, skaiCiuoklées lentelés, pristatymy rengimo
programos, grafinés ir pieSimo programos, internetinés narSyklés ir elektroninio paSto
programos. Ne visos §ios priemonés vienodai naudojamos elektroniniams tekstas ruosti, todél
jas dar galima skirstyti i tiesiogines (naudojamas elektroniniams tekstas ruosti tiesiogiai) ir
pagalbines (naudojamas elektroniniams tekstas ruosti netiesiogiai).

Tiesioginés programos

. Teksto redaktoriai — tekstui paruosti,

. skaiciuoklés lentelés — duomenims apdoroti, lenteléms, grafikams sudaryti,
skaiciuoti,

o pristatymy rengimo programos — pristatymams ruosti,

o grafinés ir pieSimo programos — iliustracijoms ruosti.

Pagalbinés programos

o Interneto narsyklés padeda ieskoti informacijos,
o elektroninio pasto programos naudingos komunikacijai, jas naudodami gauname
arba siunc¢iame informacija.

Reikia paminéti, kad nors pasaulyje egzistuoja keletas kity placiai paplitusiy operaciniy
sistemu (Unix, Linux, Macintosh), kuriose pateikiama didelé¢ ivairové elektroniniy teksty
ruoSimo priemoniy, Sioje metoding€je priemonéje apzvelgsime tik MS Windows operacingje
sistemoje naudojamas elektroniniy teksty ruoSimo priemones, nes kity operaciniy sistemy
priemonés yra reciau naudojamos Lietuvoje.

2.1. Teksto redaktoriai

Teksto redaktoriais Zmogus tiesiogiai kuria arba renka teksta elektronine forma, taip pat
ji redaguoja, kei¢ia, saugoja ir galiausiai paruogia skaityti, publikuoti ar spausdinti. Siame
skyrelyje iSvardysime ir trumpai apibiidinsime svarbiausius MS Windows operacinés sistemos
teksto redaktorius.

Du paprasciausi teksto redaktoriai Notepad ir Wordpad yra MS Windows operacinés
sistemos dalis.

e Notepad atidaro ir leidZia redaguoti tik tekstinius dokumentus (pvz., su plétiniu
»(Xt). Jame néra galimybeés keisti Srifty, pajuodinti teksto ar naudoti kokias nors
automatines funkcijas. Sis teksto redaktorius patogus trumpiems ir paprastos
strukttros tekstiniams dokumentams ruosti.

o Wordpad atidaro ir leidZia redaguoti dokumentus su plétiniais ,,.rtf*, ,,.doc*, ,,.txt*.
Sis redaktorius turi daugiau redagavimo funkcijy nei Notepad. Su juo galima naudoti
paprasCiausias teksto formatavimo funkcijas: raSyma kursyvu, pajuodinima, Srifto
keitima, pabraukima ir kt.
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Siy teksto redaktoriy nepakanka sudétingesnés struktiros dokumentams paruosti. Tam
vartotojas turi isidiegti sudétingesnius teksto redaktorius, kurie paprastai yra licencijuoti, t. y.
vartotojams juos reikia pirkti.

o MS Word - licencijuotas teksto redaktorius. Pla¢iau naudojamos 2003, 2007, 2010
mety versijos. Programos paruosty faily plétiniai yra ,,.doc* ir ,,.docx* (MS Word
2007, 2010). Programa atidaro ir i§saugo daugeliu kity formaty.

e  PageMaker — licencijuotas teksto redaktorius, skirtas leidykloms. Atidaro ir
leidzia kurti failus su ,,pm#“ plétiniu. Sios programos teksto ruosimo galimybés
atitinka profesionalios leidybos reikalavimus.

o OpenOffice Writer — atvirojo kodo™ teksto redaktorius. Programa nemokamai
platinama internete. Su $ia programa sukurti dokumentai turi plétini ,,.odt", taciau
programa gali atidaryti ir kurti jvairius kitus tekstinius formatus, taip pat ir failus
su ,,.doc* ir ,,.docx* plétiniais. Si programa gali biiti naudojama kaip licencijuoty
programy pakaitalas, nes leidZia atlikti dauguma sudétingy funkcijy, kurios
buidingos tik brangiems licencijuotiems teksto redaktoriams.

o Kiti. Egzistuoja ir daugybé kity licencijuoty ir nemokamy teksto redaktoriy, kurie
skirti tam tikroms specifinéms vartotoju reikmeéms (pvz., UltraEdit dirbti su
didelés apimties tekstais).

Sioje metodinéje priemonéje (3 skyriuje) pladiau susipaZinsime su MS Word teksto
redaktoriaus galimybémis, nes bitent Si kompiuteriné programa daZniausiai naudojama
filology baigiamiesiems darbams paruosti.

2.2. SkaiCiuoklés lentelés

Darbui su tekstiniais ar skaitiniais struktiirizuotais duomenimis yra skirtos skai¢iuokliy
lenteliy programos. Paprastai Siy programy elektroniniai rezultatai lenteliy, skai¢iy ar grafiky
pavidalu yra naudojami iprastiniuose elektroniniuose tekstuose.

Svarbiausios skaic¢iuokliy lenteliy programos:

° MS Excel — licencijuota programa, atidaro ir kuria failus su ,,.xIs* ir ,,.xlsx* (MS

Excel 2007, 2010) plétiniais, taip pat struktiirizuotus failus su ,,.txt* plétiniais ir kt.

o OpenOffice Math — atvirojo kodo programa, analogiska MS Excel.

e  SPSS - licencijuota statisting priemoné, skirta socialiniy moksly tyrimams. Si
programa leidZia vartotojui patogiai pritaikyti statistinius duomeny tyrimo
metodus (pvz., faktoring analizg).

Sioje metodinéje priemonéje 5 skyriuje pladiau bus supaZindinama su MS Excel

programos galimybémis.

2.3. Pristatymy rengimo programos

Darby, rezultaty vaizdinés informacijos pristatymams skirtos pristatymy rengimo
programos. Sios programos yra pritaikytos pateiktims kurti ir jas rodyti kompiuterio ekrane
arba projektoriumi ant ekrano.

e MS PowerPoint licencijuota programa, atidaro ir kuria failus su plétiniais ,,.ppt* ir

»PPtXx“ (MS PowerPoint 2007, 2010).
e OpenOffice Impress — atvirojo kodo programa, analogiska MS PowerPoint.
e Kitos (pvz., Harvard Graphics).

% Atvirojo kodo programos yra nemokamai platinamos programos, be to, jas tobulinti turi teis¢ bet kuris tai
sugebantis daryti programuotojas ar kompanija.
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Sioje metodinéje priemonéje pladiau susipaZinsime su svarbiausiomis MS PowerPoint
programos galimybémis, nes bitent $i programa reikalinga baigiamiesiems darbams pristatyti.

2.4. Grafinés ir pieSimo programos

Grafinés ir pieSimo programos skirtos grafiniams vaizdams, nuotraukoms ar
iliustracijoms kurti arba modifikuoti.

e MS Paint — licencijuota programa kartu su Windows, leidZia kurti ir iSsaugoti
(,,.bmp*, ,,.jpg*, ,..gif*, ,,.tif* ir kitus formatus).

e MS Picture Manager — licencijuota programa kartu su Windows.

e Kitos. Egzistuoja nemazai grafiniy ir pieSimo programy, skirty jvairiems vaizdy
kiirimo poreikiams.

Sioje metodinéje priemonéje pladiau iy priemoniy neaprasysime.

2.5. Internetinés narSykleés

Internetinés narSyklés yra programiné jranga, kuri leidZia vartotojui ieSkoti informacijos
(narSyti) ar kurti informacija internete. Internetinémis narSyklémis vartotojas gali ruoSti
tekstus, kurie yra prieinami visiems interneto vartotojams.

Labiausiai paplitusios narSyklés Lietuvoje yra:

o MS Internet Explorer — nar$yklé, licencijuota kartu su Windows operacine sistema.

Sios narsyklés populiarumas salygotas Windows operacinés sistemos populiarumo.

e Mozilla Firefox — nemokamai platinama narSykle, kuri specialisty jvardijama kaip
saugesne ir greitesn¢ alternatyva MS Explorer narSyklei. Tokie specialisty vertinimai
sunkiai patikrinami, nes visos narS§yklés yra labai intensyviai tobulinamos ir turi
skirtinga vartotojy skaiCiy.

e Chrome — nemokamai platinamas Google kompanijos produktas.

e Opera — nemokamai platinamas norvegy kompanijos produktas.

e Kitos. Egzistuoja daugybé komerciniy ir nemokamai parsisiunc¢iamy narSykliy,
skirty jvairiems interneto vartotojy poreikiams.

Sioje metodinéje priemonéje pladiau §iy priemoniy neapraSysime.

2.6. Elektroninio paSto programos

Elektroninio paSto programos — tai teksto ruoSimo priemonés, kurias vartotojas
pirmiausia naudoja komunikacijai, siysdamas teksta ar kita elektroning medZiaga internetu.
Elektroniniy paSto programy S$ioje metodinéje priemonéje smulkiau nenagrinésime dél
pernelyg didelés ju ivairovés.
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3. MICROSOFT WORD

3.1. MS Word versijos

Kompiuterio techninés galimybés ir idiegta Windows operacinés sistemos versija lemia,
kuri Microsoft Word programos versija yra idiegta vartotojo kompiuteryje.”’ Atsizvelgiant i
Zymesnius kokybinius pasikeitimus, Sios versijos galéty biiti skirstomos { tris grupes:

e MS Word 6.0 versija yra pirmasis Microsoft kompanijos bandymas sukurti
daugiafunkce teksto redaktoriaus vartotojo sasaja Windows operacinéje sistemoje.
Nors §i versija turi daug panaSumy su vélesnémis versijomis, taCiau grafinés ir
funkcinés Sios programos galimybés yra gerokai menkesnés nei vélesniy programos
Versijy.

o MS Word 97/2000/2003 versijos yra panasaus funkcionalumo ir juy skirtumai néra
dideli. Si MS Word grupé vis dar paplitusi seniau jsigytuose kompiuteriuose.

e MS Word 2007 versijoje yra igyvendinta vartotojo sasajos architektiira, orientuota i
rezultatus. Sios versijos kuria jau nauja dokumento formata su plétiniu ,,.docx",
kurio neatpaZista senesnés teksto redaktoriaus versijos. Si versija pasirodé kartu su
nauja Windows operacine versija — Windows VISTA.

e MS Word 2010 versija yra naujausias Microsoft kompanijos produktas, tai
patobulinta MS Word 2007 versija.

1 lentelé. MS Word programos versijos

MS Word 6.0

MS Word 97 (panaSaus

MS Word 2000 funkcionalumo

MS Word 2003 Versijos)

MS Word 2007 (i rezultatus orientuotos vartotojo sasajos,
MS Word 2010 atsiranda ,,.docx* formatas)

Reikia paminéti, kad Sioje metodin€je priemonéje néra galimybiy aprépti visy
funkcionalumo skirtumy, kurie egzistuoja tarp skirtingy Word programos versijy, todél buvo
pasirinktos dvi skirtingo funkcionalumo versijos: MS Word 2003 ir 2007.

3.2. MS Word: greitieji klaviSai

MS Word turi daugiau nei 4000 skirtingy komandy. IS ju mazdaug ketvirtadalis turi
priskirtus greituosius klaviSus. Tik nedaugelis Siy komandy yra vartotojy naudojamos ypac
daZznai. Norint iSkviesti daZniausiai naudojamas komandas, patogu naudoti greituosius
klaviSus.

Greitieji klaviSai — tai tam tikra klaviSy kombinacija, leidZianti iSkviesti jai priskirta
komanda (pvz., Ctrl ir s klavisai, spaudZiami kartu, leidZia iSsaugoti tuo metu atidaryta
dokumenta). Greitiesiems klaviSams priskirtos komandos yra vienareikSmés, t. y. viena
klaviSy kombinacija priskiriama tik vienai komandai.

Vartotojas gali kurti savus greituosius klaviSus (pvz., specialiems simboliams rasyti).

Svarbiausi greitieji klaviSai veikia ne tik MS Word programoje, bet daugelyje kity
Windows programuy.

Kam jy reikia?

*! Naudojamos programos versija galima suZinoti paleidziamos programos pradiniame lange arba spusteléjus
klavisa F1.
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e leidzia greiciau atlikti daZznus veiksmus,
e nereikia atitraukti démesio nuo kuriamo teksto,
e nereikia atitraukti ranky nuo klaviatiiros.
Dauguma greityjy klavi$y yra kombinacijoje su CTRL ir ALT klavisais. Siy klavisai
naudojami Siek tiek skirtingai:
CTRL
— mygtuko paspaudimas leidZia, pasiZzyméjus faila ar teksta ir su pele pakeitus jo
vieta, kopijuoti paZyméta faila/teksta;
— svarbus funkcinis mygtukas kombinacijoje su kitais mygtukais.

— mygtuko paspaudimas leidZia jeiti { meniu reZima;
— leidZzia atlikti pelés funkcijas kombinacijoje su raidémis (pabrauktos raidés);
— svarbus funkcinis mygtukas kombinacijoje su kitais mygtukais.

2 lenteléje pateiktos daZniausiai naudojamy greityju klaviSy kombinacijos.
(Atsispausdinkite §i lapa, kad galétuméte greiCiau prisminti daZniausiai naudojamy greityjy
klaviSy kombinacijas.)
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2 lentelé. Dazniausiai naudojami greitieji klavisai

Ctrl - mygtuko paspaudimas leidZia, pasiZymejus failg ar teksta ir su pele
pakeitus jo vieta, kopijuoti paZyméta failg arba teksta;
- svarbus funkcinis mygtukas kombinacijoje su kitais mygtukais.
Alt - mygtuko paspaudimas leidZia jeiti { meniu reZima;
- leidZia atlikti pelés funkcijas kombinacijoje su raidémis (pabrauktos
raidés);
- svarbus funkcinis mygtukas kombinacijoje su kitais mygtukais.
Langy valdymo
alt+tab - leidZia vaikscioti tarp atidaryty programy languy (i desing)
alt+tab+shift - leidZia vaikscioti tarp atidaryty programy langu (i kairg)
3 + tab (VISTA) - leidZia vaikscioti tarp atidaryty programy langy (i desing)
# + tab + shift - leidZia vaikscioti tarp atidaryty programy langu (i kaire)
(VISTA)

Vaiks¢iojimo po teksta

Pg up

- 1 puslapis { virSy

Pg dn - 1 puslapis { apacia

ctrl+end - zymeklis Soka | dokumento pabaiga

ctrl+home - zymeklis Soka | dokumento pradZia

ctrl+g - leidzia nusSokti (Go to)

SHIFT+F5 - leidZia pereiti i paskutini kartg redaguota dokumento dali

Kopijavimo ir jklijavimo

ctrl+c - kopijuoja pazyméta faila ar teksta i atminti (Copy) (clipboard)
ctrl+v - iklijuoja pazyméta failg ar teksta i§ atminties (Paste) (clipboard)
ctrl+x - iSkerpa paZyméta failg ar teksta ir padeda i atminti (Cut) (clipboard)
Paieskos

ctrl+f - iSkviecia paiesSkos (Find) langa

ctrl+h - iSkviecia pakeitimo (Replace) langa

Teksto maketavimo

ctrl+b - uzdeda arba nuima teksto parySkinimg (Bold)

ctrl+i - pazyméta teksta pakei€ia kursyvu arba atvirkSc¢iai (Italics)
ctrl+u - paZyméta tekstq pabraukia arba nuima pabraukima (Underline)
ctrl+shift+, - sumazina Srifta

ctrl+shift+. - padidina Srifta

ctrl+shift+1 - pakeiia pazymeéta teksta 1 Antrasté 1 (Heading 1) stiliu
ctrl+shift+2 - pakeiia pazymeéta teksta 1 Antrasté 2 (Heading 2) stiliu
ctrl+shift+3 - pakeiia pazymeéta teksta 1 Antrasté 3 (Heading 3) stiliu

Kiti

ctrl+s - saugoja atidarytg faila (Save)

F12 - saugoja atidarytq failg nurodant pavadinimg (Save As)

ctrl+z - atSaukia paskutini veiksma (Undo)

ctrl+p - iSkviecia spausdinimo langa (Print)

ctrl+a - pazymi visa teksta (Select All)

ctrl+Enter - jterpia puslapio luzi (Insert -> Break)

49




3.3. MS Word: dokumento konstravimas
Siame skyrelyje apZvelgsime MS Word komandas ir veiksmus, kurie yra reikalingi
sudétingesnés struktiiros tekstams raSyti.
3.3.1. Teksto daliy Zyméjimas

RaSant teksta daZnai reikia teksto dalis trinti, perkelti, keisti jy vaizdines savybes. Teksta
ar jo dalis Zyméti galima keliais buidais:

Naudojant klaviatiirq
Perkélus Zymekli i Zymimos teksto dalies pradZia arba pabaiga ir paspaudus SHIFT
klavi$a, rodykliy klaviSais reikia paZyméti norima teksto dali.

Nuvedus- zvmeklj- |- Zvmimos- teksto- dalies- pradZia- arba- pabaiga- ir- paspandus- SHIFT-
Klavisa reikia-rodvkliu klavisais-pazvméti-norima-teksto-dalj ¥
L i

Naudojant pele tiesiogiai Zymint tekstq

Paspaudus kairiji pelés klavisa, reikia jo neatleisti ir Zyméti norima teksto dali. Jei reikia
zZyméti ilgesng teksto dali, galima nuspausti SHIFT klavisa ir spustelti kairjji pelés klaviSa
Zymimo teksto pabaigoje.

Norint pazyméti Zodj, reikia ji pele spustelti du kartus; norint paZyméti pastraipa, reikia
ja spustelti tris kartus.

Naudojant pele Zyméjimo laukelyje 5
Kairysis teksto redaktoriaus laukelis yra Zyméjimo laukelis. Cia paspaudus su pele
galima pazymeéti teksto eilutg arba kelias eilutes.

Naudojant klavisq SHIFT ir vaiksciojimo po tekstq greituosius klavisus

Jei kartu su paspaustu SHIFT klaviSu paspausime greituosius klaviSus (Home, PgUp,
PgDN, End, ir kt.) ar ju kombinacijas, tai atitinkamai paZymeésime teksta.

Jei norite pazymeti kelias ne iS eilés einancias teksto dalis, prieS kiekviena kita Zymima
dalj naudokite Ctrl klavisa.

Jei-norite-pazvmeéti-kelias-ne-i-eilés- einancias-teksto-dalis, -pries -ldekviena kita-Zvmima-
dalj-naudokite Crl-klavisa ¥
i

3.3.2. Rodymo reZimai

Teksto redaktoriaus lango apacioje, deSin¢je puséje galima rasti skirtingy rodymo
rezimy mygtukus (Siuos mygtukus taip pat galima rasti pagrindinés irankiy juostos Rodymo
(View) skiltyje). Siais mygtukais galima pasirinkti dokumento rodymo reZima kompiuterio
ekrane.

EEEEE

e Atspausdinto puslapio vaizdas (Print Layout) — matomas dokumento vaizdas yra

toks, koks jis atrodys popieriuje.

e Skaitymas visame ekrane (Full Screen Reading) — skirtas tekstui skaityti.

e Internetinio puslapio vaizdas (Web Layout) — skirtas dokumentui pavaizduoti taip,

kaip jis atrodyty interneto narSykléje.

e Dokumento struktiira (Outline) — skirtas skirtingoms struktiirinéms dokumento

dalims iSrySkinti.
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e Juodrastis (Draft ar Normal) — matomas tik iStisinis tekstas be puslapio riby,

paras¢iy ir kolontituly.

3.3.3. Dokumento Zemélapis

Dokumento Zemélapio (Document Map) funkcija yra labai naudinga dirbant su
didesniais, sudétingos struktiiros dokumentais. Si funkcija leidZia vartotojui dokumento
kair¢je paraStéje matyti visa dokumento antra$Ciy struktiira ir panoréjus greitai perSokti {
pasirinkta dokumento vieta (Zr. 3 paveiksla). Matyti dokumento Zemélapi galima tik tuo
atveju, kai skyriy pavadinimai paZymeti kaip atitinkamos antrastes, t. y. Antraste 1 (Heading

1), Antrasteé 2 (Heading 2) ir t. t.

Home Insert Page Layout References Review

B [@[3) 5 o
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Y Document Map

]
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Print || Full Screen Web  Outline  Draft
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1.5. Gero mokslo darbo ypatybés
[=] 2. REIKALAVIMAI MOKSLO DARBAMS
[= 2.1, Mokslinio darbo dalys
2.1.1, vadas
2.1.2. Tiriamaji darbo dalis
2.1.3. Iivados
2.1.4. Papildomosios dalys
2.2, Formalieji mokslinio darbo reikalavimai
2.3, Formalieji kompiuteriu renkamo teksto reikala:
[=] 3. BAIGIAMUIL DARBL) GYNIMAS
3. 1. Pasirengimas baigiamujy darby gynimui
3.2, Baigiamujy darby gynimas
3.3, Baigiamujy darby vertinimas
4, RASYMO PROCESAS z
11 dalis. ELEKTRONINIL) TEKSTL) RUQSIMO PRIEMON
[=] 1. SWARBIAUSIOS ELEKTROMINIL TEKSTL RUOSIMC.
1.1, Teksto redaktoriai
1.2, skaiducklés-enteles
1. 3. Pristatymy rengimo programos
1.4, Grafinés ir piegimo programos
1.5. Internetinés nardykles
1.6, Elektroninio pagto programos
[=] 2. MICROSOFT WORD
2,1.M5 Word versijos
2.2, M5 Word: greitieji lavizai
[= 2.3. M5 Word: dokumento konstravimas
2.3.1, Teksto daliy Zyméjimas
2.3.2. Rodymo refimai
2.3.3. Dokumento Zemélapis
2.3.4. stiliai
2.3.5. Automatinis turinys
2.3.6. Teksto numeravimas
2.3.7. Ladiai
2.3.8. Puslapiy numeracija
2.4, M5 Word: paieska
=1 2,5, M5 Word: lenteles

View

C% """ E,L]One Page _.ﬁl %
| g A
=20 0 Two Pages [
Zoom 100% MNew  Arrange Remowve
= Page Width || window  All split | 21 Reset Window Positior
Zoom Window
|-§-|-1-|-2-|-2-|-4-|-E-|-5-|-_-‘--|-5-|-’:-|-13-|-11-|
II DALIS. METODINIAI NURODYN
DARBAMS

1. MOKSLO DARBU ZANRAI IR YPATYH
1.1 Mokslo darby ypatybés

Mokslo kalbai biidingas apibendrinimas, dalvkinis tikslum
objektyvumas, glaustumas, iSsamumas, ai$kumas. Mokslo kalbos
terminu ir vienareikimiu, tiesioginés reikimés Zod#iu vartojimas.
reikSmei apibrézti nereikia platesnio konteksto —jis turi biti aiskus i

Mokslo kalbos sintaksei biidingos konstrukcijos, pabrézian
(pvz.: pirma, antra, kita vertus), jspraudai (pvz.: vadinasi, taig
jungtukiniai sakiniai (pvz.: Daiktavardziai, reikiantys pojiciai
dalvkus, yra konkretieji, o visi kiti priklauso abstrakdiyjy daiktavard]

Objektyvuma pabrézia beasmenés ir pasyvinés konstrukcijos
vra apibréziamas daugiareik$miskumas apskritai. Toliau
daugiareikimiskumo tipai, pateikiama ju klasifikacija. Paaiskinay
pasirinktas morfologinis daugiareik$miskumas).

Biidingi mokslinio stiliaus trikumai yra gremézdiskog
daiktavardziu gausa (pvz.: Sio darbo radymui (= Sam darbu
pasirinkta tokia tema...), nekonkretiis, neaiskiis, netinkami ZodZiuy
galo svarbus, labai jdomus).

Mokslo kalbai bidingas nominatvvinis stilius: wvartojama
daiktavard#iu. Toks radvmas daro kalba abstrak¢ia ir sudétinga, o t
studentu sieldamybé. Ju manvmu, tai vra svarbiausias mokslo kal
Tacdiau, kiek jmanoma, reikia stengtis luo maau wvartoti bey
biidvardiniu daiktavardZziu su priesagomis -imas, -ymas, -umas.

Darbe patartina vartoti esamajj arba biitajj kartinj laika, o
reikétu vartoti ne biisimajj laika, nes, kai skaitomas jvadas, visas d

3 2

P DR o B R |

Page: 5 of 80 | Words: 21.939

&

Lithuanian [Lithuania)

3 paveikslas. MS Word 2007 programos dokumento Zemélapio langas

Si funkcija gali biti iskviesta:

MS Word 2003 programos versijoje pasirinkus pagrindiniame meniu Rodymas (View)

-> Dokumento struktiira (Document Map).

MS Word 2007 programos versijoje pasirinkus pagrindiniame meniu Rodymas (View) ir
irankiy juostoje pazyméjus dokumento Zemélapio (Document Map) langeli (Zr. 3 paveiksla).

3.3.4. Stiliai

Skirtingus stilius sudaro tam tikry teksto formavimo pasirink¢iy visuma (Sriftas, teksto
dydis, lygiavimas, tarpai tarp eiluciy arba pastraipy ir kt.). Kiekvienas stilius turi pavadinima
(pvz.: Iprastasis (Normal), Antrasté 1 (Heading 1)). Specialiame laukelyje nurodZius stiliaus
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pavadinima, tam tikrai teksto daliai galima priskirti visas to stiliaus pasirinktis. Stiliy
naudojimas labai palengvina dokumenty formavima (Zr. 4 paveiksla).

T Dokumentas1 - Microsoft Word

E Fallas  Redagavimas Rodymas  ITterpimas  Formatawimas — Irankial  Lenkelé  Lapaas Zinynas  Trados  MultiTerm veskite kausimg * X
: : PO A W= K S .|-_ﬁ!§474 <] tmes vewRonan < 12 < | PP P |[E]=E = d=i e T !
LT | i G o+ [ o @ H] 8 [ e | F
_g ‘ Walyti formatavima | | &) & |8 |
B =1

‘m”m‘-qs--q‘sw-o:m
Antrasté 2 "

Antrasté 3 1

Tprastasis 1

Daugiau

Antrasté 1
Antrasté 2

Antradté 3
Iprastasis

[ SN R EERN S-SR IS BN R B B

4 paveikslas. Word 2003 programos stiliy meniu

Word 2007 versijoje teksto stiliaus vaizdas ne tik pavaizduojamas kiekvieno stiliaus
mygtukuose, bet ir automatiS8kai keiiamas perkélus pelg ant stiliaus mygtuko (Zr. 5
paveiksla). Taip igyvendinamas programos kiiréjuy noras leisti vartotojui matyti rezultata dar
pries pasirenkant stiliy.

Word non-commercial use
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5 paveikslas. Word 2007 programos stiliy meniu

Vartotojas gali naudoti standartinius programos stilius arba juos keisti pagal savo
poreikius. Norédami keisti stiliy, pasirinkite stiliy, spragtelkite deSiniji pelés klavisa ir
pasirinkite komanda Modifikuoti (Modify). Atsidarys lentele, kurioje galésite keisti norimo
stiliaus pasirinktis.

3.3.5. Automatinis turinys

Jei turini kursime ,rankomis®, tai keisdami dokumenta neiSvengsime pakartotinio jo
redagavimo ir tikslinimo. MS Word teksto redaktorius turi funkcija, kuri leidZia greitai ir
patogiai susikurti bei atnaujinti dokumento turini. Automatinis turinys remiasi stiliais: jei
nekeisime vidiniy programos nustatymuy, i turini bus itraukiamas tik tas tekstas, kuriy stilius
yra Antrasté # (Heading #, pvz., Heading 1, Heading 2 ... Heading n).

Norédamas automatiskai susikurti savo dokumento turini, vartotojas pirmiausia turi
nuosekliai taikyti stilius toms teksto dalims, kurias nori itraukti i turini (pvz., antrastes), t. y.
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bendriausiems skyriy pavadinimams turi buti taikomas Antrasté 1 (Heading 1) stilius,
poskyriy pavadinimams Antrasté 2 (Heading 2), skyreliy pavadinimams Antrasté 3 (Heading
3) ir t. t. (Zr. 6 paveiksla).

1. Skyriaus pavadinimas Antrasté 1 (Heading 1)

Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas.
Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas,
tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas,
tekstas.

1.1. Poskyrio pavadinimas Antrasté 2 (Heading 2)|

Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas.
Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas,
tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas,
tekstas.

1.1.1. Skyrelio pavadinimas |Antra§té 3 (Heading 3)|

Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas.
Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas,
tekstas, tekstas.

1.1.2. Skyrelio pavadinimas |Antra§té 3 (Heading 3)|

Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas.
Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas,
tekstas, tekstas.

1.2. Poskyrio pavadinimas Antraste 2 (Heading 2)

2. Skyriaus pavadinimas Antraste 1 (Heading 1)

Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas.
Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas,
tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas, tekstas. Tekstas, tekstas,
tekstas.

6 paveikslas. Antras¢iy stiliai dokumente

Susikiirus nuoseklia antras¢iy struktiira, jau galima sudaryti ir automatini turini.

MS Word 2003 programoje pagrindiniame meniu reikia pasirinkti:

[terpimas (Insert) -> Nuoroda (Reference) -> Rodyklé ir sqrasai (Index and contents)
—> Table of contents.

MS Word 2007 programos versijoje:

Reference -> Table of Contents -> Insert Table of Contents arba pasirinkti kuri nors
vieng i anksto sudaryta turinio varianta.

Abiejose programos versijose atsidarys automatinio turinio langas (Zr. 7 paveiksla),
kuriame galima pasirinkti turinio lygiy skaiGiy, lygiavima ir kt. Siame lange pasirinkus
Pasirinktys (Options), 1 automatini turini galima itraukti ir kitus stilius. Pasirinkus atitinkamus
nustatymus, turinys atsiras toje vietoje, kur tuo metu buvo Zymeklis.

Automatinis turinys — tai specialus laukas (field), kuri reikia atnaujinti pasikeitus
dokumentui (t. y. automatiSkai turinys neatsinaujina). Atnaujinti reikia tam, kad po didesniy
dokumento pakeitimy ir prie§ spausdinant turinyje biity naujausia informacija. Tam reikia
spragtelti deSiniji pelés klaviSa ir pasirinkti komanda Naujinti laukq (Update field). Galima
atnaujinti visa turini (Update entire table) arba tik puslapiy numerius (Update page numbers
only) (zr. 8 ir 9 paveikslus).
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Table of Contents

Print Preview Web Preview
Heading1.........ccooovemmmiiiccceannees Heading 1
7 SRS ISTT IS Title 5
I Heading 2
PRl Y o Heading 3

Show page numbers
Right align page numbers
Tab leader: |.......

General
Formats:

Show levels: |3 H

LIse hyperlinks instead of page numbers

| From template E[

[Qpﬁuns... ][ Modify. .. ]

| ok

]’ Cancel ]

7 paveikslas. MS Word programos automatinio turinio langas

1. Svarbiausios elektroniniy teksty ruo3imo priemonés

1.1. Teksto redaktoriai

1.3. Pristatymy rengimo programaos....
1.4. Grafinés / pieSimo programos ......
1.5. Internetinés narsyklés
1.6. Elektroninio paste programos.......

2. MICROSOFT WORD .......... :
2.1.MS Word versjos.......
2.2, MS Word: greitieji klaviZai
Kam jureikia?.....c..cceeeeen.
2.3. M5 Word: dokumento konstravim

2.3.1. Teksto daliy Fyméjimas

B 7

W A-E

Calibri 111 A ) A
i iz -

J‘IJ

53| Cop

& Paste

3% Update Field
Edit Field... \

Toggle Field Codes

............ A | Font.

=% Paragraph...

:— | Bullets

i—  MNumbering

8 paveikslas. Automatinio turinio atnaujinimo pavyzdys
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T

Word is updating the table of contents. Select one of
the following options:

(@ Update page numbers only:
(71 Update entire table

Update Table of Contents

Ok ] [ Cancel

9 paveikslas. Atnaujinimo pasirinktys

3.3.6. Teksto numeravimas

Automatinis teksto numeravimas — naudinga funkcija, leidZianti vartotojui sukurti
automatiSkai sunumeruotus saraSus. Automatinis numeravimas patogus ne tik tuo, kad
vartotojui nereikia paciam raSyti saraSo numeriy, bet ir tuo, kad pasikeitus saraso tvarkai ar
elementy skai€iui, programa atitinkamai pakeicia ir numeracija.

Norint pradéti automating numeracija, jrankiy juostoje vartotojas turi paZyméti teksta,
kuri nori sunumeruoti, ir pasirinkti klavi§a Numeravimas (Numbering):

i— -
i—

Irasius teksta ir paspaudus ivesties klavisa ENTER, numeracija bus tgsiama. Jei tekstas
nebus paraSytas, numeracija bus nutraukta. Paspaudus saraSo desiniji klaviSa, pasirodys
komandy langas (Zr. 10 paveiksla), kuriame galima nustatyti, kad numeracija biity tgsiama
(Continue numbering) arba galima pakeisti numeracijos skaiéiy (Set numbering value). Sitos
komandos naudingos, jei sunumeruoto saraso viduryje yra nesunumeruoto teksto daliy.

=

Paste

Continue Mumbering

]

I 14

Set Numbering Value...

I Adjust List Indents... I

B

Decrease Indent

o
I

¥
&

Increase Indent

Font... I n 3
ﬁ - Set Mumbering Value |M
=17 | Paragraph...
i=  Bullets " @ startnew list
e 3 () Continue from previous list
i—| Mumbering 3 : o
: Advance value {skip numbers)
H_!?y Hyperlink...
5 Set value to:
&l Look Up.. 1 =

[ AR ' Preview: 1.
Translate 3
OK ] I Cancel
Styles 3
| e

10 paveikslas. MS Word 2007 programos numeracijos komandy langai
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Programa leidZia susikurti vartotojui ir keliy lygiyu numeracijos sarasa. Numeracijos
lygius patogu valdyti klaviSais MaZinti jtraukq (Decrease intent) ir Didinti jtraukq (Increase
intent):

|2 £

3.3.7. LiZiai

Luziai (Breaks) reikalingi tam, kad norimoje vietoje nukeltume ar padalytume teksta. Jie
gali biiti puslapio, dokumento dalies (section), teksto stulpeliu (column breaks).

Dirbant su didesniais, sudétingesnés struktiiros ir dinamiSkai besikeiCianciais
dokumentais, patogu naudotis puslapio laZiais (Page breaks). Siuos liZius patogu jterpti tada,
kai vartotojas nori pradéti nauja puslapi, pavyzdZiui, pradédamas nauja skyriy, nors
redaguojamo puslapio dar iki galo neuzpilde.

Puslapio l[0Ziui iterpti galima naudoti greitaji klavisa Ctrl+ ENTER arba:

MS Word 2003 programoje pagrindiniame meniu pasirinkti [terpimas (Insert) -> LiiZis
(Break) -> Puslapio liiZis (Page Break).

MS Word 2007 programoje pagrindiniame meniu pasirinkti {terpimas (Insert) ir irankiy
juostoje Puslapio liZis (Page Break).

3.3.8. Puslapiy numeracija

Norédamas sunumeruoti puslapius vartotojas turi:

MS Word 2003 programos versijoje pagrindiniame meniu pasirinkti {terpimas (Insert)
-> Puslapio numeris (Page Numbers).

MS Word 2007 programos versijoje pagrindiniame meniu pasirinkti /ferpimas (Insert) ir
naudoti klaviSa Puslapio numeris (Page number):

H

Page
Number =

Puslapio numeris bus iterptas i visu puslapiy virsutinj arba apatinj kolontitulq (Footer,

Header).
Page Number Format 7] x|
Mumber farmat: M ~|
[ Include chapter number
Chapter skarts with skyle IHeading 1 j
|lze separatar; I (Fvphien) j
b
751 [
Position: Preview -
Bott f page {Footer) j Page numbering
I o el pea = i« Continue From prewvious seckion
Alignment: — - —
IRight j — Stark ak: I 5
Iv show number on first page .
Format. .. | Cancel | DK I Cancel |

11 paveikslas. MS Word 2003 programos puslapio numeriy nustatymo langai

Atsidariusiuose languose galima pasirinkti puslapio vieta (virSuje arba apacioje (Top of
page (Header), Bottom of page (Footer)), numerio lygiavima (Alignment) (kairéje, viduryje,
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desinéje), numerio rodyma pirmame puslapyje (Show number on first page) ir pradzios
skaiciy (Start at) (Zr. 11 paveiksla).
MS Word 2007 programos versijoje puslapio numerio pozicija, lygiavima ir numerio

stiliy galima pasirinkti atsidariusiame interaktyviame sarase (Zr. 12 paveiksla).
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12 paveikslas. MS Word 2007 programos puslapio numerio vietos pasirinkimo langas

Norédamas paSalinti puslapiy numeracija vartotojas turi pagrindiniame meniu pasirinkti
Rodymas (View) -> Virsutinis ir apatinis kolontitulas (Header and Footer) ir pasiZymeéjgs
puslapio numeri ji iStrinti.

3.3.9. Zodziy ir spaudos Zenkly skaiciavimas

Neretai prireikia suZinoti, kiek ZodZiy ar spaudos Zenkly yra sukurtame tekste ar teksto
dalyje.

ZodZiy ir spaudos Zenkly skaicius visame faile

MS Word 2003 programos versijoje pagrindiniame meniu reikia pasirinkti Failas (File)
-> Properties (Ypatybés) ir pasirinkti kortelg Statistika (Statistics) arba [rankiai (Tools) ->
Word Count.

MS Word 2007 programos versijoje viso dokumento ZodZiy skaiiy programa nuolat
rodo apatiniame kairiajame ekrano kampe.

Page: 56 of 89 | ‘Words: 26.013 | @ Lithuanian [Lithuania) | 25 |

Pasirinkus teksto dalj, programa rodo tos teksto dalies ZodZiy skaiciy ir viso dokumento
7odziy skaiCiy.
Page: 56 of 99 | Words: 14/25.013 | @ Lithuanian [Lithuania] | :ﬂ |
Jeigu prireikty iSsamesniy duomeny, pagrindiniame meniu reikia pasirinkti PerZiiira
(Review) ir mygtuka Spaudos Zenkly apskaita (Word Count).

%Wnrd Count
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Tada atsidarys langas, kuriame bus pateikti iSsamesni viso failo duomenys:

Word Count @l&]

Statistics:
Pages a7 Puslapiai
Words 22.047 Zodziai
Characters (no spaces) 149,331 Spaudos Zenklai (be tarpy)
Characters {with spaces) 170.072 Spaudos Zenklai (su tarpais)
Paragraphs 1.649 Pastraipos
Lines 3.235 Eilutes

e {traukti puslapio ir dokumento isnasas

Zodziy ir spaudos Zenkly skaicius pazymétoje teksto dalyje

Jei reikia suZzinoti tik kurios nors teksto dalies duomenis, prie§ atsidarant apskaitos
iranki reikia paZyméti tg teksto dali.

Tai yra tekstas kurio ZodZiai yra suskai€iuoti automatiskai.

Word Count @Iﬂ_hj

Statistics:
Pages 1
Words
Characters (no spaces) 53
Characters (with spaces) a0
Paragraphs
Lines 1

Indude texthoxes, footnotes and endnaotes

3.4. MS Word: paieSka

PaieSkos langas gali biiti iSkviestas greituoju klaviSu Ctrl+F arba mygtuku:
3 Find ~

MS Word 2003 programoje Sia komanda galima pasirinkti ir pagrindiniame meniu
Redagavimas (Edit) -> Rasti (Find).

Paieska skirta:

e informacijos paieSkai (raktiniai ZodZiai),

e simboliy paieskai (simbolis) arba pakeitimui,
formato paieskai (pvz., rasti kursyvo teksta) arba pakeitimui,
teksto elementams skaiciuoti.
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Find and Replace

Find |F'.egla::e I Go To |

Find what:

Cancel

e

13 paveikslas. Radimo (Find) ir keitimo (Replace) langas

Atsidariusiame paiesSkos lange (Zr. 13 paveiksla) dar galima pasirinkti Keitimo (Replace)

ir Eiti j (Go to) komandas, taip pat iSpleésti langa spusteléjus Daugiau (More) mygtuka.

Find and Replace

PR

Find |F'.egla::e I Go To |

Find what:

Search Options
search; | Al

=]
[] Match case
[ Find whole words only
[] Use wildcards
[ sounds like {English)
[ Find all word forms (English)

Find

Format - ] [ Special -

1w Find Mext Cancel

[=]

[] Match prefix
[ Match suffix

D Ignore punctuation characters
[] 1gnore white-space characters

14 paveikslas. ISpléstas paieskos langas

Paprasta paieska ieskant informacijos ir keiciant

Norédamas faile surasti reikiama informacija, vartotojas turi Rasti (Find what) laukelyje
irasyti Zodi, simboliy grandinélg ar frazg, kuriuos norima rasti tekste. Paspaudus klavisa Find
in, programa persikels i ta vieta, kur yra ieSkomas Zodis, simboliy eiluté ar frazé. Norint rasti
tolimesni paieSkos objekto atveji, reikia spausti Rasti kitq (Find next) (Zr. 14 paveiksla).
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Irasytas Zodis, simboliy grandinél¢ ar fraz¢ bus surasti, neatsizvelgiant i teksto formata ir i tai,
ar raidés bus didZiosios ar maZosios.

Jei norima, kad paieSkos uZzklausa atsizvelgty i didZiasias ir maZasias raides, reikia
pazymeéti Skirti ABC nuo abc (Match case).

Jei norima, kad paieSkos uZklausa rasty tik pilnus ZodZius, reikia pazymeéti leskoti tik
viso ZodZio (Find whole words only).

Jei norima paieSkos objekta pakeisti i kita, reikia pasirinkti klaviS$a Keisti (Replace) ir
laukelyje Keisti { (Replace with) irasyti tai, 1 ka norima pakeisti.

Jei reikia surasti ZodZio pradZia, reikia pazymeti Match prefix. Jei reikia surasti ZodZio
pabaiga, reikia pazyméti Match suffix.

Teksto ypatybiy paieska arba keitimas

MS Word programa turi patogia galimybg ieSkoti ir (arba) keisti teksto ypatybes,
pavyzdZziui, tam tikro dydZio teksta, pajuodinta teksta, kursyvu paraSyta teksta, parySkinta
teksta, pabraukta teksta ir pan. Galima ieSkoti:

1. Konkretaus teksto su tam tikra savybe (pvz., ZodZio Antanas, paraSyto kursyvu):

a) Tam reikia jrasyti | paieSkos langeli ieSkoma teksta.

b) Zymekliui esant tame langelyje spustelti mygtuka Formatavimas (Format) ir
pasirinkti grifto (Font), Paragrafo (Paragraph), Tabuliacijy (Tabs), Kalbos (Language),
Rémelio (Frame), Stiliaus (Style), Paryskinto teksto (Highlight) teksto savybes. Siame
langelyje galima naudoti ir formatavimo greituosius klaviSus (pvz., Ctrl+1 pasirenka kursyvo
savybe).

r. k-
Find and Replace @'&J

Find |Reg|ar.e | Go To

Find what: Antanas |E|

[Eeading Highlight v] | Findin + ] I Eind Mext I | Cancel

Search Options

Search: | All IEI

Eont... I:I Match prefix
[] Match suffix

Paragrapgh...

Tabs... [7] 1gnore punctuation characters

Language... sh) [ 1gnore white-space characters

Frame...

Style...

Fi Highlight
- Farmz Spedal - .
b -

15 paveikslas. Paieskos langas su formatavimo savybémis
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Pasirinkta ieSkoma savybé ar savybés bus paraSyta Zemiau paieSkos laukelio (Zr. 16
paveiksla: Format Font: Italic).

Find and Replace

Find | Replace | GoTo |

Find what: Antanas|
Format: Font: Ttalic

16 paveikslas. Rasti (Find) lango fragmentas su pasirinkta teksto kursyvo savybe (Format Font: Italic)

¢) Paspaudus Rasti (Find) zymeklis sustos ant teksto su pasirinktaja savybe.

PASTABA: Siuo atveju, kad bity patenkinta paieskos uzklausa, tekste turi biti
iSpildytos abi uzklausos salygos — tekstas su nurodytomis savybémis. Kitaip sakant, jei tekste
bus Zodis Antanas be kursyvo, jis nebus rastas.

d) Norint pakeisti konkretaus teksto savybes, reikia pasirinkti Keisti (Replace) mygtuka

ir Zymekliui esant keitimo laukelyje irasyti ta pati teksta kaip ir radimo laukelyje, taip pat
nurodyti atitinkama teksto savybe. (Zr. 17 paveiksla).

Find and Replace Ii'ihj
Replace | GoTo

Find what: Antanas |E|
Format: Font: Italic
Replace with: |Antanas |Z|
Format: IUnderline

[ Replace ] [ Replace All ] [ Find Mext ] [ Cancel ]

e

17 paveikslas. Rasti (Find) langas, kuriame kei¢iama

2. Vien tik tam tikry teksto savybiy (pvz., bet kokio ZodZio ar teksto, paraSyto kursyvu)
paieska.

Siuo atveju i teksto paieskos langelj nereikia nieko rasyti, o tik pasirinkti norima teksto
savybe. Paspaudus Rasti (Find) Zymeklis sustos ant teksto su pasirinktaja savybe.

Reguliariy reiskiniy naudojimas

Kartais prireikia ieSkoti teksto, kuriame viena dalis yra nekintanti, o kita dalis kinta.
Tada i paieskos langeli iraSomi reguliarieji reiskiniai (regular expressions), kuriuose
kintanciajai daliai surasti yra naudojami pakaitos simboliai (Wildcards). PavyzdZiui, reikia
surasti ir pazyméti frazes ,,I paveikslas“, ,2 paveikslas* ir ,,3 paveikslas‘; $iy fraziy kintanti
dalis yra skaicius (1, 2, 3), o nekintanti Zodis paveikslas. Vietoj skai€iy panaudojus pakaitos
simboli ~# reguliarusis reiSkinys bus ,, #"# paveikslas‘.

Pakaitos simboliai yra dvejopi:
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1. Vieni simboliai gali biiti naudojami paprastame paieSkos lange. DaZniausiai
naudojamus pakaitos simbolius galima rasti paspaudus mygtuka Specialus (Special) (Zr. 18

paveiksla).
] Paragraph

-.-E-u-z-uw
2 +Vien-tik-tai-t
kursyvu) ¥

Find and Replace

Find Replace

Find what;

Search Options

Search: |All

[] Match case
[] Find whole wa
[] Uze wildcards

[ 5ounds like (&
[ Find all word f

Find

Paragraph Mark Ex
Tab Character

Any Character

Any Digit

Any Letter

Caret Character

§ Section Character

T Paragraph Character

Column Break

Em Dash
En Dash

Endnote Mark

Field

Footnote Mark

Graphic

Manual Line Break
Manual Page Break
Monbreaking Hyphen
Monbreaking Space
Optional Hyphen
Section Break

White Space

Styles

Format ~ | | Spedal x|

[] Match prefix
[ Match suffix

D Ignore punctuation characters
[ 1gnore white-space characters

Cancel

e

18 paveikslas. Paprasto paieskos lango pakaitos simboliai

Angliskas sqrasas
Paragraph Mark
Tab Character

Any Character
Any Digit

Any Letter

Carret Character

§ section Character
Paragraph Character
Column break

Em Dash

En Dash

Lietuviskas sqrasas
Pastraipos Zymé
Tabuliacijos simbolis
Bet koks simbolis
Bet koks skaitmuo
Bet kokia raidé
Intarpo Zenklas

§ Skyriaus simbolis
q Pastraipos simbolis
Stulpelio lizis

Ilgas briikSnys
Trumpas brikSnys
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“p
A
A9
N
~$
AN
"%
Ny
n
A+
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Endnote Mark Dokumento i$naSos Zymeé e

Field Laukas Al

Footnote Mark Puslapio i$SnasSos Zymeé M

Graphic Grafinis vaizdas M

Manual line break Neautomatinis eilutés ltizis N

Manual page break Neautomatinis puslapio luzis Am

Nonbreaking Hyphen Neperkeliamas brikSnelis A~

Nonbreaking Space Neperkeliamas tarpas s

Optional Hyphen Nebiitinas bruksnelis A-

Section Break Skyriaus liizis b

White Space Tarpas (tarpeliai ir tabuliacijos)  *w

Page Break Puslapio luzis A2
PavyzdZiai
n"?s randa (pabraukta dalis) UZgavénés, reiSkinys, NEP, nur, N4S
Awlang"$ w randa (pabraukta dalis) lange , lango , langq (neranda langas)
Nr.Aw/A# randa (pabraukta dalis) Nr. 10, Nr. 19, Nr. 009 (neranda Nr. 1,)
Nr.Awr# " w randa (pabraukta dalis) Nr. 10, Nr. 19
Aptp randa tu$cia eilute

2. Kiti simboliai, naudojami paieSkos lange, kuriame paZyméta Naudoti pakaitos
simbolius (Use wildcards)

I U - e x Any Character ? =4S Eio Ele T Marn
— e O Character in Range [ -] ‘araqraph. Gl
Find and Replace Beginning of Word P M
W Beniac End of Word =
Find what: BB t) |E|
Options: Use bt y
Mum Cccurrences {, }
Previous 1 or Mare @
0 or More Characters  *
Tab Character
Caret Character i ; 3
SR Column Break
Search; ..ﬁ.II Em_Das.h
Match case Efi Diah Match prefix
Find whole wo Match suffix
[¥] Use wildcard Graphi:
[ Sounds like (E Manual Line Break [ 1gnore punctuation characters
[ Find all word f Page / Section Break [ 1gnore white-space characters
Monbreaking Hyphen
Monbreaking Space
Find Optional Hyphen
Format = I [ Special - ]

19 paveikslas. Pakaitos simboliai paieskos lange, kuriame paZyméta Use wildcards (Naudoti pakaitos
simbolius)
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Angliskas sqrasas Lietuviskas sqrasas Pakaitos simbolis

Any Character Bet koks simbolis ?
Character in Range Simbolis sekoje [-]
Beginning of Word Zodzio pradzia <
End of Word ZodZio pabaiga >
Expression Reiskinys @
Not Ne [']
Num Occurrences Vartojimo daZnis {,}
Previous 1 or More Vienas ankstesnis arba daugiau @
0 or More Character 0 arba daugiau simboliy *
Tab Character Tabuliacijos simbolis At arba 79
Carret Character Intarpo Zenklas AN
Column break Stulpelio lizis "n arba "4
Em Dash Ilgas briikSnys A
En Dash Trumpas briikSnys A=
Graphic Grafinis vaizdas Ag arba M
Manual line break Neautomatinis eilutés liZis Alarba A1
Page/Section break Puslapio arba skyriaus lizis Am arba "2
Nonbreaking Hyphen Neperkeliamas brikSnelis A~
Nonbreaking Space Neperkeliamas tarpas As
Optional Hyphen Nebiitinas bruksnelis A
Paragraph Mark Pastraipos Zymé A3

PavyzdZiai:

<S randa visus ZodZius, prasidedancius s raide,

as> randa visus ZodZius su galiine -as,

M3 randa visas pastraipas, kuriy gale yra dvitaskis.

3.5. MS Word: lentelés

3.5.1. Lentelés braizymas

MS Word programoje lenteles galima sukurti keliais budais.
MS Word 2003 programos versijoje pagrindiniame meniu pasirinkite Lentelé (Table) ir
tada [terpti (Insert) —> Lentelé (Table) (zr. 20 paveiksla).

Table | Window Help
_# Draw Table o G == ,EEIE =
| Insert 4 ||§ Table.., % [

Delete v e

Select » | & ¥ . B

i o

& 2Els o

:ﬂ Table AutoFormat. ..

AukaFit ]
Conwert 3
%i Sort..,

Formula. ..

Hide Gridlines

20 paveikslas. Lentelés jterpimas Word 2003 programos versijoje
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MS Word 2007 programos versijoje reikia pasirinkti pagrindiniame meniu [terpimas

(Insert) ir pasirinkti Lentelé (Table) mygtuka.
Jei kuriama lentel¢ yra paprastos struktiiros, jos dydi galima pasirinkti pele nurodzius
norimg langeliy skaiciy (Zr. 21 paveiksla):

2 =S

Cover Blank Page
Page~ Page Ereak

Pages

Home | Insert | Page Layout References

LB

Table Ficture Clip 5Shapes Sma
- .IE'.Ft -

4x5 Table |

i - S R e T WORER R

|_|_."||

L
="
[ =]
-

Insert Table...
Draw Table

onvert Text to Tahle

Excel Spreadsheet

Quick Tables 3

21 paveikslas. Lentelés dydZio pasirinkimas

MS Word 2003 programos versijoje ta pati galima padaryti irankiy juostoje pasirinkus

mygtuka Lentele (Table):

EEz|

Jeigu vartotojas pasirinks komanda [terpti lentele (Insert table), jis pamatys langa,
kuriame turés pasirinkti lentelés parametrus (Zr. 22 paveiksla):

e stulpeliy skaiCiy (Number of columns),

o eiluciy skaiciy (Number of rows),

e automatinio ikélimo parinktis (Autofit behavior)

Fiksuotas stulpelio plotis (Fixed column width) — vartotojas gali
nurodyti nekintanti stulpelio ploti,

Automatiskai talpinti | turinj (AutoFit to contents) — stulpelio plotis
kinta priklausomai nuo jrasyto teksto uZimamos vietos,

Automatiskai talpinti § langq (AutoFit to window) — stulpelio plotis
nustatomas pagal lango dydi.
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28| [Tert Tobe PR5=)

Table size

Mumber of columns: Iﬂ 5‘ Table size
Mumnber of rows: |5 54 MNumber of columns: 5 =

AukoFit behavior Number of rows: 2 v
% Fixed colurn width: Im AutoFit behaviar
i AukoFit ko conkents
™ AutoFit ko window

Table style; Table Grid AutoFormat, .. | _ Autofit to contents

1 AutoFit to window

@ Fixed column width: | Auto e

[] remember dimensions for new tables

[~ Remember dimensions For new kables
oK I Cancel I [ oK ] I Cancel
MS Word 2003 MS Word 2007

22 paveikslas. MS Word 2003 ir MS Word 2007 programy versijy lentelés jterpimo langai

Be to, vartotojas gali pasirinkti komanda Piesti lentele (Draw table), tada atsidargs
irankiy langelis leis vartotojui nusipiesti pageidaujamos struktiiros lentel¢ naudojant
elektronini piestuka (Pen) ir trintuka (Eraser).

7

-
-

Yo pt
I"Braw | Eraser
i Pen Colar » Tahle
Draw Borders L

3.5.2. Automatinis lenteliy formavimas

Automatinio lenteliy formatavimo (AutoFormat) funkcija leidZia vartotojui greitai
pasirinkti lentelés dizaing.

MS Word 2003 programos versijoje Sia funkcija galima pasirinkti lentelés jterpimo lange
(Zr. 22 paveiksla).

MS Word 2007 programos versijoje pagrindiniame meniu atsiranda lentelés dizainui

skirtas langas Table Tools -> Design, kuriame vartotojas interaktyviai gali pasirinkti su
lentelés i§vaizda susijusias parinktis.

metodine-visa2.doc [Compatibility Mode] - Microsoft Word non-commercial use | Table Toals

i
—/ Home Insert Page Layout References Mailings Review View SDL Trados Design Layout
V| Header Row  |¥| First Column —_ &Shading x T ﬁ l:“'I
Total Row Last Column ME e | EEEe - ——-—-| - i¥iBorders v ¥a pt - =
ST P ECCCC | e T Draw Eraser
0 B Colu = 4 Pen Color = Table
Table Style Options Table Styles Diraw Borders =

3.5.3. Duomeny risiavimas lenteléje

Lentelés duomenis galima ruSiuoti Zymekliui esant lenteléje ir pasirinkus komanda
Lentelé (Table)-> Rusiuoti (Sort) (MS Word 2003 programos versijoje) arba mygtuka

7\
Z
Sort
Atsidarys langas, kuriame vartotojas turi nurodyti riiSiavimo kriterijus (Zr. 23 paveiksla):
e pagal kuri stulpeli rasiuoti (Stulpelis 1 (Column 1)),
e kokius duomenis riiSiuoti (skaiciy, teksta ar datg);
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e kokia tvarka rusiuoti (Didéjanti (Ascending), MaZzéjanti (Descending));

e ar turi lentel¢ antrasting eilut¢ (Header row), jei turi, tai joje esanti informacija
nebus riiSivojama;

e galima ruSiuoti pagal kelis stulpelius, tada reikia nustatyti riiSiavimo pirmenybg
(pvz., pirmiausia rusiuoti (Sort by) pagal Stulpelj 1, tada (Then by) pagal Stulpelj

2).
Sort D -
Sort by
Column 1 |E| Type: |Text |Z| @ Ascending
Descendin
Using: |Paragraphs |E| = -
Then by
|E| Type: |Text Izl @ Ascending
Descendin
Using: |Paragraphs |E| - -
Then by
Type: |Text Ascending
= Descending
IUsing: |Paragraphs =
My list has
Header row (@ Mo header row
Options. .. Ok ] | Cancel

23 paveikslas. RiiSiavimo langas

3.5.4. Teksto konvertavimas | lentele ir atvirksciai

Bet kuri teksta galima paversti i lentelg ir bet kokia lentele galima paversti i teksta. Tam
MS Word programoje yra komandos Konvertuoti j lentele (Convert to table) it Konvertuoti i
tekstq (Convert to text).

Norint teksta konvertuoti i lentelg, reikia konvertuojama teksta pasiZymeéti ir tada:

MS Word 2003 programos versijoje pagrindiniame meniu pasirinkti Lentelé (Table) ->
Konvertuoti (Convert) -> Konvertuoti tekstq i lentele (Convert Text to Table);

MS Word 2007 programos versijoje pagrindiniame meniu pasirinkti {terpimas (Insert)
-> Lentelé (Table) -> Konvertuoti tekstq | lentele (Convert Text to Table).

Atsidarys langas, kuriame bus sitloma, kaip tekstas bus skirstomas lenteléje, nurodant
stulpeliy skaiciy ir teksto atskyrimo vieta. Jei tas variantas vartotojui netinka, tai jis pats gali
nurodyti, kaip tekstas lenteléje turéty buti skirstomas (Zr. 24 paveiksla). Tam reikia nurodyti
Teksto atskyrimo vietq (Separate text at), kuri gali buti:

e ties pastraipomis (Paragraphs),

e ties tabuliacijomis (7abs),

e ties kabliataSkiais (Semicolons),

e ties vartotojo pasirinktomis vietomis (Others).
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Convert Text to Table Ii'ihj

Table size
Mumber of columns: : =
ber of rows 7
AutoFit behavior
@) Fixed column width: | Auto =
AutoFit to contents

AutoFit to windaw
Separate text at

Paragraphs (@ Semicolons

Tabs Qther:

QK ] | Cancel

e

24 paveikslas. Teksto konvertavimo j lentele langas

Apacioje matote pavyzdi, kaip tekstas pagal 24 paveiksle nurodytas parinktis bus
paverstas i lentelg.

Antanas; Petras; Jonas
20 m.; 22 m.; 53 m.
U

Antanas Petras Jonas

20 m. 22 m. 53 m.

Jei vartotojas nori lentelg paversti i teksta, jis, Zymekliui esant lentel¢je, turéty pasirinkti
komanda Konvertuoti lentele | tekstq (Convert Text to Table). Atsidarys lentele, kurioje
vartotojas turés pasirinkti skyrikli. Programa vietoj lentelés liniju iterps pasirinktaji skyrikli
(pastraipy Zymeg, tabuliacija, kabliataskj arba kita).

3.5.5. Skaiciavimas lentelése

Ir specializuotose skaiCiuokliy lenteliy programose, ir MS Word programos lentelése
galima taikyti formules. Norint jas iraSyti reikia:

MS Word 2003 programos versijoje, Zymekliui esant langelyje, kuriame norite jrasyti
formulg, pagrindiniame meniu pasirinkti Lentelée (Table) -> Formule (Formula).

MS Word 2007 programos versijoje, Zymekliui esant langelyje, kuriame norite jrasyti
formulg, atsidariusiame pagrindiniame meniu pasirinkti Lentelés jrankiai (Table Tools)->
Isdéstymas (Layout) ir mygtuka Formulé (Formula).

f‘ |

Atsidarys formulés langas, kuriame galima irasyti norima formulg:

68




[ Formula |i|i-r

Formula:
=SLIM(ABOVE)

Mumber format:

[+]

Paste function: Paste bookmark:
=] =]
|

’ oK ] I Cancel

e

25 paveikslas. Formulés jterpimo langas

Visos formulés turi prasidéti lygybés Zenklu.

Kiekvienas lentelés langelis turi adresa, kuris susideda i§ dviejy daliy:
e stulpeliai turi raidinius kodus abécélés tvarka (A, B, C, D, E ...),
e cilutés turi skaitmeninius kodus (1, 2, 3, 4 ...).

Al B1 C1
A2 B2 2
A3 B3 3

Formuléje nurodzius langelio adresa, galima atlikti aritmetinius skaiciavimus,
pavyzdziui, formulé ,=A7+A2“ Al langelio skaiCiy pridés prie A2 langelio skaiCiaus ir
formulés lauke pateiks rezultata. Jei langelyje bus tekstas, o ne skaiCius, tai formulés lauke
pamatysime klaidos praneSima.

Formulés lauka reikia atnaujinti, jeigu pasikeité formuléje naudojami duomenys. Norint
lauka atnaujinti, reikia spragtelti deSinjji pelés klavisa ir komandy lange pasirinkti Atnaujinti
laukq (Update field). Jei norite formulés lauke matyti pacia formulg, o ne jos rezultata,
pasirinkite komanda Perjungti lauko kodus (Toggle field codes).

Formuliy pavyzdZiai

=SUM(ABOVE) — sumuoja auksciau esancius skaicius,

=SUM(LEFT) - sumuoja skaicius kair¢je,

=(A1+A2) — susumuooja Al ir A2 langeliuose esancius skaicius,

=AVERAGE(2:2) — suskai€iuoja antros eilutés vidurki.

Lenteléje gali biiti iklijuotos ir kitos funkcijos (COUNT, DEFINED, INT ir kt.), taciau
sudétingesnius skaiCiavimus patogiau atlikti su specializuotomis skaic¢iuokliy lenteliy
programomis, pvz., MS Excel.

3.6. MS Word: makrokomandos

Makrokomanda - tai veiksmy ir komandy seka, skirta kokiai nors uzduociai
automatizuoti. Ji turi pavadinima ir gali buti iSkviesta jrankiy juostoje ar klaviSy deriniu.

Makrokomanda atlieckami veiksmai uZraSomi naudojantis komanda Record New Macro.
Makrokomandos paspartina nuoboduy rutinini darba.

MS Word 2003 programoje norint susikurti makrokomanda, pirmiausia reikia pasirinkti
1§ pagrindinio meniu:

1. [rankiai (TOOLS) ->Makrokomandos (Macros) ->[rasyti naujq makrokomandq
(Record New Macro).
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MS Word 2007 programoje:
1. Rodymas (VIEW) -> Makrokomandos (Macros) -> [rasyti naujq makrokomandq
(Record New Macro).

Tada abiejose programose:
2. pavadinti;
3. priskirti greitaji klavisa (Keyboard) ar mygtuka (Button);
4. atlikti operacijas, kurias norite jraSyti;
5. paspausti sustabdymo mygtuka.
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4. SPECIALIEJI LIETUVISKI SRIFTAI

4.1. Paskirtis, 1vairove, idiegimas

Kompiuterinis Sriftas sujungia tris komponentus:

e GRAFEMA (raSto Zenklo turinys (pvz., A));

e GRAFINI VAIZDA (pvz., AAA AR A);

e KODA (Zenklo skaitini identifikatoriy (pvz., A — 0041 Unicode)).

Nors lietuviSskus raSmenis dabar jau tinkamai perteikia daugelis Srifty, taciau jeigu
vartotojas nori naudoti specialius kirCiavimo simbolius, raSyti senoviniais baltiSkais
raSmenimis ar naudoti grazius bei estetiSkai suderintus raSmenis, jis turéty pasirinkti vieng i3
specialiyjy lietuviSsky Srifty. RuoSiant §ia metoding priemong, buvo Zinomi keturi specialieji
Sriftai:

o TimeLT Accented — seniau naudotas Sriftas tekstams kir¢iuoti;

e Aistika — mokamas Sriftas, lietuviSkiems ir rusiSkiems kiréiuotiems tekstams
(http://www.fotonija.lt/);

e Palemonas — nemokamas Sriftas, lietuviSkiems kirCiuotiems tekstams ir specialiems
senyjy raSty simboliams (http://www.vIkk.It/);

e Vytis — nemokamas Sriftas, pirmiausiai skirtas atvirojo kodo OpenOffice programai,
bet tinka ir kitoms (ftp://ftp.akl.1t/sriftai/Vytis/Naujas Vytis/).

Parsisiystus specialiuosius Sriftus reikia idiegti savo operacingje sistemoje, tada jie bus
prieinami visoms Sriftus naudojancioms programoms. Tai galima padaryti Valdymo skydelyje
(Control Panel) pasirinkus kataloga §riftai (Fonts) ir tada pasirinkus komanda Instaliuoti
naujq Sriftq (Install New Font).

4.2. Palemonas

Sis $riftas skirtas lietuviskoms kiréiuotoms raidéms pavaizduoti. Be to, juo galima
pavaizduoti senovinius baltiSkus simbolius.
Sriftu siekiama spresti ir estetines problemas:
e nosiniy raidZiy sandiira su kableliu ir kitomis raidémis;
e kirCiy sandiira su diakritikais;
e daZniausiy lietuviy kalboje raidZiy grandinéliy estetini atvaizdavima (pvz.: gyv,
ios, isk, pas, sis, uma, uva);
e norima, kad maZziau kenkty regéjimui.
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5. MICROSOFT EXCEL

MS Excel yra skaicCiuoklé¢ lentele, kuri skirta:

duomenims jrasyti,

skai¢iavimams atlikti,

duomenims riiSiuoti,

filtruoti,

grafikams ar diagramoms sudaryti,

apibendrinti,
analizuoti.

Kompiuterio technines galimybes ir idiegta Windows operacings sistemos versija lemia,
kuri Microsoft Excel programos versija yra idiegta vartotojo kompiuteryje. Sioje metodinéje
priemongje trumpai aptarsime naudingas Excel 2003 ir Excel 2007 programy galimybes.

5.1. Darbas su duomenimis

5.1.1. Duomeny formatai

IraSomy duomeny formatus MS Excel programa atpaZzista automatiskai, t. y. jeigu
raSysite teksta, duomenims bus priskirtas teksto tipas, jeigu raSysite skaiCiy — skaiciaus. Jei
néra kity nustatymuy, MS Excel programa teksta lygiuoja kairéje, o skaiCius deSin¢je. Neretai
pasitaiko, kad automatinis duomeny priskyrimas yra ne toks, kokio reikia vartotojui, tada
vartotojas gali pats nustatyti eilutés, stulpelio ar langelio teksto formata.

A=

Format Cells
Mumber |.G.Jigr1n1ent| Font | Border | Fill |Pmtecﬁun
Category:
General - Sample
Mumber
Currency
Accounting 3 ; “
Date Dedmal places: |2 =
Time [ use 1000 Separator ()
Percentage
Fraction Megative numbera:
S e -
T 1234,10
faty -1234,10
it -1234,10

for monetary value.

Mumber is used for general display of numbers. Currency and Accounting offer spedialized formatting

[ QK J [ Cancel

26 paveikslas. Duomeny formato nustatymo langas
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Jei raSydamas skaiCius vartotojas nori, kad jie biity interpretuojami kaip tekstas, tai pries
pradédamas raSyti turi jraSyti apostrofo simbolj . Reikia atsiminti, kad Skaiciai jrasyti kaip
tekstas (Numbers stored as text) negali biiti naudojami skai¢iuojant.

Vartotojas gali susikurti ir savo formata (Custom), kuri pasirinkus ira§yti duomenys bus
interpretuojami pagal susikurta Sablona.

Norint pakeisti duomeny formata, reikia pasirinkti pagrindiniame meniu Formatavimas
(Format) -> Formatuoti langelius (Format cells) (Zr. 26 paveiksla). Atsidariusiame langelyje
reikia pasirinkti tinkama formata. Kai taip nustatysite duomeny formata langeliui (ar
langeliams), tai visi ten jraSomi duomenys bus interpretuojami pagal formato nustatymus.

5.1.2. Vienody duomeny jrasymas

MS Excel programa yra gerai pritaikyta jraSyti pasikartojanc¢ius duomenis arba duomeny
sekas.

Kopijavimas

DeSinysis apatinis paZyméto langelio ar lango kampas turi maza kvadratéli, ant kurio
perkélus pelg, pelés Zymeklis pavirsta i kryZiuka. Spusteléjus §i kvadratélj, reikia ji tempti
tiek, kiek jums reikia, ir taip nukopijuoti langelyje esan¢ius duomenis.

13! +

Pelés judejimo kryptis |13 ]

Atlikus §i veiksma, pasirodys irankio ikona, su kuria galite pakoreguoti nukopijuotus
duomenis (Zr. 27 paveiksla).

| 13 13 13 13
=i
(x| Copy Cells
0 Fill 5eries
' Fill Formatting Only
' Fill Withgut Formatting

27 paveikslas. Duomeny uZpildymo jrankis

Jei pasirinksite UZpildymo seka (Fill Serries), tai nukopijuoty skaiCiy eiluté pavirs i seka
(13, 14, 15, 16). Jei pasirinksite Tik formatavimo uZpildymas (Fill Formatting Only), tai
pirmojo langelio formatavimo pasirinktys bus pritaikytos ir kitiems langeliams, taCiau patys
kity langeliy duomenys nebus pakeisti. Jei pasirinksite Uzpildyti be formatavimo (Fill Without
Formatting), tai bus nukopijuoti tik duomenys, bet nenukopijuotas langeliy formatavimas.

Langeliy duomenis galite nukopijuoti ir naudodami Uzpildas (Fill) komandg i§ meniu.
Tada reikia kartu su jraSytais pradiniais duomenimis pazyméti langeliy plota, { kuriuos norite
nukopijuoti pradinius duomenis, ir pasirinkti kopijavimo krypti (Zemyn, Desiné, Aukstyn,
Kairen).

Vienodus duomenis i daugeli langeliy galima itraukti dar vienu biidu: reikia pazyméti
langelius, { kuriuos norite jraSyti vienodus duomenis, jrasyti tuos duomenis ir paspausti
Ctrl+Enter. Jei norite pazymeti ne Salia esanCius langelius, juos Zymédami naudokite Ctrl
klavisa.
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5.1.3. Duomeny seky jrasymas

MS Excel programa leidZia vartotojui greitai ir patogiai irasSyti sekas, kurios did¢ja arba
mazeja pagal tam tikra taisyklg. PaprasCiausia ir populiariausia seka yra didé¢janti skai¢iumi 1
(pvz., 1, 2, 3, 4). Tokiai sekai paraSyti pakanka paraSyti skaiCius 1 ir 2, juos paZymeéti ir
~paémus‘ uz kryziuko tempti Siq seka tiek, kiek jums reikia. Kitas biidas — iraSyti tik viena
pradini skaiCiy, nutempti uz kryZiuko ir pasirodZiusiame irankyje pazyméti Uzpildymo seka
(Fill series) (Zr. 27 paveiksla).

Jeigu jraSysime O ir 2, tai seka didés kas du skaicius: 0, 2, 4, 6, 8.

Pasirinkus komanda UZpildas (Fill) -> Sekos (Series), galima pasirinkti ir kitus sekos
uzpildymo biidus atsizZvelgiant { augimo pobitidi ar duomeny tipa (Zr. 28 paveiksla).

& -
Series li'ihj
Series in Type Date unit
Rows Linear Day
@ Columns @ Growth Veekday
Date Manth
ALItDEI" ed
3
Trend
Step value: |3 Stop value: | 100] 27
a1
Ok ] | Cancel |
b

28 paveikslas. Seky uzpildymo langelis

Cia galima pasirinkti:

Sekos kryptj — stulpelyje (Columns) arba eilutéje (Rows).

Linijinj (Linear) augimo buda, t. y. seka did¢ja vis pridedant tarpine verte (Step value),
kurig vartotojas gali pats pasirinkti. Reikia nurodyti ir sekos galuting reikSmg.

Augimo (Growth) buda — seka didé¢ja padauginus i§ tarpinés vertés (Step value).
Pavyzdziui, remiantis 28 paveikslo nustatymais, seka yra 1, 3, 9, 27, 81.

Jei sekos duomenys yra data (Date), vartotojui dar reikia pasirinkti, kuris datos
komponentas turi kisti: diena, savaités diena, ménuo ar metai.

5.1.4. Automatiniai ir pasirinktiniai sqrasai tekstinei informacijai jrasyti

Jeigu vartotojas rinks teksting informacija stulpeliu Zemyn ir pradés raSyti Zodi, kuris jau
buvo surinktas virSutiniame langelyje, tai programa pasitlys to ZodZio pabaiga. Paspaudgs
Enter klaviSa vartotojas priims sitiloma ZodZio pabaiga.

Be to, raSydamas teksting informacija stulpeliu Zemyn, vartotojas gali pasinaudoti
automatiSkai sudaromy saraSy funkcija. Automatinis saraSas sudaromas i§ visy virSuje jau
panaudoty tekstiniy iraSy. Esant tus¢iame langelyje reikia paspausti deSiniji pelés klavisa ir
pasirinkti komanda Pasirinkti is sqraso (Pick from Drop Down List): 1§ atsidariusio saraso bus
galima iSsirinkti reikiama teksting informacija (Zr. 29 paveiksla).
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Eglé Eglaite
Juozas luozaitis
Rasa Rasaitiené
Antanas Antanaitis

Rasa Rasaitiens

29 paveikslas. AutomatiSkai sudaryto saraSo naudojimas

Taip pat MS Excel programoje yra galimybé naudotis tekstinés informacijos
pasirinktinius saraSus (Custom lists), kuriuos naudodamas vartotojas gali greitai ir patogiai
irasyti tekstiniy seky duomenis.

Siuos sarasus galima rasti:

MS Word 2003 programos versijoje pagrindiniame meniu pasirinkus [rankiai (Tools) ->
Pasirinktys (Options) -> Pasirinktiniai sqrasai (Custom Lists).

MS Word 2007 programos versijoje reikia spustelti biuro mygtuka (Office button), tada
Excel pasirinktys (Excel Options) -> Populiariis (Popular) -> Redaguoti pasirinktinius
sqrasus (Edit Custom Lists).

Atsidarys langas, kuriame matysis tuo metu programoje itraukti pasirinktiniai sarasai
(zr. 30 paveiksla). Idiegus programa vartotojas gali naudoti standartinius pasirinktinius
saraSus: angliSky ir lietuviSky savaités dieny, ménesiy pavadinimy, sutrumpintos ir ilgosios
formos sarasus.

Custom Lists Iilﬁ
Custom Lists

Custom lists; List entries:

MNEW LIST *
Mon, Tue, Wed, Thu, Fri, Sat, 5
Monday, Tuesday, Wednesday,
Jan, Feb, Mar, &pr, May, Jun, 1
January, February, March, April
Pr, An, Tr, Kt, Pn, 5t, 5k
Pirmadienis, Antradienis, Tredac

Sau, Vas, Kov, Bal, Gea, Bir, Lie

Press Enter to separate list entries,
Import list from cells: B Import

e

30 paveikslas. Pasirinktiniy sarasy langas

Norédamas pasinaudoti standartiniais pasirinktiniais sarasais, vartotojas turi irasyti bet
kuri viena elementa i§ to saraso ir tempti uZz deSiniajame apatiniame langelio kampe
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atsiradusio kryZiuko. PavyzdZiui, jei vartotojas paraS¢ vasaris, tai patempus kryZiuka norima
kryptimi iSsirikiuos kity ménesiy pavadinimai.

|vasaris kovas balandis geguie birelis liepa rugpjitis rugsejis spalis lapkritis gruodis sausis vasaris kovas balandis |

Norédamas susikurti savo saraSa, vartotojas gali deSiniajame langelyje suraSyti ZodZius
po kiekvieno ZodZio paspausdamas Enter. Baigus raSyti saraSa reikia paspausti Prideéti (Add)
mygtuka. Savo sukurtuosius sarasus vartotojas gali redaguoti ir trinti kada panor¢jgs.

I pasirinktini sarasa vartotojas gali jtraukti ir duomenis i$ jau esanciy lenteléje duomeny.
Tam skirtas laukelis Importuoti (Import). Reikia:

- pasirinkti ikona laukelio deSin¢je pus¢je, tada atsiras langas Pasirinktiniai sqrasai
(Custom Lists) (Zr. 31 paveiksla),

- pasizyméti elementus, kuriuos norite irasyti kaip automatini sarasa,

- paspausti ikong deSin¢je langelio pusé¢je,

- paspausti mygtuka Importuoti (Import).

Customn Lists

| §B$3:5153

31 paveikslas. Pasirinktiniy saraSy jtraukimas i$ lentelés

5.2. Skai¢iavimas

Formulés gali buiti iraSomos tiek formuliy lange, tiek ir lentelés langelyje, taciau
matomos tik formuliy lange, o lenteléje matomas tik skaiiavimo rezultatas. Visos formulés
prasideda lygybés Zenklu (=).

Cin
i
Home Insert Page Layout Formulas
7 . Wt :
B db Cu Calibri -1 - A
Past o S [Formulin lan Sy
aste ormuliiu as ko | -
i # Format Painter Hang gl '
Clipboard F]
D3 -
A B C F

N | k|
D
| ] ¥

32 paveikslas. Skaifiavimo pavyzdys
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5.2.1. Formuliy elementai

Formulése gali biti naudojami 7 rusiy elementai:

1. Aritmetiniai operatoriai 2. Lyginimo operatoriai
+ sumavimas = lygybe
- atimtis > daugiau nei
/ dalyba < maziau nei
* daugyba >=  daugiau arba lygu
%  procentas <= maZziau arba lygu
A kélimas laipsniu <> nelygu

3. Tekstinis operatorius
&  sujungia du teksto vienetus i viena.

4. Nuorody operatoriai
: rodo sritj (,,nuo iKi*)
, 3 [/ (priklausomai nuo nustatymy) atskiria atskirus elementus, funkcijos
argumentuose. Pvz., =SUM(A1;A2;A3)
- minuso Zenklas, skaifiaus neigiamumui.

5. Funkcijos

Funkcijos — i§ anksto sudarytos formulés. Kiekviena funkcija turi pavadinima, o jos
argumentai yra skliaustuose - =SUM(A1;B5;C6).

Funkcija galima jraSyti paprastai arba iSsirinkti specialiame funkcijy jterpimo lange.
Kairéje puséje Salia formuliy lango yra funkciju mygtukas fx, kuri spusteléjus atsidaro
funkcijuy iterpimo langas, leidZiantis vartotojui iSsirinkti neseniai naudotas, visas arba tam
tikros rusies funkcijas (finansines (Financial), datos ir laiko (Date & Time), statistines
(Statistical) ir kt., Zr. 33 paveiksla).

Insert Function @lﬁ

Search for a function:
Type a brief description of what you want to do and then dick
Go
Or select a cateqory: | Most Recently Used -

Most Recently Used -

Select a function:

TRIM
AVERAGE
EDATE

DAYS 350 Lookup & Reference
DATE Databasze
SLM Text
Loaqical o
SUBSTITUTE(text;g Information
Replaces existing texfEngineering i
Help on this function Ok, ] [ Cancel

e

33 paveikslas. Funkcijy jterpimo langas
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ISsirinkus funkcija atsidaro funkcijy argumenty langas, kuriame vartotojas gali irasyti
funkcijos argumentus Skaicius 1, Skaicius 2 (Number I, Number 2 ir t. t.), gali matyti
funkcijos rezultata (=9) ir funkcijos paaiskinima.

SUM v (0 % o |[f| =sum(e1:82)
A B o — D | E | F | G | H | 1 | 1
1 2 Function Arguments |M
2 5
3 |=SUM{I31:I32}‘| 5UM
4 Numberl = {%5}
3 Mumber2 @ =
7]
7
8
9
10 =9
1 Adds all the numbers in a range of cells,
12 Mumberl: numberl;number2;... are 1to 255 numbers to sum. Logical values and text
13 are ignored in cells, induded if typed as arguments.
14
15 Formula result = 9
16
17 Help on this function CK l | Cancel

34 paveikslas. Funkcijos argumenty jraSymo langas

6. Langeliy adresai

Santykiniai (pagal nutyl¢jima) — keiCiantis formulés jraSymo vietai, kopijuojant
formulg atitinkamai kei€iasi ir langeliy adresai. Pvz.: Al, B1, A1:A6.

Absoliutiis (pasirenkami vartotojo) — keiciantis formulés jraSymo vietai, langeliy
adresai nesikei¢ia. Pvz.: $AS$1, $B$1, SA$1:$A%6.

Misriis (pasirenkami vartotojo) — keiciantis formulés jraSymo vietai keiciasi vienas i
adreso komponenty, o kitas nesikei¢ia. Pvz.: $A1, $A2, A$1, A$2.

I formules galima iraSyti ir sri¢iy vardus (antrastinés lentelés eilutés ZodZius), pvz.,
SUM(Bendra kaina).

7. Konstantos ar skaiciai
2,5, 1000
Konstantos ar skaiciai, keiCiantis formulés iraSymo vietai, nesikei¢ia. Pvz.: =A1%3,4528.

5.2.2. Formuliy tikrinimas

Ne visada yra aiSku, ka kuri formulé skai¢iuoja ir i§ kur ima duomenis. Paprasc¢iausias
biidas patikrinti formulg — paZymeéti langelj, kuriame yra formul¢, ir su pele perkelti Zymeklj {
formulés langa. Tada visi formuléje esantys langeliy adresai ir juos atitinkanciy langeliy
rémeliai nusidaZys vienodomis spalvomis (Zr. 35 paveiksla).
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SUM * (3 %  f| =Cp7+C28+C38

A B C D
25
26 Parduotas kiekis Ziema parduotas kiekis
27 sausis 245| =C27+C28+C38
28 vasaris 26?1
29 kovas 256
30 balandis 300
31 geguié 320
32 birielis 280
33 liepa 278
34 rugpjotis 240
35 rugséjis 235
36 spalis 222
37 lapkritis 180
38 gruodis I 1121
a9

35 paveikslas. Formuliy tikrinimas

Be to, MS Excel programoje yra specialiis irankiai, skirti formulei tikrinti (Formula
Auditing).

MS Excel 2003 programos versijoje Siuos irankius galima rasti pagrindiniame meniu
pasirinkus [rankiai (Tools) -> Formuliy tikrinimas (Formula Auditing).

MS Excel 2007 programos versijoje reikéty pagrindiniame meniu pasirinkti Formulés
(Formulas), kur ir galima pasirinkti reikalinga iranki (Zr. 36 paveiksla).

T Trace Precedents  13§] Show Formulas =
I='§'.fTrar:E Dependents ‘@) Error Checking ~ 'Jd
Watch

[ REmove Arrows ~ .& Evaluate Formula | window
Formula Auditing
36 paveikslas. MS Word 2007 programos formulés tikrinimo (Formula auditing) jrankiai

Formuliy tikrinimo jrankiai atlieka $ias funkcijas:
Aptikti precedentus (Trace Precedents) — rodyklémis parodo, i§ kur duomenys
»atkeliauja 1 formule* (Zr. 37 paveiksla).
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- fu | =Ca7+co8+C38

B C D

Parduotas kiekis Ziemga parduotas kiekis
624

sausis

vasaris
kovas
balandis
geguié
birielis
liepa
rugpjatis
rugséjis
spalis
lapkritis
gruodis

37 paveikslas. Formuliy tikrinimas naudojant jranki aptikti precedentus (Trace Precedents)
Priklausomybiy aptikimas (Trace Dependents) — §is irankis rodyklémis parodo, kuriai
formulei priklauso paZymétasis skaicius.

Parductas kiekis Ziemg parductas kiekis

sausis 2%’* 624
vasaris — 2671

kovas 236
halandic 1]

38 paveikslas. Formuliy tikrinimas naudojant jrankj priklausomybiy aptikimas (Trace Dependents)

Salinti visas rodykles (Remove Arrows) — §is irankis paSalina tikrinimo jrankiy nubréZtas
rodykles.

Rodyti formules (Show Formulas) — S§is irankis visame darbo lauke vietoj rezultaty
parodo formules.

Rasti klaidas (Error Checking) — Sis irankis parodo vartotojui formulg, kurioje yra
klaida ir nurodo klaidos tipa.

Ivertinti formule (Evaluate formula) — $is irankis leidZia vartotojui pamatyti, kas slepiasi
po kiekvienu formulés elementu ir kokia seka atliekami skaiciavimai.

Rodyti perivalgos langq (Watch window) — $is irankis leidZia vartotojui specialiame
lange stebéti daugelio formuliy rezultatus i§ ivairiy viety — darbo lapuose, langeliuose ar
darbo knygose.

5.3. Rasiavimas ir filtravimas

5.3.1. Lentelé — duomeny bazé

Struktiirizuoti lentelés duomenys MS Excel programoje interpretuojami kaip duomeny
bazé, kuri susideda iS irasy, lauky ir lauky pavadinimy (Zr. 39 paveiksla).
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A B & D

1 MedZiaga R0sis vnt. Kaina Kiekis p:ﬁﬁﬁmas
2 |Sviestuvas elektr. Pr 300

3 Sofao baldas 1300 1 Laukas
4 | Kilimas baldas 200 2

5 Kédes baldas 500 1

6 Jungiklioi elektr. Pr 15 25

Trasai

39 paveikslas. Duomeny sarasas — duomeny bazé

Tiesa, norint, kad duomenys biity tinkamai interpretuojami ir kad nebitity netikétumy
juos apdorojant, reikéty laikytis keleto reikalavimy:

e viename darbo lauke (Sheet) turi biti tik vienas sarasas,

e neturi biti tusCiy eiluciy arba stulpeliy,

e viename stulpelyje turi biiti tik vieno tipo duomenys (tekstas, skai€iai, datos),

e stulpeliai turi turéti antrastes.

Tinkamai sutvarkytus duomenis yra paprasta ir lengva riiSiuoti bei filtruoti.

5.3.2. Ruasiavimas

PaprasCiausiai riiSiuojant teksting ir skaitmening informacija, patogiausia naudoti
rusiavimo mygtukus, kuriuos galima rasti irankiy juostoje:

A z
2 I R
- rusiuoja didéjancia tvarka - rusiuoja mazéjancia tvarka

Sie mygtukai veikia tik vertikalia kryptimi, t. y. rii§iuoja pagal to stulpelio, kuriame tuo
metu biina paZymeétas langelis, duomenis.

MS Word 2007 programos versijoje Siuos mygtukus galima rasti pagrindiniame meniu
pasirinkus Duomenys (Data) arba pradingje irankiy juostoje Pradinis (Home), pasirinkus
mygtuka Risiuoti ir Filtruoti (Sort & Filter).

¥ AutoSum ~ .‘i? ja
Zl ||

#] Fill -
. Sort & | Find &
./ Clear - Filter ~ |Select =

‘El Sort 5mallest to Largest
il Sort Largest to Smallest
EI Custom Sart...

= Filter

40 paveikslas. MS Word 2007 programos versijos risiavimo ir filtravimo komandos pasirinkimas

Rusiuojant reikéty vadovautis Siais patarimais:

- Jei reikia sur@iSiuoti vieno stulpelio duomenis, neatsizvelgiant i kitus duomenis (t. y.
kiti duomenys lieka savo vietose), tuos duomenis reikia paZymeéti ir atsidarius persp€jimo
langui pasirinkti Testi dabartini pasirinkimq (Continue with the current selection) (Zr. 41
paveiksla).
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Sort Warning Iilﬁ

Microsoft Office Excel found data next to your selection. Since you have not
selected this data, it will not be sorted.

What do you want to do?

(7 Continue with the current selection

Sort ] [ Cancel

41 paveikslas. Rusiavimo perspéjimo langas

- Reikéty atkreipti démesj, ar riiSiuojama antrastiné eiluté, kurios paprastai nereikia
rusiuoti. Jei ji riiSiuojama, reikéty paZymeéti duomenis be Sios eilutés arba pasirinkti komanda
Riisiuoti (Sort), kur galima pasirinkti atitinkamus nustatymus.

Norint rusiuoti pagal kelis kriterijus, reikéty:

MS Word 2003 programos versijoje pagrindiniame meniu pasirinkti Duomenys (Data)
-> Rusiuoti (Sort). Tada atsidarys langas, kuriame galima nustatyti iki 3 raSiavimo kriterijy;

MS Word 2007 programos versijoje paspausti Risiuoti ir Filtruoti (Sort & Filter)
mygtuka ir pasirinkti Pasirinktinis risiavimas (Custom sort) komanda (Zr. 40 paveiksla), arba
pagrindiniame meniu pasirinkti Duomenys (Data) ir pasirinkti Risiuoti (Sort) mygtuka:

[ —|

2|5

Sort

Tada atsidarys Riisiavimo (Sort) langas, kuriame galima:

Sort P [
Options... My data has headers

Colurmn Sort On Crder
Sortby  |pisis E Values E AtoZ E
Then by E Values E AtoZ E

MedZiaga
Risis

Vnt. Kaina
Kickis
Bendra kaina

| Add Level ] ’ * Delete Level l ’ =23 Copy Level ]

[ oK ] [ Cancel ]

e

42 paveikslas. MS Word 2007 programos versijos riiSiavimo langas

o Prideti lygj (Add Level) — Siuo mygtuku galima pridéti iki 64 rasSiavimo kriterijy.

o Trinti lygi (Delete Level) — Siuo mygtuku galima trinti nereikalingus riiSiavimo
kriterijus.

e Kopijuoti lygi (Copy Level) — $iuo mygtuku galima kopijuoti ankstesnio
kriterijaus nustatymus.

e Rodyklémis galima sukeisti ruSiavimo kriterijy tvarka.
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e Mano duomenys turi antrastes (My date has headers) — §iuo mygtuku nustatome,
ar duomenys turi antraStes ar jy neturi.

e Pasirinktys (Options) — €ia galima nustatyti, kad rii§iuojant biity skiriama a, b, ¢
nuo A, B, C (Case sensitive), ir risiavimo Kkrypti (galima rusiuoti eilutes — is
kaires | desine (Sort left to right)).

Sort Options Li'ﬂ_hj

...................................

Orientation

@ Sort top to bottom
Sort left to right

Ok ] | Cancel

5.3.3. Filtravimas

Filtravimas — tai iraSy atranka pagal tam tikrus kriterijus. [raSai, kurie netenkina
kriterijy, paslepiami.

MS Word 2003 programos versijoje pagrindiniame meniu reikia pasirinkti Duomenys
(Data)-> Filtruoti (Filter) -> Automatinis Filtravimas (AutoFilter) (Zr. 43 paveiksla).

A B | C | D E
1 |MedZiaga~|RGSis |- |V¥nt. Kaina - |Kiekis ~|Bendra kaina -
2 |Sofa E?.I_-I.) T 1300 1 1300
3 |Kedes Sustom.. ) 500 12 OO0
4 |Sriesiuras |baldas 300 5 1500
§ |Kilimas 200 2 400
B |JSuncikiiai  elektr Pr 15 25 375

43 paveikslas. Word 2003 programos versijos filtravimo langas ir rezultatas

MS Word 2007 programos versijoje filtruojamoje duomeny lenteléje pagrindiniame
meniu Pradinis (Home) reikia pasirinkti mygtuka Risiuoti ir Filtruoti (Sort & Filter) arba
pagrindiniame meniu pasirinkti Duomenys (Data) ir pasirinkti mygtuka Filtruoti (Filter).

A I?
70

Sort & Filter
Filter =

Tada atsidarys langas, kuriame bus galima pasirinkti pageidaujamus kriterijus (Zr. 44
paveiksla).

Filtravimo komandos grafinis iSpildymas naujesnéje MS Word programos versijoje kiek
skiriasi nuo MS Word 2003 programos versijos, taciau visos pagrindinés filtravimo funkcijos
yra tos pacios. Laukams, kuriuose yra tekstiné¢ informacija, taikytini teksto vienodumo
kriterijai (pvz., pasirinkus tekstini kriterijy elektr. pr galima iSrinkti visas elektros prekes);
laukams, kuriuose yra skaitmeniné informacija, galima taikyti skaitmeninius kriterijus (10
daZniausiy, ne daZznesni uz 10 ir kt.).
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A B " D E

1 Mediiaga E| Risis Vnt. Kaina E| Kiekis E Bendra kaina E|
2 |4) sortatoz 1300 1 1300
3 |4} sortztoa 500 12 6000
4 5ort by Color 4 200 2 400
5 & ! 300 5 1500
& , 15 25 375
7

3 Texut Filters 4

9 -] (Select All)
o) | [
11
12
13
14
15
16
17
18 [ OK ] [ Cancel
14

A B C E

1 Mediiaga = | Risis 7 Vnt. Kaina E| Kiekis E| Bendra kaina E|
5 |Sviestuvas elektr. Pr 300 5 1500

6 | Jungikliai elektr. Pr 15 25 375

44 paveikslas. Word 2007 programos versijos filtravimo langas ir rezultatas

5.4. Grafikai ir diagramos

Nors yra nemaza jvairové diagramy tipy, taciau galima skirti tris pagrindinius diagramy
tipus. Ty tipu diagramos gali biiti jvairiai modifikuojamos.

1. Stulpelinés ir kiigio diagramos geriausiai tinka diskretiesiems duomenims>>.

1400

1200

1000

800

600
400
200

| HHH .

Kédes

Sofa Kilimas  Sviestuvas Jungikliai

45 paveikslas. Stulpelinés diagramos pavyzdys

3% Diskretieji duomenys — tai duomenys sudaryti i§ skirtingy elementy arba i§ dydZiy turinéiy aiSkiai skiriamas
reikSmes (pvz., litai ir centai, vienetai, metai ir pan.)
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2. Plokstieji ar linijiniai grafikai geriausiai tinka norint parodyti dydzio kitima, pvz., laike.

350 -

300 A

250 -

200 \

150 \

100
50
0 T T T T T T T T T
5 5 o ) e "5 > Lo D o ) O
o & 2 o o NS PSS N N X B
2> A @ & o @ 2 N
o [3) & N o N & Es) s o
P K F T K&

46 paveikslas. Linijinio grafiko pavyzdys

3. Skritulinés ir Ziedinés diagramos geriausiai tinka procentiniam reik§miy pasiskirstymui
pavaizduoti.

Jungikliai

47 paveikslas. Skritulinés diagramos pavyzdys

Norint susikurti diagramg, pirmiausia reikia pasiZyméti duomenis, kurie turéty biti
pavaizduoti diagramoje. Jei norite pazyméti ne Salia esanCius duomenis, prie§ paZymedami
nuspauskite Ctrl mygtuka.

MS Excel 2003 programos versijoje pagrindiniame meniu reikia pasirinkti [terpimas
(Insert) -> Diagrama (Chart) arba jrankiy juostoje paspausti mygtuka:

i

Tada atsidaro Diagramos vedlys (Chart Wizard), kuriame ivairiis diagramos nustatymai
pasirenkami 4 diagramos kiirimo etapais (veiksmais (steps)).

1 etapas. Siame etape reikia pasirinkti diagramos tipa.

2 etapas. Siame etape galima patikslinti duomeny sritj, kurios pagrindu yra kuriame
diagrama.
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3 etapas. Siame etape pasirinkus atitinkamas korteles, galima nurodyti diagramos
pavadinima (Chart title), diagramos aSiy pavadinima (Category x/y axis), diagramos aSiy
rodyma, suskirstyma i tinklelius (Gridlines), duomenuy rodyma (Legend), duomeny etikeciy
rodyma (Data labels) ir duomeny lentelg (Data Table).

4 etapas. Siame etape reikia nurodyti, kur ikelti sukurta diagrama: kaip atskira darbo
lapa (As new sheet) arba kaip objekta tame paciame darbo lauke (As object in).

Jau sukurtos diagramos 4 etapy parinktys gali biti redaguojamos pasirinkus
pagrindiniame meniu punkta Diagrama (Chart) ir atitinkamus veiksmus: Diagramos tipq
(Chart type), Diagramos Saltinio duomenys (Source Data), Diagramos parinktys (Chart
options) arba Vieta (Location).

Grafinius diagramos poZymius galima keisti du kartus paspaudus atitinkama diagramos
dali arba pazyméjus redaguoting diagramos dali ir pasirinkus Formatavimas (Format) ir
atitinkama punkta.

Naujesnéje MS Word 2007 programos versijoje diagramy kiirimas labai pasikeité. Cia
diagrama paZymétiems duomenims galima sukurti dviem pelés paspaudimais.

MS Excel 2007 programos versijoje pagrindiniame meniu reikia iSsirinkti [terpimas
(Insert) ir pagrindiniame meniu iSsirinkti vieng i§ 7 diagramy tipy:

4 4

il Syl ) Q@

Column  Line Pie Bar Area Scatter Other Hyperlink Text Header WordArt Signature

|1|II||; -

- b - - b Gt Charts = Box & Footer T Line =
Charts IF] Lirks Teut

Insert Chart E.E
[ Templates Column B
e | [a] |28 g e8] 83 30
|ﬁ Line | | | | | | | E
& Fie ' ' ] ] ' .ﬂ ' & '

= o |J4_ﬂl_ti |J-@B' |m Hﬁlji |Jfﬂ._ﬂ |L€r:'_b— |l§r§.ﬂr E
by Area ) : : . .

e || L] a5 18]

i Sk |’-”¥}~' ] a3 B

)  Surface — . . . . . . .

@ Doughnut ‘/“v'f I/“ 7 I/ﬂ““ / l;':-:-:': L,.; L:;.;; P A‘

% Bubble | ] =] |¥ e |2 |JLT

#y  Radar Pie

|':\-9 l@a l@iﬂ:' l@ | v l@IB

[HanageTemplates... ] [ Set as Default Chart ] [ K. ] [ Cancel

48 paveikslas. Diagramy tipy pasirinkimo langas

Tada visos kitos parinktys bus automatiSkai nustatytos pacios programos ir vartotojui
bus nupieSta diagrama. Sias parinktis galima pakeisti pagrindinéje irankiy juostoje
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atsidariusivose trijuose interaktyviuose meniu punktuose — dizaino (design), isdéstymo
(layout), formatavimo (format), kuriuose vartotojas, jei reikia, gali pakeisti automatiSkai
nustatytas parinktis. IS karto diagramoje matyti pasikeitimai, susij¢ su pasirinktomis
ypatybémis.
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6. MICROSOFT POWERPOINT

Microsoft PowerPoint programa skirta pristatymams rengti tiek projektuojant vaizda
ekrane ant sienos, tiek ir kompiuterio ekrane. Programa yra tinkama baigiamiesiems darbams
pristatyti.

Kompiuterio techninés galimybés ir idiegta Windows operacinés sistemos versija lemia,
kuri Microsoft PowerPoint programos versija idiegta vartotojo kompiuteryje. Sioje
metodin¢je priemonéje trumpai aptarsime svarbiausias MS PowerPoint 2003 i MS
PowerPoint 2007 programy galimybes.

6.1. Rodymo reZimai

Atsizvelgdamas | atliekama uZduoti, vartotojas su MS PowerPoint programa gali dirbti
7 rezimais. ReZimus galima pakeisti pasirinkus pagrindinio meniu punkta View.

(=)
_?/ Home Insert Design Animatians Slide Showe Review Wiy Developer
0 __I';: = E 7| Ruler Q Fez |. Color
=l . Gridlines : —— | g Grayscale
{Mormal| slide  Motes  ilide ilide Handout Motes _ foom Fitto )
Sorter Page Show | Master Master Master Message Bat WWindow | mm Pure Black and White
Presentation “Wiews ShowvefHide Zoom Color/Grayscale

Pagrindinius tris reZimus (skaidriy redagavimo, skaidriy rikiavimo ir skaidriy

demonstravimo) taip pat galima rasti ir programos lango apacioje:

EEE

Darbo rezimai yra Sie:

e Paprastas (Normal) — tai pagrindinis programos rodymo reZimas, skirtas
pristatymui parengti ir skaidréms redaguoti.

Skaidriy raSiuotuvas (Slide Sorter) — Sis reZzimas leidZia apZvelgti visas
kuriamo pristatymo skaidres, todél patogus norint keisti pristatymo eiga,
iSdéstyma.

Pastaby puslapis (Notes Page) — Sis reZimas skirtas pastaby lapui atidaryti,
kuriame prie skaidriy patogu pridéti pastabas ar papildoma informacija.
VirSutiné pastaby lapo dalis yra matoma ir skaidriy redagavimo reZime.

Skaidriy demonstravimas (Slide Show) — S§is reZimas skirtas parengtam
pristatymui demonstruoti. Jo metu visa ekrano ploti uzpildo pristatymo
skaidre, t. y. nesimato jokios pristatymui nepriklausangios informacijos. Sis
rezimas gali biiti aktyvuojamas paspaudus klavisa F5.

Skaidriy ruoSinys (Slide Master) — Sio reZimo metu galima pakoreguoti
skaidres informacijos lauky ir dizaino elementy iSsidéstyma.

¢ Ruosiniy instruktorius (Handout Master) — Sio reZimo metu galima
pakoreguoti dalomosios medZiagos i§déstyma.

Pastaby instruktorius (Notes Master) — §io reZimo metu galima pakoreguoti
pastaby lapo medziagos iSdéstyma.

6.2. Skaidriy maketai

Rengiant pristatyma reikéty pasirinkti tinkama skaidriy maketa (Layout). Norint
pakeisti skaidrés maketa:
MS PowerPoint 2003 programoje pagrindiniame meniu reikia pasirinkti:
- Formatavimas (Format) -> Skaidrés maketas (Slide Layout);
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- paslinkite Zymikli ant skaidrés, spragtelkite desinjjj pelés klavisq ir pasirinkite

komandq Skaidrés maketas (Layout).

MS Word 2007 programos versijoje:
- Pasirinkite Pradzia (Home) -> Skaidrés maketas (Layout);

- paslinkite Zymikli ant skaidrés, spragtelkite desinjjj pelés klavisq ir pasirinkite

komandq Skaidrés maketas (Layout).

Pagrindiniai abiejy programos versijy maketai yra Sie (Zr. 49 paveiksla):

-

e Pavadinimo skaidré (Title Slide) — antrastinés skaidrés maketas tinkamas
pristatymo pavadinimui, $is maketas paprastai naudojamas pirmajai pristatymo
skaidrei.

e Pavadinimas ir tekstas (Title and Content) — tai paprastas maketas,
susidedantis i teksto su antraste.

o Skyriaus antrasté (Section Header) — jei pristatymas yra ilgas ir turi atskiras
dalis, tai Sis maketas gali biiti naudojamas tos dalies pavadinimui.

e Pavadinimas ir dviejy stulpeliy tekstas (Two Content) — maketas, leidZiantis
teksta pavaizduoti dviem stulpeliais.

¢ Palyginimo (Comparison) — 2-ju stulpeliy teksto maketas, skirtas lygiagreciai
lyginamiems tekstams.

¢ Tik pavadinimas (Title Only) — maketas, kuriame yra tik skaidrés antraste, jei
norima skaidre pavadinti, o turini pateikti iklijuojant paveiksléli, lentele, teksta
i§ kitos programos arba kuriant savus originalius objektus.

o Tuscia (Blank) — tuscia skaidré; joje galima kurti savo originaly maketa.

o Tekstas su pavadinimu (Content with Caption).

¢ Paveikslélis su pavadinimu (Picture with Caption).

Presentation [Compatibility Mode] - Microsoft PowerPoint non-commereial use -

(o
=i =
‘9 Home | Inset  Desian  Animations  SlideShow  Review  View  Developer ©
=¥ cut Q = Layout - S A.ll,gl Tl e ,:"lmTextDlrectmn Ea O 0-kE <4 shape Fill &4 Find
e == (] i
- 153 Copy B Reset = — [ lign Text AL LGl ¥ [ shape Outline 5 Replace -
Pasts Mew 8 AV AllE== _ Amange Quick
At painter || o el Delete ||| e e & iha)| === T convertto smartart - ||| % VUL AT T T L ciytes - = Shape Effects s select -
Clipboard i Slides Fant Paragraph Drawing Editing
‘H 99
slides { Outline. x 121 11+ 1 100 19t B 1 7 ot 1 5 4t G4 2t L4 Dt Lt 24t 418 b 7o B 8001l 12
o
& | cut
53 Copy
| Paste
1 Mewslide
Duplicate Slide
. .
Click to add titl
|| Publish Slides Office Theme N C O a I e
Check for Updates
=] Layout >
Reset Slide
FormatSadkaround.: Title Slide Title and Content  Section Header
ick to add subtitle
Tuwo Cantent Comparisen Title Only
Tl
e
Click tq Blank Contentwith Picture with
Caption Caption
Slide Lof 1 | *Office Theme® | Lithuanian [Lithu =T R e e

49 paveikslas. Makety pasirinkimas MS PowerPoint 2007 programoje
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6.3. Pristatymo konstravimas

Pasirinkus tinkama maketa, turini galima kurti spragteléjus tekstui skirta lauka ir ten
irasyti teksta arba iklijuoti i$ kitos programos. I§ kity programy i pristatymo skaidre taip pat
galima iklijuoti nuotraukas, paveikslélius, grafikus, lenteles ir kitus objektus.

Atkreiptinas démesys, kad pristatymas skirtas ne tam, kad biity rodomas spausdinti
skirtas tekstas. Pristatymas reikalingas, kad padéty klausytojams sekti Zodini prane§ima, kad
biity galima uzfiksuoti pagrindines praneSimo mintis ir pateikti vaizding informacija. Tod¢l
pristatymo skaidrése tekstas daZznai yra paprastinamas, struktiirizuojamas, paliekant tik

pagrindines mintis (plg. 50 ir 51 pav.).

Kompiuterinis sriftas

Kompiuterinis Sriftas sujungia tris
komponentus:

+ GRAFEMA (rasto Zenklo turinys (pvz., A));

« GRAFIN| VAIZDA (pvz. A A A A A B);

« KODA (Zenklo skaitinj identifikatoriy (pvz.,
A — 0041 Unicode)).

50 paveikslas. Tinkamai sudaryta skaidré — pateikiama esminé informacija su vaizdiniais

pavyzdziais

Kompiuteriniai Sriftai

Kompiuteriniai Sriftai susaisto tris labai esmingus kiekvieno rasto Zenklo
aspektus:

1) rasto Zenklo esme idreiskiandia grafemga (kompiuteriniame 3&rifte jos
paprastai identifikuojamos pagal vienokius ar kitokius principus sudarytais
vardais; grafemos — tai skiriamyjy poZymiy deriniai, leidZiantys atskirti
Zenklus vieng nuo kito, juos atpaZinti);

2) konkrety Zenklo grafinj vaizdg (tai, kaip ekrane ar popieriuje
pavaizduotas Zenklas atrodo Zmogaus akims);

3) Zenklo skaitinj identifikatoriy, daZniausiai vadinama tiesiog Zenklo
kodu.

Kompiuterinei rastijai visy svarbiausi du pastarieji aspektai — Zenkly kodai
ir ju grafiniai vaizdai: kompiuterinés sistemos viduje tekstas egzistuoja tik
skaitiniu pavidalu, t. y. jj sudarantys rasto Zenklai dia reprezentuojami jy
kodais, o idvesties jrenginiais perkeliant teksta | misy, Zmoniy, aplinka,
kodai pakei€iami juos atitinkandiais grafiniais vaizdais.

51

paveikslas. Netinkamai sudaryta skaidré - pateikiama pernelyg daug tekstinés

informacijos
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6.4. Skaidriy dizainas

Norédami savo pristatymui suteikti tam tikra stiliy, galite naudotis programoje
sukurtais dizaino sprendimais:
MS PowerPoint 2003 programoje pagrindiniame meniu reikia pasirinkti:
Formatavimas (Format) -> Skaidrés dizainas (Slide Design)
MS Word 2007 programos versijoje pagrindiniame meniu reikia pasirinkti Design ir
i$sirinkti tinkama dizaino ikong¢le.

i Presentation1 [¢ampatibility binde] - Micrasott PowerPoint non commercial use - mx
Ta) —_
"U8) Home  Insert | Design | Animations  SlideShow  Review  View  Daveloper @

|
D = AllThemes ™ ~ B cotors - | Background Styles -
This Presentation Fonts =

-
[ ettects - Hide Background Graphics | |

Fage Slide
Setup Crientation - ||| Ag

Fage Setup

| mmmm Background = |

[H bt 1 L) Custom

Built-In
Aa

V11 11z ]

More Themes on Microsoft Office Online...
Browse for Themes...
Iy save Curent Theme..,

® CLICK TO ADD TITLE

. Click to add subtitle
@

| Click to add notes

Slide Lof1 | "Office Theme” | Lithuanian (Lithuaniz)
52 paveikslas. Dizaino pasirinkimas MS PowerPoint 2007 programoje

Jeigu standartiniy dizaino sprendimo nepakanka, galima juy paieSkoti internete (2007
programos versijoje reikia pasirinkti More Themes on Microsoft Office Online) arba susikurti
savo originaly dizaina.

Be to, programoje esancius standartinius dizainus galima pritaikyti savo reikméms,
keiciant atskirus dizaino elementus (juos paSalinti, keisti ju vieta, spalva ir pan). Tam reikia
atsidaryti skaidriy ruoSinius.

MS PowerPoint 2003 programoje pagrindiniame meniu reikia pasirinkti:
Rodymas (View) -> Instruktorius (Master) -> Skaidriy ruosinys (Slide Master)
MS Word 2007 programos versijoje:

Rodymas (View) -> Skaidriy ruosinys (Slide Master)
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53 paveikslas. Dizaino elementy redagavimas MS PowerPoint 2007 programoje

6.5. Animacija

Pristatymui pagyvinti skirta animacijos funkcija. Galima animuoti skaidriy peréjimus
ir skirtingy skaidrése esanciy elementy rodyma.

6.5.1. Skaidriy peré¢jimas

MS PowerPoint 2003 programoje pagrindiniame meniu reikia pasirinkti:

Skaidriy demonstravimas (Slide Show) -> Skaidriy peréjimas (Slide Transition), tada 18
desin¢je puseje atsidariusio saraSo iSsirinkti tinkama peré¢jima.

MS Word 2007 programos versijoje pagrindiniame meniu reikia pasirinkti:

Animacija (Animations) ir tada pasirinkti tinkama ikon¢lg.

om 65 clals Iiebliul8ki 3rifeal bt [Combatibiiy Mods] - Micrasoft Povie Point non-cammerdal tse EREA
| 1; Home  Tnset  Desigh | Animations | SlideShow  Review  Wiew  Developer @
[ ‘@ i : - = == o == « ¢y Transition Sound: [Mo Sound] = Adwance Slide

— ;.: ) Eg E @! ‘!@ ' 3 ﬂ \é] -F ‘!SL K - 3 Transition Speed: Fast - | @] On Mouse Click

Preview || 0 custom Animstion : : ! 1 h 7 lapplyTo Al | Automatically After: 00:00
(| Preview Animations Transition to This Slide

Galima nustatyti tinkama skaidriy peréjimo greitj, taip pat galima skaidriy pasikeitima
automatizuoti ar netgi pridéti garsa.

6.5.2. Vartotojo susikurta animacija

Galima animuoti ir atskirus turinio elementus. Tam skirta programos funkcija
Pasirinktiné animacija (Custom animation).
MS PowerPoint 2003 programoje pagrindiniame meniu reikia pasirinkti:
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Skaidriy demonstravimas (Slide Show) -> Pasirinktiné animacija (Custom Animation)
MS Word 2007 programos versijoje pagrindiniame meniu reikia pasirinkti:

Animacija (Animations) ir pasirinkti klaviS§a Pasirinktiné animacija (Custom
Animation).

Tada skaidréje reikia pasirinkti ta turinio elementa, kuri norétuméte animuoti, pvz.,
antraste, tekstini lauka, paveiksléli, lentelg ir pan., o desin¢je pusé€je pasirinkti Pridéti efektus
(Add Effect).
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54 paveikslas. Pasirinktinés animacijos pasirinkimas

Animuoti galima:

e turinio elementy pasirodyma — [eitis (Entrance);

e turinio elementy pabrézima — Emfazée (Emphasis);

e turinio elementy iSnykima — ISéjimas (Exit);

e turinio elementy perstimimus — Judéjimo marsrutai (Motion paths).

Turinio elementy pasirodymas

Tarkime, jei pasirinksime [Jeitis (Entrance) ->Atskridimas (Fly In), visi judantys
elementai ir ju pasirodymo tvarka bus paZyméti numeriukais ir bus matomi saraSe deSinéje
juostoje (Zr. 55 paveiksla).

Kiekvienam animuotam elementui galima nustatyti:

e Kaip elemento pasirodymas yra aktyvuojamas:

o su pele — Spusteléjus (On Click);

o pasirodo su akstesniu elementu — Su ankstesniu (With Previous);

o pasirodo po ankstesnio elemento po tam tikro laiko — Po ankstesnio

(After Previous) — Siam pasirinkimui reikty nustatyti laika, spragteléjus
desiniji pelés klavisa ir pasirinkus Laiko planavimas (Timing);

Kokia judejimo Kryptis (Direction);

Kokia judejimo Sparta (Speed);

Kokia elementy pasirodymo eilé — ¢t Pertvarkyti (Re-Order) {;

Panaikinti animacija — Salinti (Remove).
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55 paveikslas. Pasirinktinés animacijos atskridimo schema

Padarius bet koki pakeitima, galima perziiiréti animuotg skaidrg pasirinkus Vykdyti
(Play) arba pasirinkus Skaidrés demonstravimq (Slide Show).

Turinio elementy pabréZimas

Sia funkcija galima naudoti, kai norima kai kuriuos tekstinius elementus isskirti,
pavyzdZiui, pakeisti spalva, padidinti Srifta, pabraukti arba kaip nors judinti. Reikia pasirinkti
Prideti efektus (Add effect) -> Emfazé (Emphasis) ir tekstiniams elementams pasirinkti
tinkama efekta.

Custom Animation T
|§§f§ Change - |K_-:; Remove |
S Entrance 3

3% Emphasis | A 1 Change Font
#E  Exit » | A 2 Change Font Size
= Mation Paths »

B
__H

B 3. Change Font Style
A 4 ColorBlend

o
2 FF Gra .
3G Gra =

W More Effects...

o~

5, Grow'Shrink

I

»

Turinio elementy isnykimas

Funkcija nustatoma analogiSkai turinio elementy pasirodymo funkcijai, tik jos
rezultatas yra elemento iSnykimas i$ skaidreés.

Turinio elementy perstiimimas

Su Sia funkcija galima pakeisti turinio elementy vieta. Ekrane nupiesStos rodyklés
leidZia nustatyti elementy judéjimo krypti ir vieta.
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56 paveikslas. Animuotas elementy perstimimas

6.5.3. Animacijos schemos

Viso pristatymo arba vienos skaidrés visiems teksto elementams galima parinkti
vienoda animacijos schema. Animacijos schemos pasirinkimas leidZia greitai animuoti visas
pristatymo skaidres.

MS PowerPoint 2003 programoje pagrindiniame meniu reikia pasirinkti:

Skaidriy demonstravimas (Slide Show) -> Animacijos schemos (Animation Schemes),
tada i§ deSingje juostoje atsidariusio saraSo iSsirinkti tinkama schema ir pritaikyti arba vienai
skaidrei, arba Taikyti visoms skaidréms (Apply to All);

MS Word 2007 programos versijoje néra funkcijos Animacijos schemos (Animation
Schemes), taCiau yra kitas biidas, kaip parinkti animacija visoms pristatymo skaidréms.

Rodymas (View) -> Skaidrés ruosinys (Slide Master), tada pasirinkti Animacija
(Animations) ir norimam skaidrés elementui pritaikyti norimus animacijos efektus (Zr. skyreli
6.5.2).
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7. DOKUMENTO FORMATAS PDF

PDF (Portable Document Format) sukurtas Adobe kompanijos 1993 metais. Sis
formatas leidZia vartotojui uZtikrinti, kad jo sukurtas dokumentas buty atspausdintas arba
matomas toks, koki ji sukiiré vartotojas.

Nepaisant kompiuteriy ar operaciniy sistemy skirtumy, PDF formato failas yra matomas
ir spausdinamas lygiai toks pats, koks buvo sukurtas vartotojo.

Dabar Sis formatas labai paplito:

e publikuojant dokumentus ar straipsnius internete,
e keiiantis dokumentais.
Dokumento konvertavimas i PDF formata gali buti palyginamas su spausdinimu:
,konvertavai i PDF, vadinasi, atspausdinai®.
PDF formato privalumai:
e nepriklauso nuo kompiuterinés ar programinés irangos,
e nepriklauso nuo raiSkos (resolution),
e nepriklauso nuo kompiuteryje idiegty Srifty.

Norint savo kompiuteryje matyti PDF formato faila, reikia isidiegti nemokama
programa Adobe Reader (anksCiau vadinta Acrobat Reader). Su $ia programa galima PDF
failus skaityti ir spausdinti, bet negalima jy keisti.

PDF formato dokumentus galima susikurti naudojant:

Mokamas programas

e Acrobat Distiller;

e MS Office 2007 (parsisiuntus specialy iskiepi);

e irkt.

Nemokamas programas

e Ghostsript ir Ghostviewer, parsisiuntus ir isidiegus $ias programas is
http://www.ghostscript.com, galima konvertuoti failus i PDF formata;

e Pdf995, parsisiuntus ir isidiegus Sia programa i§ http://www.pdf995.com
vartotojo kompiuteryje idiegiamas virtualus spausdintuvas, kuris dokumentus
konvertuoja i PDF formata;

e OpenOffice, isidiegus $i teksto redaktoriy galima bet kuri atidaryta ar sukurta
dokumenta konvertuoti | PDF formata;

e Kkt
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8. TEKSTYNU LINGVISTIKOS IR STATISTINIAI METODAI

8.1. Tekstyny lingvistika

Tekstyny lingvistika — tai toks kalbos tyrimo metodas, kurio tyrimo pagrindas yra
tekstynai.

Tekstynai (angl. corpus (vns.), corpora (dgs.)) — tai didZiuliai elektroniniy teksty
rinkiniai, kurie paprastai naudojami natiiraliosios kalbos vartosenai tirti (placiau apie
tekstynus Zr. Marcinkevi€ien¢ 1997 ir 2000; Sinclair 1991).

Tekstynams analizuoti naudojamos specialios tekstyny analizés priemongs.

8.1.1. Tekstyny lingvistikos metodai

Tekstynais paremta analizé (corpus-based) — tradicinis tyrimo metodas, kuris paremtas
arba iliustruotas medziaga 1S tekstyny.

Tekstyny inspiruota analizé (corpus-driven) — metodas, kurio id¢ja, hipotezé ir keliamos
problemos rado pradzia tekstynuose (placiau Zr. Marcinkevic¢iene 2000).

8.1.2. Tekstynai ir jy riisys

Tekstynus galima skirstyti remiantis jvairiais parametrais:

Pagal kalbos atmaing:
e raSytinés kalbos,
e sakytinés kalbos,
e miSris.

Pagal kalby skaiciy:
e vienakalbiai,
e dvikalbiai,
e daugiakalbiai.

Dvikalbiai ir daugiakalbiai dar skirstomi pagal sandarq:
e lygiagretus,
e palyginamieji.

Pagal kalbos anotavimq:
e neanotuoti,
e anotuoti.

Pagal reprezentuojamos kalbos pobiidj:
e sinchroniniai,
e diachroniniai.

Vienakalbiai tekstynai — tai vienos kalbos elektroniniy teksty rinkiniai. Nedidelj i$ keliy
ar keliy deSimciy teksty sudaryta tekstyna galima susikurti greitai ir be dideliy laiko sanauduy,
o keliy ar keliy Simty milijony ZodZiy apimties tekstynai gali biiti daugybés mety darbo
rezultatas.

Reikia paminéti, kad sakytinés kalbos tekstyny kiirimas yra daug sudétingesnis procesas
nei raSytinés kalbos tekstyny, nes sakyting kalba reikia irasSyti, transkribuoti ir tinkamai
iforminti. Sakytinés kalbos tekstynuose svarbiausias elementas yra ne sakinys, o pasakymas.
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Lygiagretiis tekstynai — tai originalis tekstai ir jy vertimy tekstai, sulygiagretinti sakiniy
lygmeniu. LygiagreCiuosiuose tekstynuose gali biti sulygiagretinti dviejy ar daugiau kalby
tekstai. Paprastai Sity tekstyny kaupimas reikalauja daug didesniy laiko sanaudy nei
vienakalbiy ar palyginamyjy tekstyny kaupimas, nes reikia ne tik surinkti reikiamus tekstus,
bet ir juos sulygiagretinti.

Palyginamieji vienakalbiai tekstynai — tai vertimo studijoms skirti tekstynai, kuriuose
pagal tuos pacius kriterijus sukaupti du vienos kalbos elektroniniy teksty rinkiniai: viename
yra originaliis tekstai, kitame tos pacios kalbos vertimo tekstai. Palyginamuosiuose
tekstynuose iprasta tirti ZodZio vartosenos skirtumus originalo ir vertimo kalboje (daugiau Zr.
Baker 1995).

Palyginamieji dvikalbiai arba palyginamieji daugiakalbiai tekstynai yra pagal tuos
pacius kriterijus sukaupti originaltis dviejy arba daugiau kalby elektroniniy teksty rinkiniai.

Anotuoti tekstynai — tai tekstynai, kuriuose struktiiriniai, gramatiniai ar semantiniai
poZymiai Zymimi specialiomis metakalbinémis paZymomis (arba anotacijomis).

8.1.3. Tekstyny reprezentatyvumas, rezultaty interpretavimas

Nors tekstyno dydis yra vienas svarbiausiy tekstyno poZymiy, taCiau vien tik tekstyno
dydzio nepakanka jo kokybei uZtikrinti. Svarbiausia yra tai, kg tekstynas reprezentuoja ir kaip
tiksliai atspindi tam tikra kalbos atmaing ar Zanra.

Taigi tekstyny dydis yra glaudZiai susijgs su reprezentatyvumo problema, nes
tekstynas — tai tam tikras kalbos méginys arba modelis, kurio tyrimy pagrindu daromos
bendresnés iSvados. Tyré¢jas dirbdamas su tekstynu arba kurdamas tekstyng visada turi uzduoti
sau klausima: ka tas tekstynas reprezentuoja (visa raSyting kalba, vertimy kalba ar vieno
autoriaus kalba) ir ar gerai reprezentuoja? DaZniems kalbos reiSkiniams, pvz., jungtukams,
tirti pakanka palyginti nedidelio tekstyno, o retesni kalbos reiSkiniai turi buti tiriami kuo
didesniuose tekstynuose.

Vertinant tekstynuose atrastus kalbos reiSkinius, reikia atsizvelgti i tekstyno tekstu:

e tema,

e kalbos atmaing (sakytiné ar raSyting),

e Zanrg (groZin¢ literatira, dokumentai, mokslin¢ literatra ir pan.),
¢ laikotarpi (metai ar tam tikras laikotarpis),

e teksty ar autoriy jvairove ir kt.

Nors egzistuoja jvairios tekstyny tyrimo medZiagos analizés metodikos, taciau rezultaty
interpretacija ir galutines iSvadas visada kuria pats tyréjas. Geras tekstynu paremtas tyrimas
remiasi ne tik reprezentatyviais ir tinkamais duomenimis, bet ir teisinga jy interpretacija.

8.1.4. Tekstyny analizés priemonés

Konkordavimo programos

Konkordavimo programa (concordancing programs ar concordancers) — pagrindiné
tekstyny analizés priemoné. IS esmés §i programa yra teksto arba tekstyno paieskos sistema,
leidZianti lingvistui rasti tekste reikalinga informacija apie atskirus teksto elementus (ZodZius
ar ZodZiy junginius) ir pateikti ja patogia forma — konkordansu.

Konkordansas yra saraSas eiluciy, kuriose rastas tiriamas Zodis ar ZodZiy junginys,
paimtas iS teksto ar tekstyno. Gali biiti vienakalbiai, dvikalbiai ir daugiakalbiai konkordansai.
Skirtingy riisiy konkordansams generuoti reikalingos ivairios konkordavimo programos:

Vienakalbiai konkordansai (pvz., Simple Concordance program — SCP, WordSmith
Tools, Dabartinés lietuviy kalbos tekstyno paie§ka33);

33 Zr. http://tekstynas.vdu.lt.
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Dvikalbiai ar daugiakalbiai konkordansai (pvz., Paraconc, Lygiagreciojo tekstyno
paieska®).

Vienakalbio konkordanso eilutés centre yra tiriamasis Zodis (angl. node), o jo
artimiausiame kontekste i§ kairés — kairieji kolokatai, i§ deSinés — deSinieji (angl. left
collocates, right collocates) (7r. 57 paveiksla). Kolokacijy tyrimuose daZnai biitina apriboti
konteksta, t. y. analizuoti tik tam tikra kolokaty skai€iy i§ kairés arba i§ deSinés, kitaip tariant,
nustatyti ,Jango dydi“ (angl. span). DaZniausiai nustatomas 4-5 ZodZiy lango dydis.
Kompiuteriy programose dél patogumo kairieji kolokatai Zymimi sutrumpintai K1-KS, o
deSinieji — D1-DS5 (angl. atitinkamai L1-L5, R1-RS), kur skai¢ius nurodo, kurioje pozicijoje
yra kolokatas.

lango dydis = 5

h Tiriamasis

zodis
K5 K4 K3 K2 K1 D1 D2 D3 D4 D5

rusiSkyju ploty lietuviskumas tokia abejotina filologija: Vitebskas nuo vyti, Pinskas nuo pinti

Kairieji kolokatai Desinieji kolokatai

Konkordanso eiluté
57 paveikslas. Konkordavimo programose vartojamy terminy iliustracija

Dauguma konkordavimo programy leidZia didinti konkordanso eilutés ilgi: eilutg galima
apriboti sakiniu arba tiksliai nurodyti jos ilgi simboliais. Tobulesnés programos dar leidZia
kurti bendraSakniy arba bendragaliiniy ZodZiy konkordansus. PavyzdZiui, jei paieSkos lange
nurodysime filolog*, konkordavimo programa suras visus ZodZius su Sia Saknimi, jeigu *gija
— visus ZodZius su $iuo baigmeniu.

Jeigu tiriame 10-15 konkordanso eiluiy, mums nereikia jokios ypatingos analizavimo
metodologijos: sugebame patys puikiai ivertinti tai, ka matome. Jei tiriame 50-100 eiluciy
konkordansa, rekomenduotina jam pritaikyti koki nors elementary konkordanso rusiavima (Zr.
toliau pateikta pavyzdi). O jeigu miisy tyrimo medZiaga susideda i§ tiukstancio ar daugiau
eiluciy, butina pritaikyti konkordansui specialias ruSiavimo ir skai¢iavimo priemones, kitaip
nesugebésime apreépti ir apibendrinti visos jame esancios informacijos.

Toliau pateiktas ZodZio filologija konkordansas, suriiSiuotas pagal K1 ir po to pagal K2:

usiskuju plotuy lietuviskumas tokia abejotina filologija: Vitebskas nuo vyti, Pinskas nuo pinti,
ialybiy spektras: lietuviuy filologija, angly filologija, vokiec¢iy filologija, vokieciuy ir rusuy
tete populiariausia nauja specialybé - angly filologija. Norinc¢iu studijuoti ja, kaip ir ekonom
neutinio susitikimo bldai taps archeologija. filologija nebepazZins mylétino Logoso. Buvau atkre
s neateity, be to, bltu per sudéetinga. Balty filologija kaip atskira specialybé déstoma tik tri

s Redakcijos svelias Baltistika, arba balty filologija, - mokslas apie balty kalbas, literata
tyrinéjimy disciplinos pagrindas lieka balty filologija, tai yra lietuviy ir/arba latviuy kalba,
Simto dalykuy. Dabar vienas tokiy - ir balty filologija. - Pernai studenty buvo tik keturi.

pastanguy reikalaujantis autorius, ji domina filologija ir filosofija, jis retai kada praleidizi
am tikéjimui nepaliaujamai stiprinti gyvuoja filologija. Jos prielaida ta, kad esama tuy nedauge
s raso arba gali rasyti. Noriu pasakyti, kad filologija remiasi kilniu tikéjimu - tikéjimu tuo,
erkeité ir pertvarké tokios disciplinos kaip filologija, kuri savo ruoztu natfGralizavo, modern
studijuoti tokius nepraktiskus mokslus kaip filologija. Baiges mokslus, B. BrazdZionis désté 1
ta balsés i priebalsius, ir stambaus kalibro filologija lieka bejégé isSreiksti ta meilés ir jau

emiotikos Sakos, hermeneutika, komparatyviné filologija ir kt.). S$i dvinari bakalauro studij
nimas neaiskus (studiju planuose - "lietuviy filologija”, mano skaitytojo biliete - "lietuviu k
ikurtas naujas didaktikos skyrius - lietuviy filologija, kuriai iki Siol vadovauja profesorius

r filologiniy specialybiu spektras: lietuviy filologija, angluy filologija, vokiec¢iuy filologija,
ne taip akivaizdu, bet tiek pat nuostolinga. filologija su saviironisku budrumu zZodiniam, sutar
e jiteigé inZinieriaus, mediko specialybes, o filologija neturéjo pasisekimo. Taip lietuviska s

- teigé menininkas, - pagimdé ne istorija, o filologija; sunku isivaizduoti didesne negu lietu
ijos perskyra taip pat tradiciné. Ja remiasi filologija: vienas dalykas yra tekstas ir jo prasm
no" mama. "Vaikeli, anokia ¢ia specialybé - ”"filologija”!, - tikino ji. - Juk nebtina studiju

strakcijos ir universalumo lygio strukttras (filologija akcentuoja konkretybés Sventuma). Galg

3% Zr. http://tekstynas.vdu.lt.
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1 kita krasta, kiti ir universitetai. Taigi filologija, nors to termino a$ ir nelabai suprantu
disertacija "Latviuy kalbos séliskuju tarmiy filologija”. 1980-1990 metais dirbo mokslini darbag
medicinos srities atstovu, antroje vietoje - filologija, trecioje - technikos mokslai. Susitik
tuviy filologija, angluy filologija, vokieciy filologija, vokiec¢iuy ir rusuy kalbos, kurias daugia
akomis: antropologija, biologija, zoologija, filologija (senais vietovardziais)104. Nors, anot

Taip surtSiuotame konkordanse be sudétingy skaiiavimy galima lengvai nustatyti
daZniausius junginius su ieSkomuoju zodZiu (balty filologija — 4, lietuviy filologija — 3).

Besikartojantys junginiai yra lengviau matomi naudojant vadinamaji zigzagini
rusiavimq (angl. zig-zag sorting). RiiSivojant zigzaginiu biidu, pirmiausia raSiuojama pagal
tiriamaji Zodi, po to pagal pirmaji i§ deSinés; pagal pirmaji i§ kairés; pagal antraji i§ deSinés;
antraji i§ kairés ir t. t. Taip susidaro pasikartojanciy junginiy grandinés, kurios yra lengvai
pastebimos plika akimi.

Jei musy konkordansas yra tiikstanCio ir daugiau eiluCiy, gali nepadéti ir kolokaty
riiSiavimas. Tada reikty automatiskai skaiciuoti kolokatus, nustatant tiksly kolokaty skai¢iy
tam tikroje pozicijoje. Dauguma konkordavimo programy leidZia atlikti tokius skai¢iavimus.

Dazniniai sqrasy generatoriai

Sios kompiuterinés priemonés skai¢iuoja daznines ZodZiy charakteristikas, t. y.
generuoja daZninius saraus (angl. frequency lists). Siuose sara§uose nurodomas kiekvienos
atskiros Zodzio formos arba ZodZio pasirodymo daznis tiriamame tekste. DaZzniniai saraSai
suteikia vertingos informacijos apie santykini zodZiy dazni ir teksto leksemy ivairove.

DaZniniai saraSai gali bati surtiSiuoti pagal dazni arba abécéle, taip pat didéjancia arba
maz¢jancia tvarka. Pagal dazni sur@iSiuotuose saraSuose iSrySkéja daZniausi ZodZiai ir ju
formos. Toliau pateiktas 10 paciy daZniausiy ZodZiy formy saraSas 60 mln. ZodZiy tekstyne. IS
Sio saraSo akivaizdu, kad pats dazniausias Zodis tekstyne yra jungtukas ir, daZniausias
prielinksnis §, 1§ veiksmazodiniy formy daZniausia yra ZodZio biti bitojo laiko III asmens
forma buvo, daiktavardziai, biidvardZziai ir prieveiksmiai i daZniausiyjy deSimtuka nepatenka.

ir 1909469
kad 485436
i 455142
i§ 384463
su 334613
0 307064
buvo 307006
tai 296544
kaip 290564
yra 272266

Generuodami dazninius saraSus lingvistai gali naudotis nepageidaujamy ZodZiy sqrasais
(stop lists), t. y. saraSais, kuriuose yra tie zodZiai, kuriy tyréjas nepageidauja savo daZniniuose
saraSuose. PavyzdZiui, norédamas dirbti tik su reikSminiais Zodziais (daiktavardziais,
buidvardziais, veiksmazodZiais), tyréjas funkcines kalbos dalis (jungtukus, prielinksnius,
dalelytes ir kt.) gali itraukti i nepageidaujamy ZodZiy sarasus.

Pagal abécéle suriiSiuotose saraSuose labai patogu sugrupuoti visus bendrasaknius ir
giminiSkus ZodZius. Siuose sarasuose taip pat lengviau surasti konkrety Zodj (ypa¢ jeigu is
saraSas yra atspausdintas). Toliau pateiktoje lenteléje matome ZodZio filologija dazniy
pasiskirstyma pagal linksnius abéc¢lés tvarka iSrikiuotame daZniniame saraSe.

ilologes

filolog 1

ilologes

filolog 10
filologija 26
filologija 43
filologijai 8
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filologijas 1

filologijoje 10
filologijomis 1
filologijos 367
filologine 12
filologine 12
filologiné 15
filologinei 2
filologinéje 1

Svarbu jvertinti, kad ZodZiy formy sarasai rodo ne ZodZiy, o ZodZio formy daZnumus. IS
tiesy tikrasis antradtinio> ZodZio filologija daznis yra visy to ZodZio linksniy daZniy suma. giq
problema padeda spresti lemuokliai, kurie suveda visas gramatines ZodZio formas i viena
antraSting. Lemuotas ZodZio sarasas sutrumpe¢ja, be to, gali pasikeisti zodZiy iSsidéstymo
tvarka surtiSiavus ji pagal dazni, taCiau lemuojant ZodZiy sarasa susiduriama su homonimijos
problema. PavyzdZiui, ZodZio forma lauZo, kuriai daZniniame saraSe yra priskiriamas tik
vienas daZznis, i§ tiesy skyla i daiktavardZio lauzas kilmininka ir veiksmazodZio lauZyti
esamojo laiko forma. Tiesa, reikia neuzmirSti, kad antraStiniy ZodZiy saraSe prarandama
informacija apie atskiry linksniy arba veiksmaZzodZzio formy daZnius.

Dauguma internete prieinamy tekstyny turi jrankius, kurie leidZia atlikti konkordavimo
ir daZniniy saraSy generavimo funkcijas. Jei studentai noréty patys kurti ir analizuoti
tekstynus, bty galima paminéti nemokamas programas AntConc ir Simple Concordance
Programme, bei komercing WordSmith Tools.

8.2. Statistiniai duomenys, statistiniai metodai

Nors tradiciSkai filologija yra laikoma humanitariniu mokslu, taciau tekstyny, fonetikos
ar kompiuterinés lingvistikos tiriamuosiuose darbuose lingvistai neretai susiduria su jvairiais
skai¢iavimais, statistika, statistiniais duomenimis ir statistiniais metodais.

Kiekybiniai metodai kalbotyroje reikalingi dél keliy prieZasCiy.

1. Kiekybiniai désningumai egzistuoja gyvojoje kalboje (linksniy, kir€iuo€iy, kalbos
daliy, gramatiniy formy daznumas). Remiantis statistika galima greiiau pastebéti
tam tikrus désningumus. Reikia pasakyti, kad daznumas, remiantis Zodyny ir realios
vartosenos duomenimis, labai skiriasi.

2. Tarp kiekybiniy ir kokybiniy reiSkiniy daZnai egzistuoja rySys (tarp skiemeny
skaiCiaus ar kirCiuoto skiemens vietos ir ZodZio vartojimo daZnumo). Statistika
kokybiniy ypatybiy neatskleidZia, bet gali juos paaiskinti.

Statistikos naudojimas kalbotyroje turi biiti prasmingas. Statistika dél pacios statistikos
beprasmé (kalbotyra negali virsti buhalterija). Kita vertus, reikia gerai iSmanyti statistikos
galimybes ir pacius metodus, kad statistikos naudojimas biity s€¢kmingas bei prasmingas.

DaZnai, ypa¢ pradedantieji tyréjai, neteisingai jvardija savo tyrimo metoda ir nepagristai
priskiria ji statistiniam.

Statistiniai duomenys — ivairls tam tikry reiskiniy skai¢iavimai (dazniai) yra randami
daugumoje Siuolaikinés kalbotyros darby, taCiau vien tik statistiniy duomeny pateikimas
tyrime nereiSkia, kad tyrime naudojami statistiniai metodai.

Statistiniai duomenys skirstomi { kokybinius ir kiekybinius. GrafiSkai galima
pavaizduoti ir vienus, ir kitus. Skaitiné interpretacija galima tik kiekybiniy poZymiy. Taciau
kokybinj poZymj visada galima interpretuoti kaip kiekybinj, suteikiant jam skaitines reikSmes,
pvz., ilgiesiems balsiams priskirti 1, o trumpiesiems O.

¥ Antrastinis Zodis (angl. headword) — tai apibendrinta 7odZio forma, kuri paprastai sutampa su to ZodZio
Zodyninio straipsnio antrastine forma. Antrastinis Zodis dar vadinamas lema.
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Kiekybinis poZymis gali biiti: a) tolydusis (jei skirtumas tarp poZymio igyjamy reikSmiy
gali buti kiek norima mazas, pvz., balsiy ilgumas); b) diskretusis (poZymio reikSmés gali
skirtis ne maziau kaip tam tikru minimaliu dydZiu, pvz., balsiy ar priebalsiy skaicius kalbose).

Tam tikra tvarka surikiuota medZiaga yra statistiné variacijos eiluté. Tokios eilutes gali
biti diskretinés ir intervalinés. Pvz.: tiriamas lietuviy kalboje vartojamy skoliniy kiekis
sociolingvistiniu aspektu (t. y. pagal amZiy). Turime 15, 18, 19, 27, 29, 35, 50, 61, 72 mety
respondentus. Jeigu analizuosime ir aptarsime kiekvieno informanto kalbg atskirai (tam tikra
tvarka, pvz., nuo jauniausio iki vyriausio, taip, kaip suraSyta), tai turésime diskreting eilutg.
Jeigu juos suskirstysime i grupes: 15-19, 27-35, 50-72, tai turésime intervaling eilutg.
Intervalings eilutés labai parankios tada, kai naudojamasi dideliu medziagos kiekiu.

Dazniy lentelés. Pavyzdziui, analizuojama, koks yra lietuviy kalbos daiktavardZiy
kirCiuo€iy daZznumas (duomenys paimti i§ Kazlauskiene 2000):

1 kirc¢iuoté 2 kirc¢iuoté 3 kirciuoté 4 kir¢iuoté

43,2 % 37,5 % 9,8 % 9,5 %

Kad buty vaizdziau, Sitos lentelés gali biiti pateikiamos grafiSkai — braiZomos ivairios
diagramos.

Aprasomoji statistika — pirminis skaitmeniniy duomeny apdorojimas: vidurkis, moda,
mediana, santykiniai ir absoliutiis daZniai, dispersija, standartinis nuokrypis.

Sios charakteristikos gali biiti dvejopos: a) poslinkio (rodo duomeny reik§miy dydj) ir b)
sklaidos (rodo reikSmiy iSsidéstyma).

Poslinkio charakteristikos Sklaidos charakteristikos
vidurkis, mediana, moda absoliutusis nuokrypis, dispersija
Vidurkis (arba aritmetinis vidurkis) — viena 1§ svarbiausiy skaitiniy poslinkio

charakteristiky — skaiiuojamas pagal formulg:

2%

n
kur x; (i=1, 2, ..., n) — varianc¢iy reikSmés, n — varianc¢iy skaiCius.

X =

Reikéty nepamirsti, kad kai kada jis gali netiksliai rodyti viduting duomeny reikSmg.
Taip buna tada, kai imtyje yra vienas ar keli labai besiskiriantys skaiCiai, pvz.: balsiy trukmé
(ms): 70 80 8575, 80 8575 70 170 70 75 85. Be to, 170 vidurkis biity 77ms, o su juo 85ms.

Mediana. Norint rasti medianq, pirmiausia reikia surtiSiuoti duomenis didéjimo tvarka.
Rikiuotés vidurinis skaiCius ir yra mediana. Jei duomeny skaiius lyginis, tai mediana —
dviejuy viduriniy skaiciy vidurkis. Mediana naudojama tada, kai d¢l keliy ekstreminiy skaiciy
vidurkis nerodo realaus poslinkio, pvz., ankstesnis balsiy trukmés atvejis: 70 70 70 75 75 75
80 80 85 85 85 170. Mediana yra 77 (vidurkis 75 ir 80).

Moda — daZniausiai pasitaikantis stebéjimas nagrin¢jamoje statistiniy duomeny aibéje.
Jei visi skaiCiai pasikartoja tiek pat karty, sakoma, kad aibé neturi modos. Miisy tiriamy balsiy
trukmes aibé neturi modos, nes net 3 reikSmés pasikartoja 3 kartus.

Absoliutusis nuokrypis (mean deviation) apibréZziamas kaip vidurkis absoliuciyjy
skirtumy tarp igyjamy reikSmiy ir vidurkio. Tie skirtumai igyja ir teigiamas, ir neigiamas
reikSmes, skirtumy suma visada lygi 0. Todél reikia naudotis ty skirtumy absoliuciaisiais
dydZziais. Apskai¢iuojamas pagal formulg:

1 _
. Z‘x i X ‘
nio
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Dispersija (variance) — daZniausiai vartojama sklaidos charakteristika. Tai atsitiktiniy
dydziy iSsibarstymas aplink vidurkj. Ji skai¢iuojama kaip ir absoliutusis nuokrypis, tik ¢ia
imama ne absoliuc¢iy dydZziy suma, o skirtumy kvadraty suma (nereikia modulio).

1 n
o’ =—Z(xi ~-x)’
ni

Dispersija yra populiacijos parametras (duomenys apie absoliuciai visa tiriamaja grupg).
Jei turime ne populiacija, o imtj, tada formulé Siek tiek kitokia:

1 n
s’ =—Z(xi -x)’
n—»1i.

Dispersijos reikSmé gali skirtis nuo absoliu¢iojo nuokrypio. Kad to nebiity, naudojamas
standartinis nuokrypis (Standart deviation). Tai Saknis 1§ dispersijos:

Z(X[ _f)z

n-—1

I standartini nuokrypi panasus ir variacijos koeficientas, nustatomas pagal formulg:
y="2.100
X

ApraSomoji statistika yra naudojama daugelyje Siuolaikiniy kalbotyros darby, taciau ir
tai dar néra tikrieji statistiniai metodai.

Statistiniai metodai skirti duomeny reprezentatyvumui jvertinti, statistiniams rySiams,
priklausomybéms, tikimybéms, sagveikoms nustatyti.

Klaidos tikimybés nustatymo metodai.

Koreliaciné analize — statistiniy rySiy tarp kintamyjy tyrimas.

Regresiné analizé — vieno kintamojo priklausomybés tyrimas nuo vieno arba daugelio
kintamyjy.

Dispersiné analizé — kintamojo reikSmiy paaiSkinimas vieno ar keliy nepriklausomy
kintamyjy veikimu.

Faktoriné ir klasteriné analizés leidZia daugeli kintamyjy sugrupuoti i tarpusavyje
nesusijusias grupes remiantis jy tarpusavio koreliacijomis.

Placiau apie statistinius metodus skaitykite specialioje statistikai skirtoje literatiroje
(Cekanaviéius et al. 2000, 2002; Januskevicius 2000).

8.2.1. Statistiniy metody naudojimas kalbotyroje

Statistiniai metodai daugiausia naudojami Siose kalbotyros srityse:

Eksperimentinéje fonetikoje

Siuose tyrin¢jimuose statistiniais metodais gali biiti tyrin¢jami garso signaly parametrai:
{vertinant garso signaly matavimo patikimuma, skirtumus ir paklaidas.

Tekstometriniuose tyrinéjimuose

Sie tyrinéjimai apima tekstyny ir kompiuterinés lingvistikos tyrin¢jimus, kuriuose
statistiniai metodai gali biiti naudojami jvairiems teksto elementams skai¢iuoti: kolokacijoms,
autorystel nustatyti, ZodZiy pasiskirstymui lyginti, automatiSkai nustatyti teksto funkcija,
grupuoti tekstus ir kt.

Anketiniuose arba apklausy tyrinéjimuose

Siy tyrinéjimy duomenys yra surinkti apklausiant respondentus. Siy tyrinéjimy istakos
yra socialiniuose moksluose — jie skirti ivairiems visuomeniniams reiSkiniams tirti. Kai
apklausiamas didziulis ivairaus amZiaus, ivairaus iSsilavinimo, ivairiy socialiniy grupiy
respondenty kiekis, tai rezultatams jvertinti reikalingi statistiniai metodai.

103



8.2.2. Statistine programiné jranga

Specializuota statistiné programiné jranga yra didelé pagalba tyréjui, norin¢iam naudoti
statistinius metodus savo tyrin€jimuose, nes ja naudojantis sudétingi ir komplikuoti statistiniai
uzdaviniai gana nesunkiai iveikiami. Be abejo, svarbu neuzmirsti, kad statistinés analizés
sekmé priklauso ne tik nuo teisingai pritaikyto statistinio testo ir teisingy skaiCiavimy, bet ir
nuo patikimy duomeny. Tik tada, kai Sios abi salygos yra iSpildytos, galima laukti patikimy ir
prasmingy rezultaty.

Egzistuoja daug {vairiy statistiniy kompiuteriniy programy, tafiau galima buty iSskirti
Sias tris programas:

MS Excel — labiau tinka apraSomajai statistikai;

STATISTICA - specializuotas statistinis programy paketas, skirtas {jvairiems
statistiniams metodams taikyti.

SPSS programa (Statistical Package for the Social Sciences) — pritaikyta statistiniams
metodams, naudojamiems socialiniuose moksluose, taikyti.
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